User’s Manual




General

Foreword

The user's manual (hereinafter referred to as "the Manual") describes the structure, function
and operation of intelligent video surveillance server (hereinafter referred to as "IVSS").

Model

8-HDD, 12-HDD, 16-HDD, and 24-HDD.

Safety Instructions

The following categorized signal words with defined meaning might appear in the Manual.

Signal Words Meaning

Indicates a high potential hazard which, if not avoided, will result in

ADANGER death or serious injury.

AWARNING

Indicates a medium or low potential hazard which, if not avoided,
could result in slight or moderate injury.

ACAUTION

result.

Indicates a potential risk which, if not avoided, could result in
property damage, data loss, lower performance, or unpredictable

@_—“”1T|Ps Provides methods to help you solve a problem or save you time.
an Provides additional information as the emphasis and supplement to

the text.

Revision History

Version Revision Content Release Time
Add video structuring, vehicle recognition, and )

V2.1.0 _ . . April 2019
vehicle comparison functions.

VvV2.0.1 Add attention in important safeguards and warnings. | January 2019

V2.0.0 Update figures of 16-HDD series IVSS. December 2018

V1.0.0 First release. November 2018

Privacy Protection Notice
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As the device user or data controller, you might collect personal data of other such as face,
fingerprints, car plate number, Email address, phone number, GPS and so on. You need to be
in compliance with the local privacy protection laws and regulations to protect the legitimate
rights and interests of other people by implementing measures include but not limited to:
providing clear and visible identification to inform data subject the existence of surveillance
area and providing related contact.

About the Manual

e The Manual is for reference only. If there is inconsistency between the manual and the
actual product, the actual product shall prevail.

e We are not liable for any loss caused by the operations that do not comply with the manual.

e The manual would be updated according to the latest laws and regulations of related
regions. For detailed information, see the paper manual, CD-ROM, QR code or our official
website. If there is inconsistency between paper manual and the electronic version, the
electronic version shall prevail.

e All the designs and software are subject to change without prior written notice. The product
updates might cause some differences between the actual product and the manual. Please
contact the customer service for the latest program and supplementary documentation.

e There still might be deviation in technical data, functions and operations description, or
errors in print. If there is any doubt or dispute, please refer to our final explanation.

e Upgrade the reader software or try other mainstream reader software if the manual (in PDF
format) cannot be opened.

e All trademarks, registered trademarks and the company names in the manual are the
properties of their respective owners.

e Please visit our website, contact the supplier or customer service if there is any problem
occurred when using the device.

e |If there is any uncertainty or controversy, please refer to our final explanation.
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Important Safeguards and Warnings

This section introduces the correct application method of IVSS. Read the Manual carefully
before use to prevent danger and property loss. Strictly conform to the Manual during application
and keep it properly after reading.

Operating Requirement

e The IVSS needs to be installed in restricted access areas, and anyone who operates the
device needs to be aware of the safety requirements of the device.

e Do not place and install the IVSS in an area exposed to direct sunlight or near heat

generating devices.

Do not install the IVSS in a humid, dusty or fuliginous area.

Install the IVSS at stable places horizontally.

Make the IVSS stay away from liquid.

Install the IVSS at well-ventilated places; do not block its ventilation opening.

Use the IVSS only within rated input and output range.

Do not dismantle the IVSS arbitrarily.

Transport, use and store the IVSS within allowed humidity and temperature range.

Power Requirement

e Be sure to use the designated battery type. Otherwise there may be explosion risk.

e Be sure to use batteries according to requirements; otherwise, it may result in fire,
explosion or burning risks of batteries!

e To replace batteries, only the same type of batteries can be used.

e Be sure to dispose the exhausted batteries according to the instructions.

e The product shall use electric wires (power wires) recommended by this area, which
shall be used within its rated specification.

e Be sure to use standard power adapter matched with the device. Otherwise, the user
shall undertake resulting personnel injuries or device damages.

e Use power supply that meets SELV (safety extra low voltage) requirements, and supply
power with rated voltage that conforms to Limited Power Source in IEC60950-1. For
specific power supply requirements, please refer to device labels.

e Products with category | structure shall be connected to grid power output socket, which
is equipped with protective grounding.

e Appliance coupler is a disconnecting device. During normal use, please keep an angle
that facilitates operation.

Attention

Al module does not support hot plugging. If you need to replace the Al module, unplug
the device power cable first. Otherwise, it will lead to file damage on the Al module.

Important Safeguards and Warnings |l



Signal Words

Icon/Button Description
After you have input password, press the icon with your pointer,
= you can see the password is displayed in letters and number;

Release mouse or move pointer to other places, the password is
displayed in the form of black dots.

Add icon. Click the icon, system can display the hidden
applications interface. You can view or open the applications.

Help information. Move the cursor to the icon, device can display

2

help information.

Display or hide icon. Click the icon to display the hidden menu.
2yt Now the icon is shownas ~ /¥ /¥ Click /¥ |7

again to hide the menu items.

Check the box, you can select multiple menu items at the same

. v
time. & means selected.

. (®
Check box, select one menu item, = means selected.

Dropdown box, click the box to view the dropdown menu.

Enable icon.

° E.: Disabled function.
° .j: Enabled function.
° : The function cannot be enabled.

: The function cannot be disabled.

S Refresh

Refresh button, click it to view the latest configuration information.

Cancel

Cancel button, click it to cancel the configuration items and then
return to the upper-level menu.

Resget

Click Reset to clear all search criteria settings.

F

Page switch.

° < / ’ : Page up/page down.

° < / 7 , go to the first page or the last page.

Jump

Play window.
Input page number in the box. Click Jump to go to the specified
page.

Important Safeguards and Warnings 1V




Icon/Button

Description

W

Filter icon. Click it to set filter criteria.

Select icon. Click the icon, the system displays a check box, so

i . .
you can select multiple objects.

Q Search column. Input key words, click Q to search the
corresponding information.
Text column. Input number, letter, symbol and so on.

b 4 Close button. Click the icon to close the window.
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1.1 Introduction

1 Overview

Intelligent video surveillance server (IVSS) is compatible with most video surveillance
products. Based on deep learning technology, IVSS has Al functions including human face
recognition, and features extraction.

e General system settings, video surveillance, video storage, alarm settings, log
management, record search and playback, intelligent analysis (such as human face
real-time recognition, search human face by specified image and then play back video).

e User-friendly interface, suitable for user to operate.

e Supports 4K and H.265 decode.

e Widely used in intelligent building, large parking lot, safe city project, financial planning

area, and so on.

1.2 Main Functions

Table 1-1 Main functions introduction

Name Description
Configuring smart detection alarm.
e Human face detection and human face comparison alarm (available with Al by
camera or Al by device).
intelligent e Upload human face image to search images, and supports searching and
analytics comparing 10 face images simultaneously.
e  Quickly search smart detection record of face property.
e Set properties parameters to filter the comparison results twice and quickly
filter the information needed.
e Double-click the search results to play the associated record files.
View live pictures, smart detection pictures and record of remote device.
® Supports creating maximum 100 views. Each view supports maximum
36-channel remote devices.
e  Supports creating view group, and view management.
Live view e Local zoom-in of view window, and control zoom-in magnification with mouse
and monitor wheel; display real-time -blt st-ream, enable original scale, switch main
stream/sub stream on the view window.
e Display smart feature property panel, view the real-time snapshots of smart
detection, play the record taken during snapshots, and export pictures.
e View statistics of smart detection pictures, and set smart detection prompt
quickly.
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Name

Description

View and play back records/snapshots.

e Through smart detection type, search smart detection record/pictures quickly.

e Search and play back record/pictures according to type, remote device and
time.

e Adoptimage to display search results. At the same time, it can export recorded
video file/image to peripheral device or the PC.

e Playback dual-bar control. Display selected channel and the record process of
all searched channels.

Search e Use cursor, time bar, mouse click to fast positioning recorded video playback
time.
e Use mouse wheel to zoom in the time bar, max unit is 24 hours, min unit is 1
second. It can quickly view channel record status.
e  Multiple-record playback mode. It includes slow play, fast play, backward play,
and frame by frame playback.
e When playback record, it can display event occurred time and select any video
panel to zoom in/zoom out.
Manage devices information, add and configure remote devices.
e Modify device name and set device storage plan.
e Add remote devices through ONVIF, AXIS, SONY protocol and so on.
Device e Search remote device with broadcast. Use manufacturer, IP filter to narrow
management search range.
e Initialize remote device, modify remote device name, IP address, and so on.
e Set remote device encode parameters, connection information, OSD, and
storage plan, and so on.
Manage face database and face image information.
File e Human face database creation.
management | @  Manual upload, batch import human face images. Maximum support 300,000
images.
Configure basic network and network applications.
e With 4 self-adaptive Ethernet ports, set device IP address, visit and manage
Network the device through web and client.
management | @  Set port number. Bind the port with load balance, fault-tolerance, link
aggregation working mode.
e Support P2P, DDNS, Email, and auto register.
It is to set alarm event. When there is an alarm, system can trigger the
corresponding device to generate alarm operation.
e Set device error alarm, including no HDD, storage error, full storage space, IP
conflict, MAC conflict, login lock, Al module temperature, Al module offline, fan
Event speed, power error, device offline, Al plan, and local alarm.
management | ®  Set video detection alarm, offline alarm and Al plan of remote device.

e Setalarm linkage, including alarm linkage record, snapshot, buzzer, log, Email,
preset point, local alarm output, IPC alarm output, access control, and audio
prompt.

e  Customize alarm arm time.
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Name Description
Manage local user and ONVIF user.
e Local user adopts two levels of management, including user and user group.
User Each user group is a set of the authorities, which is a sub-set of total authority
management set and can be edited.
e Reset system default user (admin) password.
e  Support to add, modify and delete ONVIF user.
Manage physical HDD and network mapping HDD.
Storage e Get HDD slot status, HDD model, and space of physical HDD.
e Support RAID 0, RAID 1, RAID 5, RAID 6 and RAID 10. Support one-click
management i
creation of RAID, global hot spare and local hot spare.
e  Support FTP storage configuration and iSCSI network mapping.
It is to set security access strategy of the device.
e Set HTTPS login; remotely access the device through HTTPS protocol.
Security e Set IP authority. Forbid other devices logging in with IP address, MAC address.
center e Set account locking strategy. Lock the specified IP address for a period of time,
once the login attempts has reached the threshold.
e Enable system service manually.
Set basic configuration items of the system.
e System language settings, user logout period settings.
System e Manually set device time, or sync time with the NTP.
config e Set displayer resolution and refresh frequency.
e Create weekly schedule, to be used as alarm arm time.
e Audio management manages audio files.
System e View system information, background running tasks.
Notice e View and deal with alarm information.
It is to operate and maintain the device working environment to guarantee proper
Operation operation.
and e Search system log, user operation log, event log, and linkage log.
maintenance | e  Display online user, and block online user.
management | @  Device maintenance function such as device upgrade, restore factory default
settings, auto maintain, and configuration backup.

1.3 Login Mode

The device supports local, web and IVSS client operation. For details, see Table 1-2.

In—v—-l

Operation and system configuration in this manual is mainly based on IVSS client. There
might be differences from local or web operation. The actual interface shall prevail.

Table 1-2 Login mode

Login Mode Operation Description
Connect the display, mouse and keyboard to the )
) ) ) Support all functions of the
Local login device. View and operate the local menu on the devi
evice.
display.
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Login Mode

Operation

Description

Connect the device and PC into the same network,

Support majority functions

Web login , of the device, except live,
) and remotely access the device through browser

interface . record playback and

(Google Chrome and Firefox) on PC. ) .
video-related function.
. Connect the device and PC into the same network, )
Log in IVSS , i Support all functions of the
] download and install IVSS Client on PC, and then )
client device.

remotely access the device with IVSS Client.

Overview 4




The Grand Tour

This section introduces front panel, rear panel, port function and button function, indicator
light status, and so on.

2.1 8-HDD Series

2.1.1 Front Panel

Figure 2-1 Front panel
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Table 2-1 Front panel description
No. Button/Port Description
Boot up or shut down device. Power indicator light status is as
follows:
1 Power e When device is off (indicator light is off), press the button for
a short period to boot up device.
e When device is running, (blue indicator light is on), press the
button for at least 4 seconds to shut down the device.
Displays local input alarm status.
Alarm indicator pay o P L . .
2 light e The indicator light is off: There is no local alarm input event.
g e Red indicator light is on: There is local alarm input event.
Displays the system running status.
System status N S .
3 indicator liaht e The blue light is on: Device is running properly.
g e The indicator light is off: The device is not running.
Displays current network status.
Network e Theindicator light is blue: It means at least one Ethernet port
4 . . has connected to the network.
indicator light - —
e The indicator light is off: No Ethernet ports are connected to
the network.
5 USE Connects to external devices such as USB storage device,
keyboard and mouse.
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2.1.2 Rear Panel

Figure 2-2 Rear panel
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Table 2-2 Rear panel description

No. Button/Port

Description

1 Power

Power on/off button.

Power input

Inputs AC 100V-240V power.

Al module
indicator light

Displays Al module status.
e Yellow light flashes: Al module is running properly.
e Yellow light is on: Al module is malfunctioning.

I._-._.l

This function is not available without Al module.

4 eSATA

SATA peripheral port. Connect to SATA port or eSATA device.

5 RS-232

RS-232 COM debug. It is for general COM debug, set IP address,
transmit transparent COM data.

6 AUDIO IN

Audio input port.

7 AUDIO OUT

Audio output port.

8 HDMI

High definition audio and video signal output port.
The port outputs the uncompressed high definition video and
multi-channel audio data to the connected display with HDMI port.
The three HDMI ports are different source output.

9 VGA

VGA video output port. Output analog video signal. It can connect
to the monitor to view analog video. The two VGA ports are
different source output.

e VGA1 and HDMI 1 are same source output.

e VGAZ2 and HDMI 2 are same source output.

10 USB

Connects to external devices such as USB storage device,
keyboard and mouse.

11 Network

10M/100/1000Mbps self-adaptive Ethernet port. Connect to the
network cable.

12 Alarm output

8 groups of alarm output ports (NO1 C1-NO8 C8). Output alarm
signal to the alarm device. Please make sure there is power to the
external alarm device.

e NO: Alarm output port of Normally Open type.

e C: Common alarm output port.

° J:_: GND end.
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No.

Button/Port

Description

13

Alarm input

16 groups (1-16) alarm input ports, they are corresponding to

ALARM 1-ALARM 16. The alarm becomes valid in low level.

e A and B: Control the A/B cable of the RS—485 device. It is to
connect to the PTZ camera. Please parallel connect 120Q
between A/B cables if there are too many PTZ decoders.

° J:_: GND end.

2.1.3 Dimensions

Figure 2-3 Dimension (mm [inch])
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2.2 12-HDD Series

2.2.1 Front Panel

Figure 2-4 Front panel

12
o: []
Q.
Ol
&3
3 3
Table 2-3 Front panel description
No. | Button/Port Description
Boot up or shut down device. Power indicator light status is as follows:
e When device is off (indicator light is off), press the button for a short
Power period to boot up device.
e When device is running, (blue indicator light is on), press the button for
at least 4 seconds to shut down the device.
1 Position button. It is to control the ID indicator light on the rear panel. It is to
positioning the device.
ID button |.,_!|
ID button has the indicator light function. Its display status is the same with
the ID indicator light on the rear panel.
RESET button | Click to reboot the device.
Displays power status.
b e Blue light is on: The device has properly connected to the power
ower
o . source.
indicator light . ) ) .
e The indicator light is off: The device has not connected to the power
source.
o Displays local input alarm status.
Alarm indicator . ] .
light e Green light on: There is no local alarm input alarm.
i
g e Red indicator light is on: There is local alarm input event.
: Displays network statuses of Ethernet port 1 and Ethernet port 2.
e The indicator light flashes green: At least one Ethernet port has
Network
e _ connected to the network.
indicator light 1 o . ]
e The indicator light is off: All Ethernet ports are not connected to the
network.
Displays network statuses of Ethernet port 3 and Ethernet port 4.
e The indicator light flashes green: At least one Ethernet port has
Network
e _ connected to the network.
indicator light 2 o . ]
e The indicator light is off: All Ethernet ports are not connected to the
network.
Connects to external devices such as USB storage device, keyboard and
3 USB 3.0 port
mouse.

The Grand Tour 4




2.2.2 Rear Panel

Figure 2-5 Rear panel (the single-power series)
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Figure 2-6 Rear panel (the redundant series)
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Table 2-4 Rear panel description
No. | Name Description
Power input
1 Inputs AC 100V-240V power.
port
Displays Al module status.
e The yellow light flashes: Al module is running properly.
Al module N ) . -
2 o _ e The yellow light is on: Al module is malfunctioning.
indicator light
L]
This function is not available without Al module.
3 eSATA port SATA peripheral port. Connect to SATA port or eSATA device.
RS-232 COM debug. It is for general COM debug, set IP address,
4 RS-232 port )
transmit transparent COM data.
5 AUDIO IN Audio input port
6 Ground port. Ground port.
7 SAS port SAS extension port. It can connect to the SAS extension controller.
8 AUDIO OUT | Audio output port
Positioning indicator light. It is controlled by the ID button on the front
9 ID indicator panel.
light e The blue light is on, device is positioning how.
e The indicator light is off: The device is not positioning.
VGA video output port. Output analog video signal. It can connect to the
monitor to view analog video. The two VGA ports are different source
10 | VGA port output.
e VGA1 and HDMI 1 are same source output.
e VGA2 and HDMI 2 are same source output.
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No. | Name Description
High definition audio and video signal output port.(J
11 | HDMI port The port outputs the uncompressed high definition video and
multi-channel audio data to the connected display with HDMI port. The
three HDMI ports are different source output.
Connects to external devices such as USB storage device, keyboard
12 | USB port
and mouse.
10M/100/1000Mbps self-adaptive Ethernet port. Connect to the network
13 | Network port
cable.
8 groups of alarm output ports (NO1 C1-NO8 C8). Output alarm signal
to the alarm device. Please make sure there is power to the external
alarm device.
14 | Alarm output | ¢  NO: Alarm output port of Normally Open type.
e C: Common alarm output port.
° J:_: GND end.
16 groups (1-16) alarm input ports, they are corresponding to ALARM
1-ALARM 16. The alarm becomes valid in low level.
e A and B: Control the A/B cable of the RS—485 device. It is to
15 | Alarm input connect to the PTZ camera. Please parallel connect 120Q between

A/B cables if there are too many PTZ decoders.

° J:_: GND end.
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2.2.3 Dimensions

Figure 2-7 Dimensions (mm [inch])
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2.3 16-HDD Series

2.3.1 Front Panel

Figure 2-8 Front panel with LCD
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Figure 2-9 Front panel without LCD
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Table 2-5 Front panel description

No. Button/Port Description
Once the front panel lock is secure, it can prevent HDD from being
1 Front panel lock | stolen or removed by mistake. Unlock the front panel lock and
remove the front panel, you can view 16 HDD slots. See Figure 2-9.
Boot up or shut down device. The power on/off button has the
indicator light. It can display device-running status.
5 Power e When device is off (indicator light is off), press the button for a
short period to boot up device.
e When device is running, (blue indicator light is on), press the
button for at least 4 seconds to shut down the device.
Displays the system running status.
System status L o .
3 indicator liaht e The blue light is on: Device is running properly.
g e The indicator light is off: The device is not running.
Displays local input alarm status.
Alarm indicator pay . P L . .
4 light e Red indicator light is on: There is local alarm input event.
¢ e The indicator light is off: There is no local alarm input event.
Displays current network status.
e The indicator light is blue: It means at least one Ethernet port
Network
5 e , has connected to the network.
indicator light - S
e The indicator light is off: No Ethernet ports are connected to the
network.
Connects to external devices such as USB storage device, keyboard
6 USB port
and mouse.
After you remove the front panel, you can see there are 16 HDDs.
From the left to the right and from the top to the bottom, it ranges
from 1-4, 5-8, 9-12, and 13-16.
There are two indicator lights on the HDD slot: HDD indicator light
and HDD read/write indicator light.
7 16-HDD slot

& S . . . .
e O1: HDD indicator light. The light is yellow after you install the
HDD.

B8
e O: Read/write indicator light. The blue light flashes when it is

reading and writing data.
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2.3.2 Rear Panel

Figure 2-10 Rear panel (the single-power series)
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Figure 2-11 Rear panel (the redundant series)
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Table 2-6 Rear panel description
No. Name Description
Power input
1 Inputs AC 100V-240V power.
port
Displays Al module status.
e The yellow light flashes: Al module is running properly.
Al module N ) . -
2 o _ e The yellow light is on: Al module is malfunctioning.
indicator light @
This function is valid if there is Al module.
3 RESET button | Reserved.
High definition audio and video signal output port.(]
4 HDMI port The port outputs the uncompressed high definition video and
P multi-channel audio data to the connected display with HDMI port.
The three HDMI ports are different source output.
VGA video output port. Output analog video signal. It can connect
5 VGA port to the monitor to view analog video. The VGA port and HDMI 1 port
are same source output.
RS-232 COM debug. It is for general COM debug, set IP address,
6 RS-232 port .
transmit transparent COM data.
7 AUDIO IN Audio input port

The Grand Tour
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No. Name Description
AUDIO OUT Audio output port
8 eSATA port SATA peripheral port. Connect to SATA port or eSATA device.
Connects to external devices such as USB storage device,
9 USB port
keyboard and mouse.
10 SAS port SAS extension port. It can connect to the SAS extension controller.
10M/100/1000Mbps self-adaptive Ethernet port. Connect to the
11 Network port
network cable.
16 groups (1-16) alarm input ports, they are corresponding to
ALARM 1-ALARM 16. The alarm becomes valid in low level.
e A and B: Control the A/B cable of the RS—485 device. It is to
Alarm Input connect to the PTZ camera. Please parallel connect 120Q
between A/B cables if there are too many PTZ decoders.
° J:_: GND end.
12

Alarm Output

8 groups of alarm output ports (NO1 C1-NO8 C8). Output alarm
signal to the alarm device. Please make sure there is power to the
external alarm device.

e NO: Alarm output port of Normally Open type.

e C: Common alarm output port.

° J:_: GND end.
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2.3.3 Dimensions

Figure 2-12 Dimensions with LCD (mm [inch])
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Figure 2-13 Dimensions without LCD (mm [inch])
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2.4 24-HDD Series
2.4.1 Front Panel
Figure 2-14 Front panel with LCD
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Figure 2-15 Front panel without LCD
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Table 2-7 Front panel description

Button/Port

Description

Power on/off
button

Boot up or shut down device. The power on/off button has the

indicator light. It can display device-running status.

e When device is off (indicator light is off), press the button for a
short period to boot up device.

e When device is running, (blue indicator light is on), press the
button for at least 4 seconds to shut down the device.

USB port

Connects to external devices such as USB storage device, keyboard
and mouse.

Front panel
lock

Once the front panel lock is secure, it can prevent HDD from being
stolen or removed by mistake. Unlock the front panel lock and
remove the front panel, you can view 16 HDD slots. See Figure
2-15.

24-HDD slot

After you remove the front panel, you can see there are 24 HDDs.
From the left to the right and from the top to the bottom, it ranges
from 1-4, 5-8, 9-12, 13-16, 17-20, and 21-24.

There are two indicator lights on the HDD slot: HDD indicator light
and HDD read/write indicator light.

U] - . . . .
e OJ: HDD indicator light. The light is yellow after you install the
HDD.

° I%: Read/write indicator light. The blue light flashes when it is

reading and writing data.
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2.4.2 Rear Panel

Figure 2-16 Rear panel (the single-power series)
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Figure 2-17 Rear panel (the redundant series)
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Table 2-8 Rear panel description

No. Button/Port Description
Power input
1 port Inputs AC 100V-240V power.

16 groups (1-16) alarm input ports, they are corresponding to
ALARM 1-ALARM 16. The alarm becomes valid in low level.
e A and B: Control the A/B cable of the RS—-485 device. It is to

2 Alarm Input connect to the PTZ camera. Please parallel connect 120Q
between A/B cables if there are too many PTZ decoders.
° J:_: GND end.
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No. Button/Port Description
8 groups of alarm output ports (NO1 C1-NO8 C8). Output alarm
signal to the alarm device. Please make sure there is power to the
external alarm device.
Alarm Output e NO: Alarm output port of Normally Open type.
e C: Common alarm output port.
° J:_: GND end.
10M/100/1000Mbps self-adaptive Ethernet port. Connect to the
3 Network port
network cable.
4 SAS port SAS extension port. It can connect to the SAS extension controller.
Connects to external devices such as USB storage device,
5 USB port
keyboard and mouse.
6 eSATA port SATA peripheral port. Connect to SATA port or eSATA device.
; AUDIO IN Audio input port
AUDIO OUT Audio output port
RS-232 COM debug. It is for general COM debug, set IP address,
8 RS-232 port .
transmit transparent COM data.
VGA video output port. Output analog video signal. It can connect
9 VGA port to the monitor to view analog video. The VGA port and HDMI 1 port
are same source output.
High definition audio and video signal output port.(J
The port outputs the uncompressed high definition video and
10 HDMI port . . . .
multi-channel audio data to the connected display with HDMI port.
The three HDMI ports are different source output.
11 RESET button | Reserved.
Displays Al module status.
e The yellow light flashes: Al module is running properly.
Al module L ) . N
12 e The yellow light is on: Al module is malfunctioning.

indicator light

an|

This function is not available without Al module.
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2.4.3 Dimensions

Figure 2-18 Dimensions with LCD (mm [inch])
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Figure 2-19 Dimensions without LCD (mm [inch])
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Hardware Installation

You need to install HDD, connect cable, and so on, so IVSS can store videos and images for
features and properties analysis and comparison.

AWARNING

Some products are heavy. Several people may be required to carry the product jointly to
prevent personal injury.

3.1 Installation Flow

Follow Figure 3-1 to install the hardware.
Figure 3-1 Installation flow

»

Unpack Install HDD Connect Cable Boot up Finish

3.2 Unpacking the Box

When you receive IVSS, please check against the following items. If any of the items are
missing or damaged, contact the local retailer or after-sales engineer immediately.

No. | Item Content
Appearance Check whether there is any visible damage.
Check whether there is any accidental clash during
Package .
1 Whole transportation.

package | Accessories (list of
accessories on the | Check whether they are complete.
warranty card)

Appearance Check whether there is any visible damage.
) Check whether the model is the same as order

Device model

contract.
) Check whether it is torn or not.
2 Device

L1

The label on the }

device Do not tear off, or discard the label. Usually you need

to show the serial number when we provide
after-sales service.

3.3 HDD Installation

Install the number of HDD you require as per the following guidance.

L.—_.l

Different models support different HDD numbers, and the actual product shall prevail.
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3.3.1 12-HDD Series

A\

If you have not pushed the HDD box to the bottom, do not close the handle to avoid any
damage to the HDD slot.

Installing HDD

Button

@ Place one side of the

(DPress the button on the front | HDD closely along the

® Insert the HDD box into the

panel of IVSS, open the | upper side of the box and .
HDD slot, press it to the bottom,
handle, and then pull out the | press down to push the
) and then close the box handle.
HDD box. HDD down to the lower side

of the mounting surface.

Removing HDD

OPress the button on the
front panel of IVSS, open the
handle, and then pull out the
HDD box.

@ On the back of the HDD box,
press hard on the position

indicated by the arrow.

@ Take out the HDD and
reinsert the box to the slot. Push
it to the bottom and close the
box handle.

3.3.2 16/24-HDD Series

A\

If you have not pushed the HDD box to the bottom, do not close the handle to avoid any

damage to the HDD slot.

Installing HDD
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Button

® Lock the screws on the back of the
HDD box. Insert the box into the HDD slot,

(DPress the button on the push it to the bottom, and then close the
@ Put the HDD into the
front panel of IVSS, open handle.

box along the direction
the handle, and then pull i ) m
shown in the figure.

out the HDD box. In the figure, you only need to lock one set
of the screws (Group A or Group B). See
the actual situation.

Removing HDD

e = =——

Bu—tt(v)n;; A}~ 5| e —:7 il (]LE@EL

®@Unlock the screws on the

back of the HDD box.
(D Press the button on the 1]

front panel of IVSS, open the
handle, and then pull out the
HDD box.

(®Take out the HDD and reinsert
The screws are at different the box to the slot. Push it to the
positions for different HDDs, | bottom and close the box handle.
and the actual product shall
prevail.

3.4 Device Connection

You need to connect the ports of IVSS to different devices, so the IVSS can realize various
functions such trigger alarm, stores videos/images to USB storage devices. See Figure 3-2.

I—vJ

The following steps are to connect 16-HDD series device. Please refer to the actual product

for detailed information.

e Display, mouse and keyboard are needed for local operation.

e Before using the smart detection functions such as face detection and face recognition,
you shall install the Al module first.
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Figure 3-2 Connection diagram
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3.4.1 Alarm Connection

Before using the alarm, connect alarm input or alarm output device.

3.4.1.1 Alarm Port

For alarm port, see Figure 3-3 or Figure 3-4. For details, see Table 3-1.
Figure 3-3 Alarm port (8 and 12-HDD)
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Figure 3-4 Alarm port (16 and 24-HDD)

1 2 3 4 5 6 7 8 + +

B A NO5C5NO6C6NO7C7NO8CS

S¢5c¢5¢

BEABHAEY
T

9 10 11 12 13 14 15 16

ik
i

NO1C1NO2C2NO3 C3NO4 C4
ALARM OUT

ALARM IN |

Table 3-1 Alarm port

Ilcon

Description

1-16

They are corresponding to ALARM 1-ALARM 16. The alarm becomes
valid in low level.

NO1 C1-NO8 C8

Eight groups of normally open linkage output (on/off value)

+12V Constant power output, 500mA current.
-é— Grounding wire.

A and B: Control the A/B cable of the RS—485 device. It is to connect to
A B the PTZ camera. Please parallel connect 120Q between A/B cables if

there are too many PTZ decoders.
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3.4.1.2 Alarm Input

Both NO and NC are supported. The alarm input port supports alarm signal from ground and
device of 12V-24V voltage. If the alarm device is connected to the Device and other devices,

use relay for isolation. See Figure 3-5.

e GND and COM of alarm device shall be connected in parallel. Alarm device shall be

powered with external power source.

e Connect GND of alarm device with GND of Device in parallel.
e Connect the NC port of alarm device to the alarm input port (1-16).
Figure 3-5 NC alarm input connection

Wiring port of alarm device

1
+12V | GND | COM NC
(@) (@) © @ Wiring port of device
|— © ALARM
© GND
+12V  GND

3.4.1.3 Alarm Output

The alarm output port cannot be connected to high-power load (less than 1A). When forming
output circuit, the excessive current should be prevented from causing damage to the relay.
Use the contactor for isolation when applying high-power loads.
e The alarm output is on/off output (Normally Open Contact), and there should be external

power supply to alarm output device.

e RS-485 Aline and B line: connecting the A line and B line on the PTZ decoder.
e To avoid overload from damaging the Device, please refer to the parameters about relay.

For details, see Table 3-2.

Table 3-2 Relay parameters of alarm output port

Model HRB1-S-DC5V

Contact material Silver
Rated power capacity 24V DC 2A, 125V AC 2A

Rated value ,

) Maximum power 62.5VA/30W

(resistance -

load) Maximum power voltage 125V AC, 60V DC
Maximum power current 2A

) Between contacts 1000V AC 1 minute

Insulation -

Between contact and loop | 400V AC 1 minute

Insulation voltage

1000MQ (500V DC)

Turn-on Time

<5ms

Turn-off Time

<5ms

Mechanical

300 times/1 minute

Life

Electrical

30 times/1 minute

Operating ambient temperature

-30°C-70°C
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3.4.2 PTZ Decoder Connection

e The common-ground must be prepared for PTZ decoder and the Device; otherwise the
common-mode voltage might not be able to control the PTZ. It is recommended to use
shielded twisted pair, and the shielding layer can be used for common ground.

e Prevent interference from high-voltage power, make reasonable wiring, and take
measures for lighting protection.

e Remotely import 120Q to reduce resistance reflection and protect the signal quality.

e The Device Aline and B line cannot connect to other RS-485 output device in parallel.

e The voltage between the Aline and B line of PTZ decoder must be less than 5V.

3.4.3 Notes to Grounding

e Poor grounding of camera might damage the chip.
e When supplying external power source to the alarm device, the alarm device should be
common-grounded with IVSS.
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4 Booting Up IVSS

A\

e Before booting up IVSS, make sure the input voltage shall match the device power
requirement.

e To ensure stable operation of the device and prolong service life of HDD, provide stable
voltage with less ripple interference by reference to international standard.

e For device security, connect other cables of the device first, and then connect the device
to the power socket.

Startup may vary depending on the model you purchased.
e 8-HDD series IVSS: Press the power button on the rear panel to boot up IVSS.
e For other series IVSS:
¢ Connect to the power socket to boot up IVSS.
<& After clicking shutdown button on the GUI to shut down the device, press the power
button for a short period of time to boot up the device.
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Initial Settings

When using IVSS for the first time, initialize the device, and set basic information and

functions first.

5.1 Initializing Device

For first-time use after purchasing IVSS or restoring factory settings, set the login password
of admin (system default user). You can also set password protection.

[l

This section takes initialization on web for example.
Step 1 Open the browser, input IP address of IVSS, and press Enter key.
The Device Initialization interface is displayed. See Figure 5-1.

I-—v—-l

Default IP addresses of network port 1-4 are 192.168.1.108-192.168.4.108. Enter
the corresponding IP address of the actually connected network port.

Figure 5-1 Initializing the device

Device Initialization

@ Input Password @ Password Protection
.
& ®| (7
& (<]

Step 2 Set admin login password. See Table 5-1 for details.

Table 5-1 Description of password parameters

Parameter Description
User The default user name is admin.
b q Set admin login password, and confirm the password.
asswor
The new password can be set from 8 characters through 32 characters and
] contains at least two types from number, letter and special characters
Confirm e mm man o i
(excluding ™", ™", ", ":" and "&"). Enter a strong password according to the
Password
password strength prompt.
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Parameter Description

After setting the prompt, when you move the mouse to m on the login

Prompt interface, the system pops up a prompt to help you remember the password.
guestion m

The prompt question function is for local login interface only. Refer to the
actual interface for detailed information.

Step 3 Click Next.
The Password Protection interface is displayed. See Figure 5-2.
Figure 5-2 Password protection

Device Initialization

& Input Password @ Password Protection

Email {To reset password) E

Security Questions E
Question 1 What is your favorite book during your childhood? v

Answer

Question 2 What was the first name of your first boss? v

Answer

Question 3 What is the name of your favorite fruit? A

Answer

Step 4 Set password protection information. For details, see Table 5-2.
Setting the security questions here, you can use the email you input here or answer
the security questions to reset admin password. To reset password, see "8.7.3.2
Reset Password."

I-—v—-l

e Click ] to cancel Email or Security Questions box.

e If the email or security questions box is not set, the password can be reset on
local interface only.

Table 5-2 Password protection
Password protection mode | Description
Set email address. Reset the password through the reserved
email address.
Set security questions and corresponding answers. Reset
the password through the security question.
Step 5 Click Finish to complete device initialization.
The device initialization success interface is displayed. See Figure 5-3. Click Enter
Quick Settings to go to the quick setting interface, where you can quickly set system
time, IP address, and P2P. Refer to "5.2 Quick Settings" for more details.

Email

Security question
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Figure 5-3 Initialization completed

Successfully initialized the device!

5.2 Quick Settings

After initializing the device, it goes to quick settings interface. You can quickly set system time,
IP address, and P2P.

5.2.1 System Time

You can set system time and enable NTP function. After NTP is enabled, IVSS automatically
synchronizes time with the NTP server.
Step 1 On the initialization interface, click Enter Quick Settings.
The Time interface is displayed. See Figure 5-4.
Figure 5-4 Time

Quick Configuration

Date

20180122

Time

15:36:34

Time @ Manual Setting

Date/Time 2018 -01 - 22 15 : 36 : 33 Sync with your PC time Sync

Sync with Internet Time Server

Time and Date Format YYYY.MM.DD v 24HR v

Time Zone (UTC+08:00)Beijing v

Step 2 Set parameters. See 0.
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Table 5-3 System Time

Parameter Description

You can set system date and time by selecting Manual Setting or Sync with

Internet Time Server.

e Select Manual Setting and then input actual date and time. Click Sync,
to synchronize system time with PC time.

e Sync with the Internet Time Server: Check the box and then input NTP
server IP address or domain, and then set Auto Sync Time Interval.

[

Only IVSS client or web interface supports time synchronization function.

Time

Time and date . .
Set system date and time display format.
format

Time Zone Set device time zone.

Step 3 Click Next to save settings.

5.2.2 IP Address

It is to set device IP address, DNS server information and other information according to
network planning.

L'_.l

IVSS has 4 Ethernet ports by default. Make sure at least one Ethernet port is connected to
network before setting IP address.
Step 1 On Time setting interface, click Next.
The IP Set interface is displayed. See Figure 5-5.
Figure 5-5 Set IP

Quick Configuration

NIC NIC Type Dhep IP Address Subnet Mask Mac Speed Operate &£
® Ethernet Electric Port No 192.168.2.108 255.255.2550  34:22:3c:da:32.. 10M/100MSel s

Ethemnet Electric Port No 192.168.3.108 255.255.255.0 | 34:22:3d:da:32. 10M/100MSe L4
Ethernet Electric Port MNo 192.168.4.108 34:22:3d:d 10M/100M5Se 4

DNS Server Default NIC
C D e I Default Et t Ett N v

O) Use th owing DNS server addr
Preferred [
It: DNS B 4 4

Step 2 Configure IP address.

1) Click L4 of the corresponding NIC.

The Edit Ethernet Network 1 interface is displayed. See Figure 5-6.
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Figure 5-6 Edit Ethernet network 1

Edit Ethernet Network1 >

Static IP Address 192 168 3 108

Gateway 192 168 0 1

1) Set parameters. See Table 5-4.

Table 5-4 TCP/IP parameters description

Parameter Description

Speed

Current NIC max network transmission speed.

Use dynamic IP

When there is a DHCP server on the network, check Use Dynamic IP Address,
a dynamic IP address will be allocated to IVSS, and you don't need to set IP

address
address manually.
Use static IP Set a static IP address for IVSS. Check Use Static IP Address, and then set
address static IP address, subnet mask and gateway.
Set NIC MTU value. The default value is 1500 byte.
We recommend you to check the MTU value of the gateway first and then set
the device MTU value equal to or smaller than the gateway value. This helps
MTU reduce the packets slightly and enhance network transmission efficiency.

A\

Changing MTU value may result in NIC reboot, network offline and affect current
running operation. Please be careful!

Step 3

Step 4

Step 5

2) Click OK.
The IP Set interface is displayed.
Set DNS server information.
You can select to get DNS server manually or input DNS server information.

u

DNS server information must be configured if you want to use domain service.

e Select Obtain DNS server address automatically, then IVSS automatically
gets the DNS server IP address on the network.

e Select Use the following DNS server address, and then you need to manually
input preferred DNS and alternate DNS.

Set default NIC.

Select default NIC from the dropdown list.
L]

Make sure the default NIC is online.
Click Next to save settings.
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5.2.3 P2P Settings

P2P (peer-to-peer) allows resources directly available to network participants, with no need of
central coordination by hosts or servers.
For IVSS, you can scan the QR code to download cellphone APP without DDNS service or
port mapping or installing the transmission server. After registering a device account on the
APP, you can view the remote video, play back record file, and so on.
(1]
Make sure the system is connected to the network. Otherwise, the P2P function is not
available.
Step 1 On IP Set interface, click Next.

The P2P Access interface is displayed. See Figure 5-7. Scan the QR code on the

actual interface.
Figure 5-7 P2P access

Quick Configuration

® Time & [P Set @ P2P Access

P2P Access n

Implement the P2P access of the device, and prepare remote services for monitoring, video

alarm, cloud storage, device management and other remote services.

Mabile App Device QR Code

SN: 000000000000000000

-

1.Download App 2.Add Device 3.Watch monitoring

with App

Step 2 Click - to enable P2P function. The function is disabled by default.

Step 3 Click Finish to save settings.
After the configuration, you can register a device account on the APP to view video,
play back record file, and so on. Refer to corresponding cellphone APP for detailed
information.

5.3 Login

The device supports local, web and IVSS client operation.
e Display and mouse are needed for local operation.
e Remotely access with web and IVSS client. IVSS client is recommended.

L1
After initializing IVSS, you have logged in by default. Now you can set system settings and do
operations.
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5.3.1 Logging in Client

System supports working with the corresponding general applications (IVSS) to access the
device remotely. It is to realize system configuration, operations and system maintenance.
Step 1 Double-click the IVSS installation package.
1) Open the browser, enter IP address, and press Enter key.
Web login interface is displayed. See Figure 5-8.
Figure 5-8 Web login interface

’.‘,SS Login for iVSS

Forgot Password?

Current browser does not support video function *Click D!

2) Click Download to download IVSS Client installation package.

u

If you have downloaded IVSS Client packages, click Run Immediately to start
IVSS Client.
Step 2 Install IVSS Client.
1) Double-click the IVSS installation package.
The Install interface is displayed. See Figure 5-9.
Figure 5-9 Installation interface

VSS

V1.0.0.651721

English -

Install

M 1Agree EULA Custom >

2) Select language.
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3) Read EULA and then select | Agree EULA.
4) (Optional) Click Custom to select installation path and create shortcut. See
Figure 5-10.

Figure 5-10 Custom installation.

| Ay

English -

Install

M 1Agree EULA

EIGH C:\Program Files (x86)\iVSS\

™ Add Shortcut to Desktop

5) Tick I Agree, and click Install to install IVSS client.
Upon completion, the completion interface is displayed. See Figure 5-11.
Figure 5-11 The installation is completed

VSS

V1.0.0.651721

Installation is complete

Run

Step 3 Click Run or double-click shortcut icon E on PC desktop to log in IVSS Client.
L]

e When PC theme is not Aero, the system will remind you to switch the theme.
See Figure 5-12. To ensure video smoothness, switch your PC to Areo
theme. For details, see "10.4 Configuring IVSS Client."

e System display IVSS Client at full-screen by default. Click “EENF to
display the task column. See Figure 5-13.
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Figure 5-12 Prompt

-

==

MNon Aero

Your computer is using non-&ero theme, which will
affect the video fluency. Flease switch the theme to
Agro.

Figure 5-13 Main interface

iVSS | Please Enter URL

1) Enter device IP address, and then press Enter or click = .

The Login interface is displayed. See Figure 5-14.
Figure 5-14 Login

'.‘,SS Login for iVSS

Forgot Password?

2) Enter device user name and password.
(1]
e Click Login. For your device safety, change the admin password regularly
and keep it well.
e In case you forgot password, click Forgot password? and then follow the
prompts to reset the password.
3) Click Login.
The LIVE interface is displayed. See Figure 5-15 and Table 5-5.
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Vss

Figure 5-15 Preview

3 4567

Table 5-5 Main interface description

No. | Name Description
Displays enabled application icon.
1 Task Move the mouse to the app and then click n to close the app.
column
- L1
The live function is enabled by default and cannot be closed.
2 Add icon Click to display or hide app interface. On app interface to view or enable app.
Operation ) L
3 . Displays currently enabled app operation interface.
interface
) Click to view system information, which includes system error, system alarm
4 System info s
and system notification.
5 Background | Click to view the background running task information. You can view the all
task tasks, running tasks or waiting tasks.
Svst Click to enter system configuration mode. You can configure system settings
stem
6 y G such as network, event, and storage. See "8 System Configuration" for
confi
g detailed information.
. Click it to change user password, lock user, logout user, reboot device or shut
7 Login user .
down device.
Click to view alarm device name, alarm time and alarm type. For details, see
"7.4 Alarm List."
Al li
8 arm list L..!|
Click Press this icon to drag up and down to adjust its position.

5.3.2 Logging in Local Interface

IVSS can be directly connected with VGA display or HDMI display, and can carry out local
operation on the display.

Preparation
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Ensure that IVSS is connected with display, mouse and keyboard.

Properly wire all the required devices. For cable connection, see "3.4 Device Connection".

Operation Steps
Step 1 Turnon IVSS.

The Login interface is displayed. See Figure 5-16.
Figure 5-16 Login

,.‘,SS Login for iVSS

@ Prompt Password Forgot Password?

Login

Step 2 Enter user name and password.

u

e Click Login. For your device safety, change the admin password regularly and
keep it well.

e Move the mouse to m to view the password prompt information. It is to help

you remember password.
e In case you forgot password, click Forgot password? and then follow the
prompts to reset password.
Step 3 Click Login.

The LIVE interface is displayed. See Figure 5-17.
L]

Click @ to control the local screen. Device can connect to multiple displays at the

same time. You can select a display you want to use.

Initial Settings 36



Figure 5-17 Live

¥ 0 17-10-12.20:30:42
P2017-10:12 0304/

5.3.3 Logging in Web

System supports general browser such as Google Chrome, Firefox to access the web to
manage the device remotely, operate and maintain the system.
L]
When you are using general browser to access the web, system supports setting function
only. It cannot display the view. It is suggested that IVSS client should be used.
Step 1 Open the browser, input IP address, and click Enter.
The Login interface is displayed. See Figure 5-18.
Figure 5-18 Web login interface

’.‘ISS Login for iVSS

Forgot Password?

Step 2 Enter user name and password.
L1]
e Click Login. For your device safety, change the admin password regularly and
keep it well.
e In case you forgot password, click Forgot password? and then follow the
prompts to reset password.
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Step 3 Click Login.
The LIVE interface is displayed.

5.4 Configuring Remote Device

Initialize remote device and then add it to IVSS, then you can manage remote device and set
its parameters through IVSS.

5.4.1 Initializing Remote Device

After you initialize remote device, you can change remote device login password and IP
address. After initialization of remote device, IVSS can be connected.

Step 1 Click , or click on setting interface, and then select DEVICE.

The DEVICE interface is displayed. See Figure 5-19.
Figure 5-19 Device management

MACL  Scetecanazbe

+ add s

Step 2 Click + or Add, and then select Smart add.

The Smart add interface is displayed.
Step 3 Search remote device.
1]

System searches the remote devices of current IP segment by default.
1) Click {c}}

The Add interface is displayed. See Figure 5-20.
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Figure 5-20 Add

Add X

Manufacturer
All

Private Panasonic Sany Dynacolor Samsung AXIS

Arecont Airlive Canon e LG Pelco

SANYOD Watchnet Hunmei Other

IP Address

IP Address (®) IPSegment

fram . . . ‘ to

) Select manufacturer and set IP address you want to search.
e |tisto set remote device IP address. System can search the corresponding
remote device.
e |t is to set remote device IP segment. System can search the remote
devices of current IP segment.
) Click OK to save the configuration.
System goes back to Device interface.
) Click Start Search.
System starts to search and then displays search results. See Figure 5-21.
Figure 5-21 Remote device

N

w

N

Add Device X
Smart Add Manual Add Import CSV File
W Stop Search Searching... .j:) 75 : @
(0) Initialization State « Address Product Model Manufacturer Product Type Sn Operate
v Initialized EVS Private EVS [
v Initialized PC-NVR Private [
IPC-HFW8281E Private IPC YZC4DZ029WO... LIVE
DH-TPC-PT862... Private TPC 4KO52E2YAKT... @
v Initialized JF-NC301RP-K... Private IPC 2A01EBAYAZO... IEI
v Initialized NVR WatchNet NVR (]
v Initialized RVi-1NR08120-P Private RVi
iWI IPC-HF8249F-FR Private IPC 3L05538PAK00... Erl . %
Total 75 Item(s) Show upto | 50 - 1/2 > > GO
Bandwidth : 13.5Mbps/512Mbps Cancel

Step 4 Select uninitialized remote device and then click Initialize button.
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The Device Initialization interface is displayed. See Figure 5-22.

C="T1Ips

Click Initialization status and then select Uninitialized, you can quickly filter the
uninitialized remote device.
Figure 5-22 Initializing the device

Device Initialization »

@ Password Protection ® Modify IP

Using current device password and password protection

information n

a @ 7

Cancel

Step 5 Set remote device password and password protection.
L[]
Using current device password and password protection information: Check the box

to use current device admin account and email information. There is no need to set
password and email. Go to Step 6.

1) Click ] to select the Using current device password and password

protection information check box.
The password setting interface is displayed. See Figure 5-23.
Figure 5-23 Password setting

Device Initialization *®

@ Password Protection ® Modify IP

Using current device password and password protection

information |

B sereress @

cnce
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2) Set parameters. See Table 5-6.

Table 5-6 Description of password parameters

Parameter Description

Username The default user name is admin.

Password In thg New Password box, enter the new password and enter it again in the
Confirm Password box.
The new password can be set from 8 characters through 32 characters and

Confirm contains at least two types from number, letter and special characters

Password (excluding ™", "™, ™", ":" and "&"). Enter a strong password according to the
password strength indication.

3) Click Next.

The Password Protection interface is displayed. See Figure 5-24.

Figure 5-24 Password protection

Device Initialization 5

& Password 2 Password Protection ® Modify IP

Email (To reset password)

Back Cancel

4) Set an Email address.
Input an email address for resetting password purpose. You can use the email
address here to reset password in case you forgot password in the future.

Step 6 Click Next.

The Modify IP interface is displayed. See Figure 5-25.
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Figure 5-25 Modify IP

Device Initialization . be
@ Password @ Password Protection m
(1) Sn IP Address

32:c5:18:1d1:b1 192.168.1.103

DHCP (@ Static

Static IP Incremental
Address . . Value 1

Subnet Mask

Gateway

Back Next Cancel

Step 7 Set camera IP address.

e When there is DHCP server in the network, select DHCP, and the remote device
gets dynamic IP address automatically. It is unnecessary to enter IP address,
subnet mask and gateway.

e Check Static, and then enter static IP address, subnet mask, default gateway
and incremental value.

e  After you input incremental value, system can add the fourth address of the IP
address one by one to automatically allocate the IP addresses.

e If you want to change several devices IP addresses at the same time, system
allocates IP address of the same network segment.

e If there is IP conflict when changing static IP address, device pops up IP conflict
dialogue box. If batch change IP address, device automatically skips the
conflicted IP and begins the allocation according to the incremental value.

Step 8 Click Next.
Device initialization starts. See Figure 5-26.
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Figure 5-26 Initialize

Device Initialization i A

Finish

No.(1) Sn IP Address Results

1 000000000000000000 192.168.1.102- 192.168.1.102 Success

Confirm and then add m

Step 9 Click Confirm and Add, or click OK.
e Click Confirm and Add: System completes initializing the remote device and
then adds the remote device to the list. System goes back to Add device

interface.
e Click OK: System completes initializing remote device. System goes back to

Add device interface.

5.4.2 Adding Remote Device

5.4.2.1 Smart Add

Search the remote devices on the same network and then filter to register. It is applicable
when you don't know the exact IP address.

. .
Step 1 Click k=dl, and then select Device.

The Device interface is displayed.

Step 2 Click + or Add, and then select Smart Add.
The Smart Add interface is displayed. See Figure 5-27.
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Figure 5-27 Short-cut menu

Add Device ®
Smmart Add Manual Add Import CSV File
#
There are no rows in the table!
Bandwidth : &.28Mbps/400Mby Cancel
Step 3 Search remote device.
1]
IVSS searches the remote devices of current IP segment by default.
1) Click o3
The Add interface is displayed. See Figure 5-28.
LI
The actual interface shall prevail.
Figure 5-28 Add
Add X
Manufacturer
All
Private Panasonic sony Dynacelor samsung AXIS
Arecont Airlive Canen e LG Pelco
SANYOD Watchnet Xunmei Other
IP Address

IP Address (@ IPSegment

from . . . to

s

2) Select manufacturer and set IP address you want to search.
e |tisto set remote device IP address. System can search the corresponding
remote device.
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W

The

N

It is to set remote device IP segment. System can search the remote
devices of current IP segment.

) Click OK to save the configuration.

Add interface is displayed.

) Click Start Search.

Search result is displayed. See Figure 5-29. Select remote device and then click

Add

. Device begins add remote device and pops up confirmation interface. For

details, see Table 5-7.

Figure 5-29 Search result

Add Device X
Smart Add Manual Add Import CSV File
LISl Searching.. (D) 75 @
(0) Initialization State « Address Product Model Manufacturer Product Type Sn Operate
EVS Private EVS
PC-NVR Private LI
IPC-HFW8281E Private IPC YZCADZ029WO...
DH-TPC-PT862... Private TPC 4KO52E2YAKT.. (]
JF-NC301RP-K... Private IPC 2A01EBAYAZO.. LIVE
NVR WatchNet NVR
RVi-1NR0O8120-P Private RVi
! nitialize IPC-HF8249F-FR Private IPC 3L05538PAKO0... & X %
Total 75 Item(s) Show upto | 50 v 1/2 % » GO
Bandwidth : 13.5Mbps/ Cancel

Table 5-7 Result description

Parameter

Description

Start search

Click Start Search to start searching remote device. Now it becomes Stop
Search button. Click Stop Search button to stop searching remote device.

Select uninitialized remote device and then click Initialize button to initialize

Initialize remote device. Refer to "5.4.1 Initializing Remote Device" for detailed

information.
o Displays remote device initialization status.

Initialization

State Click ™ to filter initialized or uninitialized remote device.
Click to display real-time preview video from the remote device. See
Figure 5-30. Click . or Close to close the real-time preview window.

Operation

L'_.l

You can view the live video if admin password of the remote device is admin, or
remote device admin’s password is the same as the system.
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Parameter Description

Displays registered remote device bandwidth and supported remote device
bandwidth.

Bandwidth

Figure 5-30 Real-time view

Manufacturer Private

Address ==~ —_

‘;“ Initialization State Initialized

SN _ e -
Product Type TPC
Product Model TPC-BF5400

Port 37777

Step 4 Adding a remote device.
e Add 1-channel remote device.
Select a remote device and then click Add. Device begins adding remote device
and pops up confirmation interface. See Figure 5-31.

[

¢ During the adding process, click Cancel button, you can cancel adding
process. Click Stop button of the corresponding remote device to cancel
add.

¢ Double click remote device IP address, user name, password,
manufacturer, port to change corresponding information.

& If system fails to add the remote device, refer to the reason on the Status
column to change the remote device information and then click Retry to try
to add again.

Figure 5-31 Add confirm (1-channel)

Add Confirm —

Address Username Password Manufacturer Paort Status Operate

192.168.1.101 admin | e Private 37727 Added

Bandwidth : 12.552Mbps/7 46 Continue to add Finish
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e Add multiple-channel remote device
1) Select a remote device and then click Add button.
The Add interface is displayed. See Figure 5-32.
Figure 5-32 Add confirm (multiple-channel)

Add Confirm

Address Username Password Manufacturer Part Status Operate

..... Private 40009 Please select a cha

192.168.1.103 admin

Continue to add Finish

Bandwidth : 30.949%Mbps/

2) Double click Please select a channel.
The Video Device interface is displayed. See Figure 5-33.
Figure 5-33 Video device

(1) Video Device ¥

IP PTZ Camera

CAM 2

EN -

3) Select a channel you want to add.

Click * and then input the key words, it can quickly search the channel you

want to add.
4)  Click OK to add the select channels.
Step 5 Click Continue to add or Finish.

e Click Continue to add, device goes back to Smart add interface to add more

remote device.
Click Finish to complete adding remote device process. Device displays Device

[ ]
interface to view the newly added remote device information.
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5.4.2.2 Manual Add

Enter the IP address, user name and password of remote device, and then add it to IVSS. It is

applicable when you want to add a specific device to IVSS.

Step 1 Click , and then select Device.

The Device interface is displayed.

Step 2 Click + and then select Manual add.

The Manual Add interface is displayed. See Figure 5-34.
Figure 5-34 Manual add

Add Device %
Smart Add Manual Add Import C5V File
+ Add Device o Delets
(1) Device Type Manufacturer Address User Mame Password Port Operate
Private admin e 37777 o+
Total 1 ltem(s) Showupto | 50 - Y. co
Bandwidth © B.4Mbps/ Cancel

Step 3 Click Add Device button.
The Add Device interface is displayed. See Figure 5-35.
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Figure 5-35 Add device

Add Device %
Smart Add Manual Add Import CSV File
+ Add Device b Delete
(1) Device Type Manufacturer Address User Mame Password Port Operate
] Devices v Private admin e 37777 m +
m
Total 1 Item(is) Showupto | 50 - Y, co
Bandwidth © B.4Mbps/ Cancel

Step 4 Set parameters. For details, refer to Table 5-8.

Table 5-8 Remote Devices Configurations Description

Parameter

Description

Type

It is to select remote device type. The default type is Devices.

Manufacture
r

Displays the connection protocol of the remote device. Default protocol of the

system is Private. Double click Private to select other protocols.

To add stream media device, select Rtsp protocol, and enter RTSP address of

stream media device in Address column. See Figure 5-36.

Rtsp://<user name>:<password>@<IP

address>:<port>/cam/realmonitor?channel=1&subtype=0U.

e Port: Enter port number. The default setting is 554.

e Channel: Enter channel number of the stream media device to be added.

e Subtype: Itis to set record bit stream type. It includes main stream 0 and
sub stream 1.

For example

rtsp://admin:admin@192.168.20.25:554/cam/realmonitor?channel=1&subtype

=0.

L]

To add a stream media device, it is unnecessary to set user name, password,

and port.

Address

Enter the IP address or RTSP address of remote device.

Username

Password

It is to input user name and password of remote device.

Port

Displays port number of remote device.

Initial Settings 49




Parameter Description

Delete current line or add a new line.

o

e Click @ to delete current line information. Select multiple lines of

remote device information, and then click Delete to batch delete the

Operation . .
selected information.
e Click ¥ toaddanew line. Enter remote device information to add
several devices at the same time.
Figure 5-36 Rtsp Adding
Add Device x
Srmart Add Manual Add Import CSV File
+ Add Device m Delete
(1) Device Type Manufacturer Address User Name Password Port Operate
Devices Private Rtspe//admin:lga admin e 37777 o+
Total 1 ltem(s) Showupto | 50 - Y. Go
Bandwidth : B.4Mbps/ m Cancel

Step 5 Adding a Remote Device.
e Add 1-channel remote device.
Select remote device and then click Add button. Device begins add remote
device and pops up confirmation interface. See Figure 5-37.

[

¢ During the adding process, click Cancel button, you can cancel adding
process. Click Stop button of the corresponding remote device to cancel
add.

¢ Double click remote device IP address, user name, password,
manufacturer, port to change corresponding information.

¢ If system fails to add the remote device, refer to the reason on the Status
column to change the remote device information and then click Retry to try
to add again.
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Figure 5-37 Add confirm

Add Confirm s
Address Username Password Manufacturer Port Status Operate

192.168.1.105 admin = e Private 40009 Added

Bandwidth : 30.949Mbps/7 45} Continue to add Finish

e Add multiple-channel remote device
1) Click Add.
The Add Device interface is displayed. See Figure 5-38.
Figure 5-38 Add confirm

Add Confirm S <
Address Username Passwaord Manufacturer Part Status Opesate
192.168.1.106 admin e Private 40009 Please select 3 cha

Bandwidth : 30,949Mbps/74 8! Continue to add Finish

2)  Double click Please select a channel.
The Video Device interface is displayed. See Figure 5-39.
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Figure 5-39 Video device
© Video Device ¥

IP PTZ Camera

CAM 2

3) Select a channel you want to add.

Click * and then input the key words, it can quickly search the channel you

want to add.
4)  Click OK to add the select channels.

Step 6 Click Continue to add or Finish.
e Click Continue to add, device goes back to Smart add interface to add more

remote device.
e Click Finish to complete adding remote device process. Device displays Device

interface to view the newly added remote device information.

5.4.2.3 Template Add

Fill in information about remote device in the template, import the template to add the device.
It is applicable when user name and other information of remote devices are not the same.

Step 1 Click , and then select Device.

The Device interface is displayed.

Step 2 Click + or Add, and then select Import CSV file tab.
The Import CSV file interface is displayed. See Figure 5-40.
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Figure 5-40 Import CSV file

Add Device %
Srmart Add Manual Add Import CSV File
Choose File Browser... Import
(0) Device Type Manufacturer Address User Mame Password Port Operate
Total 0 Item(s) Showupto | 50 - Y. co
Bandwidth : &4Mbps/ Cancel

Step 3 Fill in template file.
1) Click Download Template to download template file.
File path may vary depending on interface operations, and the actual interface
shall prevail.

e At IVSS client, click = , select Download content to view file saving path.

For details, see 10.3 View Downloads
e Select file saving path during local operation.

I._.-_.l

Connect USB device to IVSS if you are on the local menu to operate.
e During web operations, files are saved under default downloading path of
the browser.
2) Fillin template file and save according to your actual situation.
The following information of template file shall be filled in. See Figure 5-41.

u

If information about remote device is not filled in completely, improve it after
importing template.
Figure 5-41 File

A E © D E F G
1 IP Address Port Channel No.  Channel Name Manufacturer User Name Password
2
&

Step 4 Import template file
1) Click Browse to select the upgrade file.
2) Click Import.
The imported information about remote device is displayed. See Figure 5-42.
1]
e When information about remote device is incomplete, complement it
according to your actual situation.
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Click @ to delete current line information.

[
Figure 5-42 Device information

Add Device %

Smart Add Manual Add port CSV File

Choose File Browse Import Download Template

(0) Device Type Manufacturer Address User Name Password Port Operate
Total O ltem(s) Showupto | 50 - 1 co
Bandwidth : 13 44Mbps/ Cancel

Step 5 Add remote device.

Add 1-channel remote device.

Select a remote device and then click Add button. Device begins adding remote
device and pops up confirmation interface. See Figure 5-37.

L]
<

During the adding process, click Cancel button, you can cancel adding
process. Click Stop button of the corresponding remote device to cancel
add.

Double click remote device I[P address, user
manufacturer, port to change corresponding information.
If system fails to add the remote device, refer to the reason on the Status
column to change the remote device information and then click Retry to try
to add again.

name, password,
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Figure 5-43 Add confirm

Add Confirm R
Address Username Password Manufacturer Port Status Cpesate

192.168.1.105 admin e Private 40009 Added

Bandwidth : 30.949Mbps/748} Continue to add Finish

e Add multiple-channel remote device
1)  Select a remote device and then click Add button.
Enter Add interface. See Figure 5-44.
Figure 5-44 Confirm

Add Confirm - R
Address Username Password Manufacturer Port Status Cperate
192.168.1.106 admin = e Private 40009 Please select 3 cha

Bandwidth : 30.949Mbps/ 48 Continue to add Finish

2)  Double-click Select a channel.
Enter Video channel interface. See Figure 5-45.
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Figure 5-45 Video device
© Video Device ¥

IP PTZ Camera

CAM 2

Kl -

3) Select a channel you want to add.
Click * and then input the key words, it can quickly search the channel you

want to add.
4)  Click OK to add the select channels.
Step 6 Click Continue to add or Finish.
e Click Continue to add, device goes back to Smart add interface to add more
remote device.
Click Finish to complete adding remote device process. Device displays Device

manager interface to view the newly added remote device information.
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Al Operations

Al detection is to process and analyze the video and take the key information, compare the

key information with the preset detection rule and trigger an alarm once the detected

behavior matches the detection rule.

The device supports Al by camera and Al by device.

e Al by camera: The camera supports smart detection. The IVSS needs to detect and
display the intelligent alarm information from the remote device.

e Al by device: The camera only provides videos and snapshots, but IVSS supports smart
detection.

I—'_.l

When Al by camera is enabled, smart detection configuration has to be set on remote device.
See remote device user’s manual.

6.1 Enabling Al Plan

Al functions, such as Al detection and analysis, will not work before Al plan is enabled.

e Al plan is available on select models.
e The interface may vary with different Al functions.

Step 1 Click , or click on setting interface, and then select EVENT.

The EVENT interface is displayed.
Step 2 Select camera in the device tree on the left.
Step 3 Select Al Plan > Al Plan > Al Plan.
The Al Plan interface is displayed. See Figure 6-1.
Figure 6-1 Al plan(1)

" v ——
Q g |9 Ml AlPlan Al Display
v IVSS X, VideoMotion ~
* @ Diee & Toers v
» Gy 1D01DT7PAWO00124 Face Detection ]
¥ {y 1D01D77PAWO00124 ¥ IPCOffline
B8 IPC Offline v
 AlPlan
o & AP
Ly cameral = an
&y camera2 II Face Detection
Sy camera3 PL Face Recognition
Ly camerad B s -
Cy 1715.39.22-15-1102
[l Access
@ RTSP Media

Step 4 Click - to enable Al detection plan. The icon becomes .j.
Step 5 Click Save.
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6.2 Face Detection

e After you configure face detection and face comparison function, the device processes
and analyzes video image, extract face information from the video, and compare it with
face images in the face database.

e Alarm is triggered when similarity reaches or exceeds the designated similarity.

e |VSS supports real-time view of face detection and face comparison information;
searches and plays back video according to face features.

I—vJ

IVS and face detection function cannot be enabled at the same time.

6.2.1 Setting

Set face comparison flow. See Figure 6-2.

L.—_.l

e You need to enable Al plan before using Al by camera. Refer to "6.1 Enabling Al Plan" to
enable Al detect function.
e You cannot search by image when you are using Al by camera and face comparison.
Figure 6-2 Face comparison flow

Set face
database

Start

detection playback

[ (Creae )| [ Setface 3 ) 0 :
i database i i detecatckfnj i [Setmdlsplaa i (Atlribute j |
i P i i '
i [ N [ I
: | (“Setface H(Viewlive | !!( Search |
i image i | \_recognition / |! |_image i by image ) |
| | 4 |
: : : ¥ :
! : 1 11 I
i I i i i
) 1 1 1

[Exporl file j

.

6.2.2 Configuring Face Database
You can create the face database to save face image, and the intelligent detection function
can trigger the face database to carry out human face comparison, human face search, and

so on. For face database configuration flow, see Figure 6-3.
Figure 6-3 Deleting face database

Create face database Register face image Face abstracting Finish

6.2.2.1 Creating Face Database

Create human face database to sort out and manage the face images uploaded to IVSS.

Creating human face database
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Step 1 On the LIVE interface, click , select File > Face database.

Face database interface is displayed.
Step 2 Click Create.
The Create interface is displayed. See Figure 6-4.
Figure 6-4 Create face database

Create ¢

@ Face database name @ Register Face

Face database name

Cancel

Step 3 Set Face database name.
Step 4 Click Register face or Save and close.
e Click Register face, and then add human face on the newly created human
database. See Figure 6-5.
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Figure 6-5 Register face

Create

Usage 0%

Add mode

® Face database name @ Register Face

@® Manual Add

Batch Import

* Name

Gender

Birthday

Country or Region

Address

ID Type

ID No.

Back

@® Male

Female

Cancel

Click Save and close to create a human face database with no data.

After creating face database, you can go to the Face Database interface to view the
newly created face database information. See Figure 6-6. For details, see 0.

& Face Management

A

Murmber 0

I
&an ®o

Figure 6-6 Face database

+ B velere e 7%
s
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Table 6-1 Description

No. Description

Database".

Click Create to create a face database. For details, refer to "6.2.2.1 Creating Face

2 Select a face database, and then click Delete to delete the database.

Display number and space information of face database.

e Number: The percentage ratio of the added face image quantity to the allowable total
guantity of face image. Device supports maximum 300,000 face images.

e Space: The percentage ratio of the created face database quantity to the allowable
total quantity of face database. Human face database creation. Maximum 50
databases.

Check All to select all face databases.

5 Display the list of created databases.

Display abstract state.

20 displays face image of current database that failed to abstract.

Operation

You can modify database name, upload face images to database, arm or delete the database,
after the database is created. Refer to Table 6-2 for detailed information.

Table 6-2 Operation of face database

information and
state.

Name Operation
View face database information and state in face database zone.
° 4k Set Human face database name.
View face o« 394515 to display face image of current database.
database

e # Ujsto display human face that failed abstracting. Refer to "6.2.2.3

Human Face for detailed information.

e @ means current face database has not connected to the corresponding

channel to compare human face. After arm, the interface can display the
remote device that is connected with the face database.

Change face
database name

Click [# to change face database name.

Managing face

Double click face database to enter face database interface and manage face

image images. For details, refer to "7.3 File Management".
Arming face Link the face database to compare faces, and arm the face database. For
database details, refer to "6.2.4 Configuring Face ".
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Name Operation

e Delete: Move the cursor to the face database and click I at the top right

corner of the face database to delete.
Deleting face
database e Batch delete: Move the cursor to the face database and then click at
the top left corner of the face database. Select several face databases at
the same time and then click Delete to delete them.

e Check All box and then click Delete to delete all face database.

6.2.2.2 Adding Face Image

Add face images to the created face database in the way of manual add, batch import and
detection.

Preparation

e Aface image has been obtained, and it meets the following requirements:
¢ The image format is .jpg.
¢ The image size shall be less than or equal to 4MB.
<& The resolution ranges from 100x100 to 6000x5000.
e You have obtained the face image and saved it in the proper path.
¢ When operating on the local interface, save the image in the USB storage device
and then connect the USB storage device to the IVSS.
¢ When operating on the Web or IVSS interface, save the image on the PC in which
the Web or IVSS client is located.

6.2.2.2.1 Manual Add

You can add human face image one by one. If the registered human face image quantity is
small, you can use manual add mode.

Step 1 On LIVE interface, click , select File > Face Database.

Face Database interface is displayed.
Step 2 Double click face database.
Face database interface is displayed. See Figure 6-7.
Figure 6-7 Manual add

All ﬂ

Step 3 Click Manual Add.
The Face Register interface is displayed. See Figure 6-8.
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Figure 6-8 Face register

Face Register X

* MName
Gender @ Male Fernale
Birthday - -

Country or Region -
Address
ID Type -

1D M.
e
Cancel
Step 4 Click and select face image.

The Open interface is displayed. See Figure 6-9.
L1]

e When the uploaded image is half-length photo or full-body photo, the system
automatically selects the frame of the uploaded image and only the face area
will be retained.

e When there are multiple faces in the uploaded images, the system
automatically identifies the faces in the images and uploads multiple face
images according to the number of faces recognized. See Figure 6-10. Select
face image you want to upload. Blue frame means that it is selected.

e Click Cancel to cancel all checked face images.
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Figure 6-9 Confirm choice

Confirm Choice X

@ Select the face to add Upload Again

=
=

-

-

N
< = >
. )
Cancel
Figure 6-10 Confirm choice
Confirm Choice b
@ Select the face to add Upload Again
< >
Cancel

Step 5 Click OK, import face image.
The Face Register interface is displayed. See Figure 6-11.

I-—-—-l

Move the cursor to the face image and click Change Image to change it.

Al Operations 64



Figure 6-11 Face register

Face Register K
* Name -
A
Gender (@ Male Female
Birthday - -
Country or Region -
=
- Address
X )
1D Type -
= ID Ma.
Cancel

Step 6 Fill in face image information.
Step 7 Click Save and continue to add or OK.
e Click Save and continue to add, it is to save current face image information
and add another human face image.
e Click OK to save current face image information and complete registration.
After adding the image, at the bottom left corner of the human face image, there is an

icon - It means device is creating module. See Figure 6-12. Refer to "6.2.2.3

Human Face for detailed information.
Figure 6-12 Manual add

- o &ooin  EEEEN
» & Q

A

Name ; =ge = ame ; =

F Birthday: - Birthday
L 1D Type : Unknown ¢ 10 Type : Unknown
ot |
=
Addres —.‘-J-

6.2.2.2.2 Batch Import

Batch import is to import multiple face images at the same time by uploading file or uploading
folder. If you want to register a large number of face images, batch import is recommended.

Preparation

Before the batch import, name the face image according to the following rule:
"Name#SGender#BBirthday#NNation#PProvince#TIDtype#MIDnumber#AAddress.jpg"
(such as"Tim#S1#B20000101#NCN#PZheJiang#T1#M0000#AAddress").
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Name the face image according to the rule. After successful import, the system will identify
the face image automatically. For details about naming rule, see Table 6-3.

N

Name is required and the rest are optional. For example, if you want to enter the name and ID
number only, the naming can be Tim#S#B#N#P#T#MO0000#A.jpg or Time#M0000.jpg.

Table 6-3 Naming rules for batch import

Item Description
Name Enter the corresponding name.
Gender Enter number. 1: Male; 2: Female.
) Enter number in the format of yyyymmdd or yyyy-mm-dd. For example,
Birthday

20181123.

Abbreviation of
countries/regions

Enter the corresponding abbreviation of the nation/region.

Province Enter the corresponding spelling or English name of the province.

ID type Enter the corresponding number. 1. ID card, 2. Passport, 3. Officer Card.
ID number Fill in the corresponding ID number.

Address Enter the detailed address.

Operation Steps

Step 1 On the LIVE interface, click , select File > Face Database.

Face Database interface is displayed.
Step 2 Double-click face database.
The face database interface is displayed.
Step 3 Click Batch Import.
The Batch Import interface is displayed. See Figure 6-13.

Figure 6-13 Batch import

Batch Import

Maming Format:
Example:
Gender{Number):
Birthday:

ID Type(Mumber):

Mame #5Gender#BBirthday#MNCountry#TID Type#MID Mumber#AAddress.jpg{Mame required, others optional)
Tom#S1#B1990-01-01#MUSET1EM123456782EANorth Main Street.jpg

1.Male 2.Female

yyyymmdd

11D Card 2.Passport 3.Officer Card

Cancel
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Step 4 Import face image.

The system supports to upload file and folder. Select according to your actual need.
e Upload File

1) Click to select multiple face images.

¢ Press and hold Shift, click any two images, so both images and all
images between them can be selected.
¢ Press and hold Citrl, click multiple face images to select them.
2)  Click Open.
e Upload Folder

1) Click and select the folder where there are face images.

2)  Click OK.
The number of face images is displayed. See Figure 6-14.
Figure 6-14 Batch import

Batch Import »

Selected: 3 images

Step 5 Click OK.
The batch import result interface is displayed. See Figure 6-15.
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Figure 6-15 Batch import

Batch Import by

3 successfully imported. 0 failed imported

Step 6 Click Continue to add or OK.
e Click Continue to add to add more images.
e Click OK to complete adding images. Face database interface is displayed, and
you can see the added images. See Figure 6-16.
After adding the image, at the bottom left corner of the face image, there is an icon. It
means device is creating module. Refer to "6.2.2.3 Human Face for detailed

information.
Figure 6-16 Face database
® Back & 1212 [EEEER
5 2 b # oel Ql
i . Sl A - - il

6.2.2.2.3 Detection Add

You can add snapshots from Al detection to the created face database.
Step 1 Select face images on the LIVE interface.
e Click .I. or ", and move the mouse to the image.

e  After opening face detection window, move the mouse to face image in the
feature panel.

u

Take adding face detection image for example.
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The operation icons are displayed. See Figure 6-17 and Figure 6-18.

Figure 6-17 Face total

FACE TOTAL =
PN ECNN 2018-11-20 16:36:52 || MU  2018-11-20 16:36:50 || WmmlLEE B 2018-11-2016:35:10 || ew MESERAm.. 2018-11-20 16:35:09
Gender ‘ Gender ) Gender Gender
Age Age Age 4 Ase
Glasses Glasses Glasses Glasses
o~ Mask Mask | Mask Mask
2 n | fjiss | =1 | -]
Figure 6-18 Operation icon
N 2018-11-20 14:36:52
Gender ==
Age -
Glasses =
Mask =
Step 2 Click or E
The Face Register interface is displayed. See Figure 6-19.
Figure 6-19 Face register
Face Register b4
* FaceDB Select -
* MName
Gender ® Male Female
Birthday
Country or Region -
Address
1D Type -
1D No.
Cancel

Step 3 Select the face database, and fill in person information according to your actual

situation.
Step 4 Click OK to save the configuration.
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6.2.2.3 Human Face Abstract

The human face abstracting is to abstract the corresponding information of the face image
and import to the database, and then create the human face features module. In this way,
device can compare human face, and search human face.

I—vJ

e The greater the face image quantity is, the longer the face abstracting time it takes.

e During the abstracting creation process, some intelligent functions (such as human face
comparison, search human face and so on.) are null. These functions become normal
after the abstracting process is completed.

e When the uploaded image is half-length photo or full-body photo, the system
automatically selects the frame of the uploaded image and only the face area will be
retained.

Step 1 On the LIVE interface, click , select File > Face Database.

Face Database interface is displayed.
Step 2 Double click face database.
Face database interface is displayed. See Figure 6-20.
Figure 6-20 Face database interface(1)

* Back
PSP - |
» ab  oc ql
Al
Name : /o8 Name : = Name : s Name : S
E Birthday . Birthday q Birthday h Birthday
1D Type : Unknown 1D Type : Unknown k 1D Type : Unknown v 1D Type : Unknown
1D No. 1D No. 1D No. 10 No.
e = A -—
H Address Comig | adiress L ] Address Salt ...

Step 3 Select face images and then click Abstract.
System pops up a confirmation box. See Figure 6-21.

I-—-—-l

e Select All to select all face images in current human face database.
e If there are too many human face images in the human face database, click

Q to set search conditions (such as nhame, gender, birthday, country, province,

ID type, ID number or abstracting status) to quickly find the human face images.
Figure 6-21 Prompt

A Inthe progress,

smart business: Face recognition,Face Picture Analyse will be
suspended until the abstracting process is finished

Start Abstract Cancel

Step 4 Click Start Abstract.
Device begins creating module. See Figure 6-22.
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e The abstracting is successful if - is no longer at the bottom left corner of the

face image. The abstracting may fail if the face image is not clear or does not

contain complete information, and E appears at the bottom left corner of the

face image.

e When the uploaded image is half-length photo or full-body photo, the system
automatically selects the frame of the uploaded image and only the face area will

be retained.
Figure 6-22 Abstract result
- ok 2 imin
i,  Ab B Delete Q|
Name : /5 ! Name L ]
g i - A,

6.2.3 Configuring Face Detection

You can configure alarm rule of face detection.

Step 1 Click @ or click on the setting interface, and then select EVENT.

The EVENT interface is displayed.
Step 2 Select remote device in the device tree on the left.
Step 3 Select Al Plan > Face Detection.
The Face Detection interface is displayed. See Figure 6-23 or Figure 6-24.
Figure 6-23 Al by camera

» Record | 171.5.39.22-IV5-1102

» Snap | 171.5.39.22-1VS-1102
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Figure 6-24 Face detection (Al by device)

Step 4 Click Al by camera or Al by device, and then click - to enable Al function.
L1

Al by camera supports face recognition (FR) function. After enabling FR function,
IVSS displays enhanced human face zone on the surveillance window.

Step 5 Set detection region.
[1]

It only supports setting minimum size and maximum size.

1) Click i“'*, and set detection region in surveillance window. See Figure 6-25.

Figure 6-25 Area

%
[i]

e Click # or white dot on detect region frame, and drag to adjust its range.

. || . . . .
e Click mn or 'm= to sethuman face detection minimum size or maximum

size. System triggers an alarm once the detected human size is not larger
than the maximum size or smaller than the minimum size.
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e Select the motion detect zone you drew. Click @ to delete the zone.

2) Click “E to complete the settings.

Step 6 Click Deployment Time to select schedule from the drop-down list.
After setting arm period, system triggers corresponding operations when there is a
motion detection alarm in the specified period.
e Click View Schedule to view detailed schedule settings.
e If the schedule is not added or the added schedule does not meet actual needs,
click Add Schedule. For details, see "8.8.4 Schedule."
Step 7 Click Action to set alarm action. For details, see "8.4.1 Alarm Actions."
Step 8 Click Save.

6.2.4 Configuring Face Recognition

You can configure face recognition alarm rule.

Step 1 Click , or click on setting interface, and then select EVENT.

The EVENT interface is displayed.
Step 2 Select remote device in the device tree on the left.
Step 3 Select Al Plan > Face Recognition.
Face Recognition interface is displayed. See Figure 6-26 or Figure 6-27.
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Figure 6-26 Face recognition

Figure 6-27 Face recognition

Step 4 Click Al by Camera or Al by Device, and then click - to enable intelligent

function.
Step 5 Click Deployment Time to select schedule from the drop-down list.
After setting arm period, system triggers actions when there is a motion detection
alarm in the specified period.
e Click View Schedule to view detailed schedule settings.
e If the schedule is not added or the added schedule does not meet actual needs,
click Add Schedule. Refer to "8.8.4 Schedule" for detailed information.
Step 6 Set stranger mode.
It is to enable stranger mode. Once the face comparison similarity is lower than the
specified value, system triggers an alarm.

1) Click - to enable stranger mode.

The Stranger control mode interface is displayed. See Figure 6-28.
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Figure 6-28 Stranger control mode

Stranger control mode [l

AlAarmRule D1 Show Feature Panel [l

Log | Enable

Local Alarm Out | Output Portl

+ Action:

2) Set parameters. For details, refer to Table 6-4.

Table 6-4 Stranger control mode description
Parameter Description

Al alarm rule Click <"~ to set alarm rule box color,

Show feature panel Check Ol to enable features panel function. System displays stranger

panel once there is an alarm.

3) Click Actions to set alarm actions. Refer to "8.4.1 Alarm Actions" for detailed
information.
Step 7 Set triggered face database.
L]
e Before you use Al by camera function, go to the remote device to set face
database. At IVSS interface, set alarm activation event.
e Repeat the step to trigger several human databases at the same time.
1) Click Associate Face Database, and then select the triggered human face
database.
Face database configuration interface is displayed. See Figure 6-29.
Figure 6-29 Face database configuration

B

123 I
Similar  e— 280 AlAamRule D show Feature Panel ]
Log | Enable X
Local Alarm Out | Output Port1 X
2) Set parameters. For details, refer to Table 6-5.
Table 6-5 Configuration description
Parameter Description
It is to set human face similarity.
Similar System compares the human face with the image on the face database,
system triggers an alarm once the similarity reaches threshold you set here.
Al alarm rule Click 2. to set alarm rule box color.
Show feature panel Click - to enable features panel function. System displays features
panel once there is an alarm.

3) Click Actions to set alarm actions. Refer to "8.4.1 Alarm Actions" for detailed
information.
Step 8 Click Save.
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6.2.5 Real-time View

You can view real-time face detection and human face comparison images.

6.2.5.1 Setting Al Display

You can configure display rule of Al detection results.

Before using this function, ensure that view has been created. Refer to "7.1.1 View
Management" for detailed information.

Step 1 On the LIVE interface, click V8 and select Face tab.

The Face interface is displayed. See Figure 6-30.
LL]
e Click Sync from Al-Dis., obtain global smart detection display rule of IVSS.
Refer to "8.4.2.3.2 Setting Al Display" for detailed information.
e Click Apply to all windows, it is to copy current configuration to other
window(s).
Figure 6-30 Face

Human Vehicle
View 1 i

S 1011161811 Show Tracking Box : Il

<]
<

Gender Gender
Age Age

Glasses Glasses
Mask

<]

Similar’e

Sync from Al-Dis Apply to all win m Cancel

Step 2 Enable Show Tracking Box.
After it is enabled, when the system detects face or human, the window will display
corresponding rule box.

Step 3 Enable Features Panel, and select feature(s) you want to display.
After enabling the features panel function, there is a features panel on the right side
of the video window.
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e Drag " * to adjust features panel transparency. The higher the value, the more

transparent the features panel.
e  System supports maximum 4 features.
e System has checked four features by default. To select other features, cancel
the selected features, and then select the ones you need.
e Click to display the corresponding features panel on the LIVE interface,
including face detection panel, face recognition panel and face DB panel.
Step 4 Click OK to save the configuration.

6.2.5.2 Live

Go to the LIVE interface, enable view, device displays view video. See Figure 6-31.
e The view window displays currently detected face rule box.
e The right side displays features panel.
¢ During face detection, features panel displays detection time, the detected face
image and feature.
<& During face comparison, features panel displays detection time, the detected face
image, face image in the database, comparison result and database name. After
setting stranger mode, when the detected face image mismatches face image in the
database, features panel will have Stranger tag.
Figure 6-31 Live

__ChannelQ

Move the mouse to features panel, and the operation icons are displayed. See Figure 6-32
Figure 6-32 Face database

e Click E to add this image to the face database. Refer to "6.2.2.2.3 Detection Add" for
detailed information.
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e Click or double click the detected image, so the system starts to play back the

recorded videos (about 20s) at the time of snapshot.
6.2.5.3 Face Total

On the Live interface, click ‘l Face detection panel is displayed. See Figure 6-33.

Figure 6-33 Detection image (1)
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CIickT’lto filter the images. See Figure 6-34.

Figure 6-34 Filter

All

(< I <

Face Detection

<]

Face Recognition

<

Stranger

Move the cursor to features panel, and the operation icons are displayed. See Figure 6-35.
Figure 6-35 Detection image (2)

FACE TOTAL E

B . 20161121 09:37:20 || (uniomeE . 20181121 09:37:18  FEMBCEER . 2016-112109:37:18 || [Solie e .

2018-11-21 09:37:16

Gender = Gender Gender Gender '
o e = Age = Age hge
8 Glasses Glasses Glasses Glasses
| Mask - Mask Mask - Mask
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° : Click it to add this image to the face database. Refer to "6.2.2.2.3 Detection Add" for

detailed information.

° : click it, or double-click the detected image, IVSS starts to play back the recorded

video (10 s before and after the time of snapshot). See Figure 6-36.

¢ Click l]] to pause play. Now the icon becomes [] Click I] to play back video

again.

& Click to close view window.
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Figure 6-36 Record

Playing

X
- 3 B 2018709801 1622854,

nvranyvediochannel

: Click it, and the Save interface is displayed. See Figure 6-37. Click Browse to select

the storage path, and then click OK to export records to the selected path.
L]

Connect USB device to IVSS if you are on the local menu to operate and store the file to
USB storage device.

Figure 6-37 Save

Save »
(1) All Start Time End Time Record Length Size
(1) 2018-11-211... 2018-11-21 10:35:44 00:00:20 5.76MB
Total 576MB
Save Path: I Browser...

6.2.6 Face Search

Search face detection information, including face detection image, record and features.
Search according to record and image.
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6.2.6.1 Search by Attribute

Set event type and attribute, to search qualified face information.

Step 1 On the LIVE interface, click , select Al Search > Search by Face > By

Attribute.
By Attribute interface is displayed. See Figure 6-38.
Figure 6-38 Search by attribute

Step 2 Select the remote device, and set event type, face attribute and time.

Step 3 Click Query.
The search results are displayed in the panel. See Figure 6-39. Click the panel. The

operation icons are displayed. See Figure 6-40.
Figure 6-39 Search result
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After search, you can play back record, add image to the face database, and export the file.
See Figure 6-40 and 0.
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IPC1

Figure 6-40 Icon
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Table 6-6 Search by image

Icon | Operation

e Select one by one: Click the panel or move the cursor onto the panel, and then click

to select the panel. means it is selected.

e Batch select: Check All to select all panels on the interface.

Click or double-click the panel, the system starts to play back the recorded videos

(about 20s).

Click to add the image to the face database. Refer to "6.2.2.2.3 Detection Add" for

detailed information.

Click or select the panel and click lat to export images, videos and Excel to

designated storage path.

L_,J

After setting alarm linkage snapshot, during exporting images, the system exports detected

images and panoramic images at the time of snapshot.

6.2.6.2 Search by Image

It is to upload face image and then compare with the human face in the record file. Device
can filter the record file in which the human face similarity has reached the threshold.

Device supports to use the face image on the face database or the local face.
e When you use face database images to search, ensure face database has been
configured. Refer to "6.2.2 Configuring Face Database” for detailed information.
e If you want to use the local images, you need to obtain the face image and saved it in the
corresponding path.
¢ When operating on the local interface, save the image in the USB storage device
and then connect the USB storage device to the IVSS.
¢ When operating on the Web or IVSS interface, save the image on the PC in which
the Web or IVSS client is located.

6.2.6.2.1 Device Search

Upload face image, compare it with face detection result of remote device, and find face
detection information that meets the set similarity.

Step 1 On LIVE interface, click , select Al Search > Search by Face > By Image.
The By Image interface is displayed. See Figure 6-41.
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Figure 6-41 Search by image

Al SEARCH +

Searchby Face | Search by Human Vs

By Attribute By Image
+ Upload Image| v >
-——
Device FaceDB
Q Y

2018-12 -17 23 :59 : 59

A\ Search range 30 days

Step 2 Click Device tab.
Step 3 Upload face image.
L1
Device supports to upload maximum 50 face images. Device supports to select

maximum 10 face images at one time.
e Upload the image from the face image database to search corresponding face.

+ Upload Image |

1)  Move the mouse to and select Face DB.

The Choose Picture From Face DB interface is displayed. See Figure

6-42.
Figure 6-42 Choose picture from face DB
Choose Picture From FaceDB »
Mame I:I Gender All - FaceDB 123 - = Reset Choosed Pictures
Ointotal. Showupto| 20 w 1% I:l JumpTo Cancel
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2) Select face database and then set search criteria.
¢ If there are too many face images on the database, set name, gender
to filter.

& Click # to set the search ID number.

3) Click Query.
Device displays the searched face images.
4)  Select face image.
The selected face image is displayed on the Chosen Pictures on the right
side.
5) Click OK to upload face image.
e Local image: Upload images from local PC or USB storage device.

+ Upload Image | «

1)  Move the mouse to and select Local.

2)  Select face image you want to upload.
(1]
You can select several face images at the same time.
3) Click OK to upload face image.
After uploading the images, device displays the face images on the top left corner.
The latest 10 images are selected. See Figure 6-43.
Figure 6-43 By image

By Attribute By Image
+ Upload Image | 2
Selected only Cancel Clear

Similar— = | 80

e When the uploaded image is half-length photo or full-body photo, the system
automatically selects the frame of the uploaded image and only the face area
will be retained.

e When there are multiple faces in the uploaded images, the system
automatically identifies the faces in the images and uploads multiple face
images according to the number of faces recognized.

e Device supports to select maximum 10 face images.

e Click Cancel to cancel all checked face images.

e Select Selected only, device displays checked human face images only.
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e Click Clear to clear all uploaded face images.

Step 4 Hold on and drag

®" to set human face similarity. It is 80% by default.

Step 5 Select remote device on the device list and then set record file time period.

Step 6 Click Query.
The Result is displayed. See Figure 6-44 and Table 6-7.

Figure 6-44 Query
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Table 6-7 Device search description
No. Description
Displays selected face images. The number at the bottom right of the face image is to
1 display the searched image amount.
Click one image to view its query result.
5 It is to set filter criteria. It can quickly search the required image according to the face
features.
3 Displays searched schedule list.
Click a date, you can view the image list on current date on the right panel.
4 Displays the searched face panel, including face image, feature attribute and
similarity.
Operation

After query, you can play back video file and export. Refer to Table 6-8 for detailed

information.
Table 6-8 Device search operation
Icon Operation
e Select one by one: Click the panel or move the mouse onto the panel. Click
Select panel to select the panel. ¥ means it is selected.
e Batch select: Click All to select all panels on this page.
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Icon Operation

Playing back

) Double-click the panel to play back recorded video (about 20s).
recorded video

Move the mouse to panel and click , or click the panel and click la to export

images, videos and Excel to designated storage path. Refer to "6.4 IVS" for
Export file detailed information.

After setting alarm linkage snapshot, during exporting images, the system exports
detected images and panoramic images at the time of snapshot.

6.2.6.2.2 Searching Face Database

Upload face image, compare it with face image in face database, and find face image that
meets the set similarity.

Step 1 On Live interface, click , select Al Search > Search by Face > By Image.

The By Image interface is displayed.
Step 2 Click the FaceDB tab.
FaceDB interface is displayed. See Figure 6-45.
Figure 6-45 Face database

Al SEARCH +

Search by Face Search by Human vs

By Attribute By Image

+ Upload Image | w )

Device FaceDB

Upload face image. Refer to "6.2.6.2.1 Device Search Step 3" for detailed
information.

%}
@
w

Hold on and drag to set human face similarity. It is 80% by default.

%}
@
D

Select the face database.
Click Query.
The Result is displayed. See Figure 6-46. For details, see Table 6-9.

0 0
@D |D
[o 2R (6]
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Figure 6-46 Result

. )
- - i n ‘l "
Y ., A
e ) :
[ o]
| \
Table 6-9 Description
No. Description
Displays selected face images. The number at the bottom right of the face image is to
1 display the searched image amount.
Click one image to view its query result.
5 Displays searched schedule list.
Click a date, you can view the image list on current date on the right panel.
3 Displays the searched face panel, including face image, information and similarity.
Operation

After query, you can play back video file and export. Refer to Table 6-10 for detailed

information.
Table 6-10 Face database operation
Name Operation
e Select one by one: Click the panel or move the mouse onto the panel. Click
Select a o
panel. to select the panel. means it is selected.
e Batch select: Check All to select all panels on this page.
Export File Click the panel and click e to export images to designated storage path. Refer
to "6.4 IVS" for detailed information.

6.3 Video Structuring

With video structuring, IVSS can detect, recognize, and extract features from human body,
face, motor vehicle, and non-motor vehicle. For example, features such as gender, age, and
top color can be extracted from human, and you can then search a certain human face or
configure alarm with these features.
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6.3.1 Enabling Al Plan

You need to enable Al plan when Al by camera is used. Refer to "6.1 Enabling Al Plan" to
enable Al detect function.

6.3.2 Configuring Video Structuring

After enabling and then configuring video structuring, IVSS can only link the current remote
device for taking snapshots when alarm is triggered.

I—vJ

This section takes Al by device for example. Al by camera only supports enabling detection
function and setting deployment time.

[ 1
Step 1 Click or , and then select EVENT.

The EVENT interface is displayed.

Step 2 Select a device from the device tree at the left side.

Step 3 Select Al Plan > Video Structuring > Al By Device.
The Al By Device interface is displayed. See Figure 6-47.

Figure 6-47 Al by device
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Step 4 Click . next to Feature Vector Extraction to enable feature extraction, then IVSS

can extract features of face and human, such as gender, age, and top color.
L]

Feature vector extraction is available only after Human detection is enabled.

Step 5 Select the detection target.
e People: Click - next to Enabled to enable people detection. Face detection
can also be enabled at the same time.

e Vehicle: Click corresponding - to enable vehicle detection.
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e Non-Motor Vehicle: Click corresponding - to enable non-motor vehicle

detection.

Step 6 Click bk (the icon changes to i“":t), then you can configure detection area (orange)

in the video image. See Figure 6-48.
e Click any white dot on the frame, and the dot changes to #. Drag # to adjust the

detection area.

Click K to draw an excluded area which will not be detected. IVSS does not
detect target within the excluded area.

< Up to 4 excluded areas can be drawn.

<& To delete an excluded area, select the area, and then click @ .

e Click H or Im:I to set the minimum size or maximum size of detection target.

Alarm will be triggered when the size of detection target is within the minimum and

maximum sizes.

Figure 6-48 Detection area

Step 7 Click Deployment Time dropdown list to select schedule.
IVSS links alarm event when an alarm is triggered within the schedule configured.

e Click Add Schedule to add new schedule if no schedule is added or the existing
schedule does not meet requirements. For details, see "8.8.4 Schedule."”
e Click View Schedule to view details of schedule.
Step 8 Click Save.

6.3.3 Live

You can view the detected features and properties of face, people, motor vehicle and
non-motor vehicle on the LIVE interface.
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6.3.3.1 Setting Al Display

You can set the features and properties that you want to display in the real-time video image
of the LIVE interface.

L1

Before setting the features and properties, you need to create a view by adding cameras to
the view so you can check video and pictures captured by the cameras. For details of
creating a view, see "7.1.1 View Management."

Step 1 Select a view from Live > View > View Group.
Step 2 Click TE at the lower side of the LIVE interface, and then select Human, Vehicle or

Non-Motor Vehicle. See Figure 6-49.

LL]

The figure takes Human for example. The interface is for reference only, and the
actual interface shall prevail.

Figure 6-49 Human
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Step 3 Click - next to Show Tracking Box, then a tracking box is displayed in the video

|
Top E.'ol:-r| | Coat | |I::ott:3mf_'olcr| | Bottom |

when target that meets the filtering conditions is detected.

Step 4 Configure feature panel.

1) Click - next to Features Panel to enable feature panel.

A features panel is displayed on the right side of the video when target that
meets filtering conditions is detected.

2) Select the target you want to detect. You can select from Face, Human, Vehicle,

and Non-Vehicle Motor.
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3) (Optional) Drag " to adjust the transparency of panel. The higher the value, the

more transparent the panel.
4) (Optional) Select the features to be displayed in the panel.
e Up to 4 features can be displayed.
e 4 features are selected by default. To select another feature, click the
selected feature to cancel it, and then click the feature to be displayed.
Step 5 Click OK.

6.3.3.2 Real-time View

You can view the detected features and properties of face, people, motor vehicle and
non-motor vehicle in the real-time video image.

On the LIVE interface, select a view from View Group, and the video image of the view will be
displayed. See Figure 6-50.
e Rule box is displayed in real-time in the video image. Different detection targets
correspond to different colors of rule box, and the actual interface shall prevail.
e Features panels are displayed on the right side of the video image.
Figure 6-50 Live

Rule box Feature panel

Move the cursor to the features panel, and the icons are displayed. See Figure 6-51 or Figure
6-52.
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Figure 6-51 Icons (vehicle detection)
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Figure 6-52 Icons (other detection)
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e cClick BY 10 add plate information to plate database.

e Click @ or double-click the detected image to play back the video record (10 s before

and after the time of snapshot).

6.3.3.3 Detection statistics

You can view the features and properties of detected human body, face, motor vehicle and
non-motor vehicle.

6.3.3.3.1 Human

You can view the features and properties of detected human body and face.

On the Live interface, click ", the PEOPLE TOTAL interface is displayed.

CIickT’-, and then select Snap With Face and Snap Without Face. The information of

detected human and face is displayed. See Figure 6-53.
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Figure 6-53 Human detection
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Move the cursor to a panel, and the following icons are displayed:
) : Click it to add the face image to face database. For details, see "6.2.2.2.3 Detection

Add."
[

This function is available when face image is captured.
° : Click it, or double-click detected picture to play back the video record (10 s before and
after the time of snapshot).

° : Click it to export the video record to specified save path (PC or USB storage device).
L1

If store the video record to USB storage device, make sure the device is connected.

6.3.3.3.2 Motor Vehicle

You can view the features and properties of detected motor vehicles.

On the Live interface, click Q the VEHICLE TOTAL interface is displayed.

Click T&, and then select Vehicle Recognition, the information of detected vehicles is
displayed. See Figure 6-54.

Figure 6-54 Motor vehicle detection
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Move the cursor to a panel, and the following icons are displayed:
) : Click it to add the license plate image to plate database. For details, see "6.6.3.2.3
Add by Searching."

° : Click it, or double-click detected picture to play back the video record (10 s before and
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after the time of taking the snapshot).

° : Click it to export the video record to specified save path (PC or USB storage device).

[

If store the video record to USB storage device, make sure the device is connected.

6.3.3.3.3 Non-motor Vehicle

You can view the features and properties of detected non-motor vehicles.
On the Live interface, click &3’ the NONMOTOR TOTAL interface is displayed.

Click Ti, and then select Snap With Face and Snap Without Face. The detected
non-motor vehicle features and properties are displayed. See Figure 6-55.

Figure 6-55 Non-motor vehicle detection
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Move the cursor to the panel, and the following icons are displayed:
° : Click it, or double-click the detected image to play back the video record (10 s before

and after the time of taking the snapshot).

° : Click it to export the video record to specified save path.
[

Make sure USB storage device is inserted during local operation.

6.3.4 Al Search

Select device and set properties to search detection results. For example, you can set human
properties such as gender, age, top, pants, and search human with these properties.

6.3.4.1 Search by Human

Select device, and set human properties and features, so you can search human with the
defined properties and features.

Step 1 On the LIVE interface, click , and then select Al SEARCH > Search by Human.
The Search by Human interface is displayed. See Figure 6-56.
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Figure 6-56 Search by human
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Step 2 Select device, and set human properties and time period.

ick il or A
Click or to set the color. means more than one color.

Step 3 Click Query.
The search result is displayed. See Figure 6-57.

e |If face is captured, the human and face snapshots are displayed.

e If no face is captured, the human snapshot and human properties are displayed.

Al Operations 95



Figure 6-57 Search result
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Other Operations

Click on one displayed panel, and the icons are displayed. See Figure 6-58 or Figure 6-59.
For details, see Table 6-11.

Figure 6-58 Icons (1)

channel0 05:38:03

Figure 6-59 Icons (2)
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Coat UnKnown
Top Color
Bottom UnKnown
Bottom Cc

Table 6-11 Operation

| Icon | Operation
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Icon Operation

e Select one by one: Click to select the panel. means the panel is selected.

e Selectin batches: Select All to select all the panels on the interface.

Click or double-click the panel to play back the video record (10 s before and after

the time of taking the snapshot).

Click to add picture to database. See "6.2.2.2.3 Detection Add."

Click , or select the panel and then click e to export picture, video, and Excel file to

specified save path.

6.3.4.2 Search by Vehicle

Set event type and vehicle properties to search vehicle detection results. For example, you
can set vehicle properties such as type, logo, plate, and search vehicles with these
properties.

Step 1 On the LIVE interface, click , and then select Al SEARCH > Search by Vehicle.
The Search by Vehicle interface is displayed.

Step 2 Select device, and then click Property tab.
The Property interface is displayed. See Figure 6-60.
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Figure 6-60 Property
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» [ @ RTSP Media
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All -
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1
Type| Al - Calor‘ i

L/
Logo| Al - PlatE‘ i

Plate| Enter Plate Number

¥
2019 - 04 - 16 00 : 00 : 00

2019 - 04 - 16 23 : 59 : 59

/B, Search range 30 days

Step 3 Select Vehicle Detection as Event Type.
Step 4 Set vehicle properties and time period.

ick il or ~ A
Click or to set the color. means more than one color.

Step 5 Click Query.
The search result is displayed. See Figure 6-61.

If license plate is detected, both the scenario and the license plate will be displayed.
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Figure 6-61 Search result
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Other Operations

Click on one displayed panel, and the icons are displayed. See Figure 6-62 and Table 6-12.
Figure 6-62 Icons

cameral 00:00:10
1 ; Plate
' Color K
i Type Unknown
Logo Linknow

Table 6-12 Operation

Icon Operation

e Select one by one: Click to select the panel. means the panel is selected.

e  Selectin batches: Select All to select all the panels on the interface.

@ Click @ or double-click the panel to play back the video record (10 s before and after

the time of taking the snapshot).

=+ Click to add picture to database. See "6.2.2.2.3 Detection Add."
, o , . ,
Click , or select the panel and then click “~ to export picture, video, and Excel file to

specified save path.
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6.3.4.3 Search by Non-motor Vehicle

Set event type and non-motor vehicle properties to search non-motor vehicle detection
results. For example, you can set non-motor vehicle properties such as type, color, helmet,
and search non-motor vehicles with these properties.

Step 1 On the LIVE interface, click , and then select Al SEARCH > Search by NonMotor.
The Search by NonMotor interface is displayed. See Figure 6-63.

Figure 6-63 Search by non-motor vehicle

Al SEARCH

Search by Face Search by Human Search by Vehicle  Search by NonMotor VS

Q, SearchDevice Name/IP W
3 B} Device

[ Access
b [ | @ RTSP Media

MNonMotor Property

Type | All -
b/

Color‘v

Hum...| Al -

Hel...| all -

2019 - 04 - 16 00 : 00 : 00

2019 - 04 - 16 23 : 59 : 59

A Search range 30 days

Step 2 Select the device you want to search.
Step 3 Set non-motor vehicle properties and time period.

ick Wl or ~ A
Click or to set the color. means more than one color.

Step 4 Click Query.
The search result is displayed. See Figure 6-64.
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Figure 6-64 Search result

Searchby Face  Searchby Human  Search by Vehicle  Search by NonMotor

Nt E |
Other Operations
Click on one displayed panel, and the icons are displayed. See Figure 6-65 and Table 6-13.
Figure 6-65 Icons
IPC 17:38:24
Type Two-whe...
Color .
Helmet UnKnown
Occupancy 1
Table 6-13 Operation
Icon Operation
e Select one by one: Click to select the panel. means the panel is selected.
e Selectin batches: Select All to select all the panels on the interface.
Click or double-click the panel to play back the video record (10 s before and after

the time of taking the snapshot).

Click to add picture to database. See "6.2.2.2.3 Detection Add."

Click , or select the panel and then click e to export picture, video, and Excel file to

specified save path.
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6.4 IVS

With IVS function, IVSS processes and analyzes images, extracts key information from video
records, compares the key information with the predefined detection rule, and triggers alarm
once the detected behavior matches the detection rule.

IVS type includes cross line detection and cross region detection.

LLI
IVS and face detection function of the same camera cannot be used at the same time.

IVS scene requirement is as follows:

e Total area of the target does not exceed 10% of the image.

e Target size in the image shall not be less than 10 pixels x 10 pixels, and leftover target
size shall not be less than 15 pixels x 15 pixels (CIF image). Target height and width
shall not exceed 1/3 height and width of the image. It is suggested that target height
should be 10% of image height.

e Brightness difference of target and background shall not be less than 10 gray levels.

e Ensure that the target appears in the field of view for over 2s, movement distance
exceeds target width and shall not be less than 15 pixels (CIF image).

e When conditions allow, try to reduce complexity of surveillance analysis scene. It is not
recommended to use IVS in the scene with gathered targets and frequent changes of
light.

e Try to avoid glass, reflection of light on the ground and water; try to avoid tree branches,
shadows and areas with mosquito; try to avoid backlight and direct light.

6.4.1 Setting

The flow of setting IVS is shown in Figure 6-66.
L]

You need to enable Al plan when Al by camera is used. Refer to "6.1 Enabling Al Plan" to
enable Al detect function.

Start Enable Al plan

Figure 6-66 IVS flow

Set VS Finish

playback

’ : - ]

& D
| | Image I !
1 b !
1 b !
| (View i i
' |_peopletotal| | | | Exportfile |
1 b !
1 1 H
i | vehicle total | | | :
I [ H
[ H }

6.4.2 IVS

Set alarm rule of IVS. Alarm is triggered when IVSS detects target that goes against the IVS
rule.
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N

e |VSS supports Al by camera and Al by device. When both are enabled, Al by device is
prior.
e This section takes setting Al by device for example.

Step 1 Click , or click on setting interface, and then select EVENT.

The EVENT interface is displayed.
Step 2 Select remote device in the device tree on the left.
Step 3 Select Al Plan > IVS Rule > Al by device.
The Al by device interface is displayed. See Figure 6-67.
Figure 6-67 Al by device

¥ IPCOffline No. RuleName Rule Type Operate.
dad

Al Plan ; CrossRegionDetectio | =

Step 4 Set cross line detection and cross region detection rule.
1) Click Add Rule, and select Cross Line Detection or Cross Region Detection.
The rule information is displayed. See Figure 6-68 or Figure 6-69.
Figure 6-68 Configuring cross line detection rules

No. RuleName Rule Type Operate

1 Rule1 CrossLineDetection =}

Figure 6-69 Configuring cross region detection rules

No. RuleName Rule Type Operate

1 Rulel CrossRegionDetection =]

2) Click - to enable detection rule.

Click I to delete detection rule.

3) Click i to edit cross line. See Figure 6-70. Click K to edit cross region.

See Figure 6-71.
e Hold on ¥ and drag it to adjust position or length of the line and region.
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e Click = or + on cross line direction to set the direction. An alarm will be
triggered only when the target crosses the line in the designated direction.

e Click white dot on the line or region frame to add a turning point. Hold on =
at the turning point and drag it to adjust position or length of the line and
region.

—o_

e Selectaline andthen click @ to delete.

Figure 6-70 Configuring cross line

2018-11-2111:34:38 o @ Click the mouse to draw the area.

Al Recognition L]

9 i Y

© Click the mouse to draw the area.

Al Recognition [l
Action Appear Cross

Direction Both -

4) Set cross region action and direction.

Go to this step only when you set cross region.

5) Click E or ‘mm to set minimum size or maximum size of detection target.
System triggers an alarm once the detected target size is not larger than the
maximum size or smaller than the minimum size.

Step 5 Al recognition
After setting Al recognition, when the system detects a person or vehicle, a rule box
will appear beside the person and vehicle in the surveillance image.

1) Click - to enable Al recognition function.
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The recognition type option displayed. See Figure 6-72.
Figure 6-72 Type

Al Recognition ]

2 i 5

2) Select a recognition type.

o Misto recognize person, and = is to recognize vehicle.

e After enabling Al recognition function, at least one recognition type shall be
selected.
Step 6 Click Deployment Time to select schedule from the drop-down list.
After setting deployment period, system triggers corresponding operations when
there is a motion detection alarm in the specified period.
e Click View Schedule to view detailed schedule settings.
e If the schedule is not added or the added schedule does not meet actual needs,
click Add Schedule.
Step 7 Click Actions to set alarm action. Refer to "8.4.1 Alarm Actions" for detailed
information.

L]
Repeat Step 4-Step 7 to add multiple detection rules. Support to add max. 10

detection rules at the same time.
Step 8 Click Save.

6.4.3 Real-time View

You can view real-time IVS results on the LIVE interface. Results such as detected face
features and cross line detection are displayed on the right side of the real-time video image.

6.4.3.1 Live

Go to the LIVE interface, enable view, device displays view video. See Figure 6-73.

e When a target triggers cross line or cross region rule, the line or region frame in the view
flickers in red.

e After setting Al recognition, when the system detects a person or vehicle, a rule frame
will appear beside the person and vehicle in the view.

e There is a feature panel on the right side of the video window.
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Figure 6-73 Live

Rule Box Featu]re Panel

Face Detection
468 143

Face Detection

Move the mouse to features panel, and the operation icons are displayed. See Figure 6-74.

Click @ or double-click the detected image, so the system starts to play back the recorded

videos (10 s before and after the time of taking the snapshot).
Figure 6-74 Cross line

6.4.3.2 Detection Statistics

You can view the IVS results of detected human body, face, vehicle, and non-motor vehicle.
For example, you can view whether people cross a region or cross a line.

On the LIVE interface, click TT. The PEOPLE TOTAL interface is displayed. See Figure

6-75.
Figure 6-75 People total
A

PEOPLE TOTAL

IPC 2018-11-20 10:00:26 IPC 2018-11-20 10:00:24 IPC 2018-11-20 09:59:12 IPC 2018-11-20 09:58:06

4 Record Typ Y Record Typ pr Record Typ Record Typ
e Human e Human (3 Human e Human
1

Click Q The VEHICLE TOTAL interface is displayed. See Figure 6-76.
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Figure 6-76 Vehicle total

VEHICLE TOTAL
4E05619YAJF39...2018-11-30 14:43:04 4E05619YAJF39...2018-11-30 14:43:04 4E05619YAJF39...2018-11-30 14:43:04 4E05619YAIF39...2018-11-30 14:43:04
F Record Typ Record Typ 5 - Record Typ
) MotorVe e MotorVe 0 gak e MotorVe
hicle hicle hicle
s A
AT A
CrossRegionDetection CrossRegonDetection CrossRegionDetection
2156 | i a1 | =y 10 | )

Move the cursor to detection panel, and the operation icons are displayed. See Figure 6-77.
Figure 6-77 Operation icon

IPC1 2018-11-30 14:44:23
Record Typ
e Human
° : Click it, or double-click the detected image, IVSS starts to play back the recorded

videos (10 s before and after the time of taking the snapshot). See Figure 6-78.

¢ Click []] to pause play. Now the icon turns into I] Click I] again to continue to
play.

¢ Click to close view window.

Figure 6-78 Record

Playing X
[ s
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. Click it, and the Save interface is displayed. See Figure 6-79. Click Browser to

select storage path, and then click OK to export records to the selected storage path.

[

Connect USB storage device to IVSS if you want to store the records to such storage

device.
Figure 6-79 Save
Save %
(1) Al Start Time End Time Record Length Size
1 2018-11-211.. 2018-11-21 10:35:44 00:00:20 5.76MB

Total 5.76MB

Save Path: Erowser...

6.4.4 Search Interface

Select remote device and set event type to search IVS information. For example, you can set
event type as cross line detection, and detected targets that cross line will all be displayed.

Search image

Step 1 On the LIVE interface, click and then select Al Search > IVS.
The IVS interface is displayed. See Figure 6-80.
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Figure 6-80 IVS

Step 2 Select the remote device, and set event type, effective target and time.
Step 3 Click Query.
The search results are displayed in the panel. See Figure 6-81.
Figure 6-81 Search result

All0) Total 12 record(s)
20184130+
3 e naa Bsoa 3 van 3 vam 3 1o
I ObjectTy Human ! OfiectTy Human ! OhiectTyy Human ! ChiectTy Human g OtiectTys Human g OfjectTyr Human
e T
| CrosstineDetection | CrosstineDetection | CrosstineDetection | CrosstineDetection | GrosstineDetection __________J CrosstineDetection |
3 15034 3 150347 3 150435 3 15013 3 150825 3 15092
1 OljectTy Human ! Ofjectty; Human ! GliectTyy Human ! Ohiectyy Human E Oljectyy Human ! Oliectty; Human

Click the panel, and the operation icons are displayed. See Figure 6-82.
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Figure 6-82 Operation icon

IPC1 10:33:43
Gender Male
Age

Mask

Glasses

Table 6-14 Search by image

Icon Operation

Move the mouse onto the panel. Click to select the panel. means it is selected.

Click to add picture to database. See "6.2.2.2.3 Detection Add."

Click the panel, and click or double click the panel. The system starts to play back

the recorded videos (10 s before and after the time of taking the snapshot).

Click the panel and click , or click the panel and click la to export images, videos

and Excel to designated storage path.

I—v—-l

After setting alarm linkage snapshot, during exporting images, the system exports
detected images and panoramic images at the time of snapshot.

6.5 Vehicle Recognition

Alarm is triggered when vehicle property that meets detection rule is detected.

I—vJ

IVSS supports only vehicle recognition through Al by camera. Make sure the vehicle
recognition parameters of camera are configured. For details, see the user's manual of the
camera.

6.5.1 Enabling Al Plan

Before using Al by camera, Al plan needs to be enabled first. For details, see "6.1 Enabling Al
Plan."

6.5.2 Setting Vehicle Recognition

Set the deployment time of vehicle recognition and alarm linkage event, and IVSS links alarm
event when alarm is triggered within the defined time.

Step 1 Click or , and then select EVENT.
The EVENT interface is displayed.
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Step 2 Select device from the device tree at the left side.
Step 3 Select Al Plan > Vehicle Recognition.
The Vehicle Recognition interface is displayed. See Figure 6-83.
Figure 6-83 Vehicle recognition

¥ Video Detect
a v =
v IVSS "X VideoMotion v
¥ [B Device B Tampering v
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[l Access
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» @ RTSP Media APt

31 Face Detection

P Face Recognition

® Video Structuring
B vs
i Vehicle Recognition

= Plate Comparison

Refresh

Step 4 Click the Deployment Time dropdown list to select schedule.
IVSS links alarm event when alarm is triggered within the defined schedule.
e Click View Schedule to view detailed schedule settings.
e If the schedule is not added or the added schedule does not meet actual needs,
click Add Schedule. For details, see "8.8.4 Schedule."
Step 5 Click Actions to set alarm action. For details, see "8.4.1 Alarm Actions."
Step 6 Click Save.

6.5.3 Real-time View

On the LIVE interface, you can set the vehicle properties that you want to display on the
real-time video image, and view such properties.

6.5.3.1 Setting Al Display

You can set the vehicle properties that you want to display on the real-time video image.

I—vJ

Before setting the features and properties, you need to create a view by adding cameras to

the view so you can check video and pictures captured by the cameras. To create view, see
"7.1.1 View Management."

Step 1 Select a view from LIVE > View > View Group.

Step 2 Click TE, and then select Vehicle tab.
The Vehicle interface is displayed. See Figure 6-84.
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Figure 6-84 Motor vehicle

) - Face Human Vehicle Mon-MotorVehicle
View 3
B camers
g cameral ; : Show Tracking Box : [
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Place White List Black List.
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Driver Call Safe Belt Safe Belt
Driver Call Driver Call
Features Panel : [
Transparence : - 7
Sync from Al-Dis. Apply to all win “ Cancel
L0 | ff 11903 | py 103798 | Mysars | & |

Step 3 Click - next to Show Tracking Box to enable tracking box function.

A tracking box is displayed in the video image when target meeting detection rule is
detected.
Step 4 Set features panel.

1) Click - next to Features Panel to enable features panel function.

Features panel will be displayed at the right side of video image when target with
selected features is detected.

2) Select a vehicle information panel. means the panel is selected.

3) (Optional) Drag " 1o adjust the transparency of panel. The higher the value, the

more transparent the panel.
4) (Optional) Select the features to be displayed in the panel.
e Up to 4 features can be displayed.
e 4 features are selected by default. To select another feature, click the

selected feature to cancel it, and then click the feature to be displayed.
Step 5 Click OK.

6.5.3.2 Live

On the LIVE interface, select a view, and the video image of the view is displayed. See Figure
6-85.
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e Tracking box is displayed in the video image.
e Features panel is displayed at the right side of the video image.
Figure 6-85 Live
Rule box Features panel

15:02:05

Move the cursor to the features panel, and the operation icons are displayed. See Figure

6-86.
Figure 6-86 Icons
cameral 00:00:10
] al Plate
/ 2 | Color E|
l Type LinkKnown
’ Logo Linknow
1

e Click B to add license plate information to the plate database. For details, see
"6.6.3.2.3 Add by Searching."

e Click or double-click the vehicle image to play back the video image (10 s before

and after the time of taking the snapshot).

6.5.3.3 Detection Statistics

You can view the features and properties of detected motor vehicles.

On the LIVE interface, select a view and then click ﬁ The VEHICLE TOTAL interface is
displayed.

Click Ti, and then select Vehicle Comparison, the information of detected vehicles is

displayed. See Figure 6-87.
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Figure 6-87 Vehicle detection

VEHICLE TOTAL =
cameral 2019-04-16 11:31:19 cameral 2019-04-16 11:31:18 cameral 2019-04-16 11:31:18 cameral 2019-04-16 11:31:12
Type Vehicle Type Vehicle Type Vehicle I"i-l'i = Type Vehicle
CrossReglonDetection CrossReglonDetection CrossReglonDetection CrossReglonDetection
L0 | i 12661 | 108462 | Aysesr | A
Move the cursor to the features panel, and the following operation icons are displayed:
) : Click it to add license plate information to plate database. For details, see "6.6.3.2.3
Add by Searching."
. : Click it or double-click the picture to play back the video image (10 s before and after

the time of taking the snapshot).

° : Click it to export the video to specified save path.

I-—-——-l

Make sure USB storage device is connected during local operation.

6.5.4 Searching Detection Information

Set event type and vehicle properties, such as plate, vehicle color, plate color, logo, and then
search vehicles with these properties. For details, see "6.3.4.2 Search by Vehicle."

6.6 Vehicle Comparison

IVSS compares the detected vehicle properties with plate pictures of linked plate database,
and then triggers alarm when the matched similarity reaches or exceeds the defined
similarity.

6.6.1 Procedure

The procedures of setting vehicle comparison are shown in Figure 6-88 and Figure 6-89.
Figure 6-88 Vehicle comparison procedure (Al by camera)

Set Plate
Comparison

Create Plate
Database

Enable Al
Plan

Add Vehicle Plate Verification

Real-time View

!
|
|
|
|
Playback |
)

N— — — — — — = —

Al Operations 114



Figure 6-89 Vehicle comparison procedure (Al by IVSS)
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6.6.2 Enabling Al Plan

Before using Al by camera, Al plan needs to be enabled first. For details, see "6.1 Enabling Al
Plan."

6.6.3 Setting Vehicle Database

Set vehicle database, and then IVSS can analyze and compare vehicle plates with
information in the database.

6.6.3.1 Creating Vehicle Database

You can create vehicle database, and then classify and manage the database. Database of
trusted vehicle list and blocked vehicle list can be created. Alarm will be triggered when
vehicle in the blocked list is detected.

Step 1 On the LIVE interface, click , and then select FILE > Vehicle Management >

Vehicle Database.
The Vehicle Database interface is displayed. See Figure 6-90.
Figure 6-90 Vehicle database

{‘:’} Face Management ~ + Create Vehicle DB o Delete Usage 0%
Face Database
6} Vehicle Management >

Vehicle Database

Step 2 Click Create Vehicle DB.
The Create Vehicle DB interface is displayed. See Figure 6-91.
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Figure 6-91 Create vehicle database

Create Vehicle DB

1 Vehicle DB Name

Vehicle DB Mame

Type Black List

€ Register Vehicle

Cancel

Step 3 Set Vehicle DB Name, and select Type of vehicle database.

Step 4 Click Register Vehicle or Save and close.

e Click Register Vehicle, and add the vehicle information to the database. See
Figure 6-92. For details, see "6.6.3.2 Registering Vehicle Information.”
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Figure 6-92 Register vehicle plate

Create Vehicle DB Usage 0% X
& Vehicle DB Name 2 Register Vehicle
Add mode ® Manual Add Batch Import
Country or * Plate
Region -
Name Logo -
Color fy . Plate Color &y .
Driver 1D
Type
Cell Phone
Email
£
Address
Back Cancel

e Click Save and close to create a database without editing its information.
The newly-created database can be viewed on the Vehicle Database interface. See
Figure 6-93.
Figure 6-93 Vehicle database

{é} Face Management w + Create Viehicle DB @ Delete Usage 0%

Face Database All

{6+ Vehicle Management > .
Database 1 [# Database 2 [&

Vehicle Database 0 Black List Ty 1 Black List

Other Operations

Operations after a database is created include modifying the database name, registering
plate information, arming the database, and deleting the database. See Table 6-15.

Table 6-15 Other operations
Operation Description
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Operation

Description

View database
information and

e [Database 2 - patapase name.

° a 1: Number of vehicle plate in the database.

e  Black List ) White List . The database is in the blocked/trusted list.

status
e @ Disarm=d . The database is not linked to channel for vehicle plate
comparison. If armed, the linked device channel will be displayed.
Modify database »
name Click [ next the database name to modify its name.

Manage database

Double-click the database, and you can manage the vehicle plate
information in the database. For details, see "6.6.3.3 Managing Vehicle
Information."

Arm database

Link the database to camera channel for vehicle plate comparison. For
details, see "6.6.4 Setting Plate Comparison.”

Delete database

e Delete one by one: Move the cursor to the database, and click 0 at the

upper right corner to delete it.

e Delete in batch: Move the cursor to a database, and check to

select the database. Select multiple databases in this way, and then

) m Delete
click to delete the selected databases.
. m Delete
o Delete all: Select All, and then click to delete all
databases.

6.6.3.2 Registering Vehicle Information

Add vehicle information in the created databases. Supports manual add and batch import.

6.6.3.2.1 Manual Add

Add information of one vehicle at a time.

Step 1 On the LIVE interface, click , and then select FILE > Vehicle Management >

Vehicle Database.
The Vehicle Database interface is displayed.
Step 2 Double-click the database.
The database interface is displayed. See Figure 6-94.
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Figure 6-94 Database

- Back ﬁ Database 1|0
+ Manu, d ™ Batch Import + Copyto o Delete Q .
All
Step 3 Click Manual Add.
The Vehicle Register interface is displayed. See Figure 6-95.
Figure 6-95 Vehicle register
Vehicle Register =

Country or
Region

MName

Driver 1D

Cell Phone

Email

Address

* Plate

Logo -
Color &N Plate Color &y
Type
b=
Cancel

Step 4 Set the parameters. See Table 6-16.

Table 6-16 Vehicle register parameters

Parameter Description

Cou.ntry of The country or region that the vehicle belongs to.
Region

Name Driver's name.

Driver ID Driver's license number.

Cell Phone Driver's cell phone.

Email Driver's Email.

Address Driver's address.

Plate Vehicle plate number.

Logo Vehicle logo.

Color Click @ - to select the color of vehicle.
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Parameter Description
Plate Color | click ™ . to select the color of vehicle plate.
Type Click #* , and you can select the vehicle type. See Figure 6-96. Blue means
already selected.
Figure 6-96 Vehicle type
Vehicle Register *
CE R (Y
® o@® @ @ @
UnKnown Large Bus Heawy Truck Medium Truck
- — B C L)
Qo e o9 o e o e
Sedan Minivan Light Truck Medium Bus
[ 1 FI 1T 7% L1 rl
oe oe e O
SUv MPW Pickup Minicar

Step 5 Click Save and continue to add or OK.
e Click Save and continue to add: Save the current vehicle information, and
then continue to add next vehicle.
e Click OK: Save the current vehicle information.
The added vehicle information is displayed. See Figure 6-97.
Figure 6-97 Vehicle information

{6} Face Management ~ * Back fy Database 111 [IEEE
Face Database + Manual Add & Batch Import + Copy to M Delete Q.
{} Vehicle Management > All

Vehicle Database

Country or Region :
_____ Name :
aaddn )
e a Driver ID :

Logo : UnKnown

Color : Plate Color :

- #  Type: Large Bus

123456789 vpe: Large

u #  Address:
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6.6.3.2.2 Batch Import

Import vehicle information to the database in batches.

Step 1 On the LIVE interface, click , and then select FILE > Vehicle Management >

Vehicle Database.
The Vehicle Database interface is displayed.
Step 2 Double-click the database.
The database interface is displayed.
Step 3 Click Batch Import.
The Batch Import interface is displayed. See Figure 6-98.
Figure 6-98 Batch import

Batch Import *
Choose File Browse
¥ Download Template Replace Data
Template Value Query

Logo : Audi * | = Malue:1
Type : Sedan w* | = Valus: 4
Color : & -, Walus : FFOODO

Plate Color : & -, Walue : DODOFF

Cancel

Step 4 Acquire and fill in the template file.
1) Click Download Template to download the template to PC or USB storage
device.
The save path may vary when operating on client or local interface, and the
actual interface shall prevail.

e Onclient: Click = on the upper right side, and then select ®  Download

to view the save path of template file.
e Onlocal interface: Select the save path of template file.
(1]
Make sure USB storage device is connected during local operation.
e On web interface: Template file is saved in the default download path of
browser.
2) Fillin the template fill according to your actual needs. See Figure 6-99.
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Fill in the vehicle information according to the instructions. For logo, type, color,
and plate color, fill in the corresponding code or value. Search the code or value
on the Batch Import interface (See Figure 6-98).

Figure 6-99 Template file

Serial No*Plate NoCountry Logo Tvpe Color Plate Col Owner License Tel Email Address
1 BD5ISMR GB 1 2 FFFFFF  FFFFFF Peter L-PETER12 T-0712345 123@gmail Birmingham
&&Explain:

1.With * is required

2. Country: Conform to IS03166 specification. 2 bytes uppercase format. Example Great Britain GB Chinese CN.

3.Logo: Please input code number of vehicle logo. Example Bentlev 54. The code number can be gquerving on the page of downloaded this.
4. Type: Please input code number of vehicle tvype. Example SaloconCar 4. The code number can be querving on the page of downloaded this.
5.Vehicle Color: Please input RGB coler. E)‘Smple Red FF0000. The code number can be querving on the page of downloaded this.

6.Plate Color: Please input RGB color. Example Red FF0000. The code number can be querving on the page of downloaded this.

7.License: Please add prefix 'L-".

8.Tel: Please add prefix 'T-".

3) Save template file.
Step 5 On the Batch Import interface, click Browse to import template file.
If the plate number in the template is the same as the number in the database, select
Replace Data to overlap the information in the database.
Step 6 Click OK.
The batch import result is displayed. See Figure 6-100.
Figure 6-100 Batch import result

Batch Import *

1 successfully imported. O failed imported.

Step 7 Click Add More or OK.
e Click Add More: Import vehicle information, and continue to add vehicle
information.
e Click OK: Import vehicle information.
The added vehicle information can be viewed on the Vehicle Database interface.
See Figure 6-101.
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Figure 6-101 Vehicle information

{2 Dstabse 112
¥ Batch Import + Copyto m Delete Q.
Country or Region :
Name :
Driver ID :
Logo : UnKnown
Color : Plate Color :

#  Type: Large Bus

Address :

Country or Region : United Kingdom
Name : Peter

Driver ID : PETER123456D12EC
Logo : Audi

Color : Plate Color :

#  Type: Heavy Truck

6} Face Management v  Back
Face Database + Manua
46} Vehicle Management > Al
Vehicle Database
aaasEla
e @
123456789
B
@ @
BD515MR

-

2in total. Show

6.6.3.2.3 Add by Searching

vupto | 40

Address : Birmingham

-

| Jump To

Add plate information from vehicle recognition or detection to the database.
Step 1 On the LIVE interface, select the vehicle information to be added.

e Click Q move the cursor to the information panel, then click

On the Vehicle Recognition or Video Structuring interface, move the cursor

to the vehicle recognition or vehicle detection panel, and then click =i}
The Vehicle Register interface is displayed. See Figure 6-102.
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Figure 6-102 Vehicle register

Vehicle Register X,
Vehicle DB Select hd
Country or * Plate
Region -
L
Mame s v

Color oM ‘] Plate Color & . ‘]
Driver ID

Type
Cell Phone

Email

>

Address

Cancel

Step 2 Select Vehicle DB, and enter Plate. Other information can be filled in according to
actual conditions.
Step 3 Click OK.

6.6.3.3 Managing Vehicle Information

After adding the vehicle information, such as plate, vehicle type, vehicle color, plate color,
logo, to the database, the information needs to be properly managed and maintained to keep
it accurate and complete.

On the LIVE interface, click , and then select FILE > Vehicle Management > Vehicle

Database. The database interface is displayed. See Figure 6-103. You can edit or delete the
vehicle information, or copy or cut the information to another database.
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Figure 6-103 Database

6} Face Management ~ - Back famy Database 12
Face Database + Manual Add = Batch Import + Copy to o Delete
{8} Vehicle Management > Al
Vehicle Database
Country or Region :
_____ Name :
aEEER i
e e Driver ID:
Logo : UnKnown
Color : Plate Color :
# Type: Large Bus
123456789 ype: Large
L # Address:
Country or Region : United Kingdom
Name : Peter
[
@0 @ Driver ID: PETER123456D12EC
Logo : Audi
Color : Plate Color :
#  Type: Heavy Truck
BD51SMR yoe: Heawy
L #  Address: Birmingham
2 in total. Show upta| 40 -

6.6.3.3.2 Editing Vehicle Information

Step 1 Move the cursor to the database, and then click [
The Edit interface is displayed. See Figure 6-104.

Jump To
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Figure 6-104 Edit

Edit *
Country ar * Plate 123456789
Region -
Name Logo UnKnown -
Color My Plate Color &y .
Driver ID

Type

CellPhone | 0 (= oem e

dEEER

Email

P

Address

Step 2 Modify vehicle information according to actual needs.
Step 3 Click OK.

6.6.3.3.3 Copying Vehicle Information

Copy the vehicle information in a database to another database. IVSS Supports only copy
and apply the vehicle information to database of the same type. For example, vehicle
information in a black list database can only be copied to another black list database.

Step 1 Move the cursor to the database, and then click
LL]

e Multiple vehicle information can be selected at a time.
e Select All to select information of all vehicles on the interface.

) + Copyto
Step 2 Click

The Copy to interface is displayed. See Figure 6-105.
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Figure 6-105 Copyto

Copy to s

Retain Original plate Replace existed plate “ Cancel

Step 3 Select the target database.
L]

e Multiple databases can be selected at a time. Blue means already selected, for

example :

e Select Retain Original plate: When the same plate is detected, the vehicle
information in the target database will not be replaced.
e Select Replace existed plate: When the same plate is detected, the vehicle
information in the target database will be replaced.
Step 4 Click OK.

6.6.3.3.4 Deleting Vehicle Information

e Delete one by one: Move the cursor to the database, and then click O at the upper

right corner to delete the database.
e Delete in batch

¢ Move the cursor to the database, and then click at the upper left corner to select

. . . ) m Delets
the database. Select multiple databases in this way, and then click
to delete selected databases.
) m Delets .
& Select All, and then click to delete all the databases on the interface.

6.6.4 Setting Plate Comparison

IVSS compares detected plate with plate information in the database, and trigger alarms
when plate in the black vehicle list is detected.
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N

The section takes Al by device for example, and the actual interface shall prevail.

Step 1 Click or on the setting interface, then select EVENT.

The EVENT interface is displayed.
Step 2 Select device from the device tree on the left side.
Step 3 Select Al Plan > Plate Comparison.
The Plate Comparison interface is displayed. See Figure 6-106.
Figure 6-106 Plate comparison

w  Video Detect Enabled | m|

:ﬁ: VideoMotion

E¥ Tampering ~ Deployment Time - @ View Schedule + Add Schedule
w  IPC Offline )
¥ Associate Vehicle Without Database
HE 1PC Offline -

w Al Plan

{8 AlPlan

FL Face Detection

n Face Recognition

@ Video Structuring o
B vs ]
Eﬁi Vehicle Recognition

Esi Plate Comparison =1

Refresh Cancel

Step 4 Click - to enable plate comparison. The icon changes to .j.

Step 5 Click Deployment Time dropdown list to select schedule.
IVSS links alarm event when an alarm is triggered within the schedule configured.
e Click Add Schedule to add new schedule if no schedule is added or the existing
schedule does not meet requirements. For details, see "8.8.4 Schedule."

e Click View Schedule to view details of schedule.
Step 6 Link vehicle without database.

Enable linkage of vehicle without database. Alarm is triggered when vehicle not in the
database is detected.

1) Click # .

The Associate Vehicle Without Database interface is displayed. See Figure
6-107.
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Figure 6-107 Associate vehicle without database

¥ Associate Vehicle Without Database

Record | IPC x

Log | Enable )4

2) Click Actions to set alarm linkage event. For details, see "8.4.1 Alarm ."
Step 7 Link database.
LL]
Repeat the following steps to link multiple databases.
1) Click Associate Vehicle Database, and select the database to be linked.
The database linkage interface is displayed. See Figure 6-108.
Figure 6-108 Database linkage

Database 1 [l o
Al Alarm Rule 2 . Show Feature Panel [T
Record | IPC X
Log | Enable X

2) Setthe parameters. See Table 6-17.

Table 6-17 Database linkage parameters

Parameter Description
Al Alarm Rule Click O to set the color of alarm rule box.
Show Feature Click E. and when alarm is triggered, the plate comparison information is
Panel
displayed in the feature panel of video image.

3) Click Actions to set alarm linkage event. For details, see "8.4.1 Alarm ."
Step 8 Click Save.

6.6.5 Real-time View

View vehicle comparison results on the LIVE interface.

You can view real-time vehicle comparison results on the LIVE interface. If vehicle in the
database is detected, properties of the vehicle, such as plate, type, color, and logo, are
displayed on the right side of the real-time video image.
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6.6.5.1 Setting Al Display
You can set the vehicle properties that you want to display on the real-time video image.
L1

Before setting the features and properties, you need to create a view by adding cameras to
the view so you can check video and pictures captured by the cameras. To create view, see
"7.1.1 View Management."”

Step 1 Select a view from LIVE > View > View Group.

Step 2 Click TE, and then select Vehicle tab.

The Vehicle interface is displayed. SeeFigure 6-109.
Figure 6-109 Vehicle

) - Face Human Vehicle Mon-MotorVehicle
View 3
B camers
g cameral ; : Show Tracking Box : [
[F, cameral :
[Ey cameral
[Fy cameral L __________ e __I
Place White List Black List.
Ornament Place Place
Sa rL Belt Ornaiment Ornament
Driver Call Safe Belt Safe Belt
Driver Call Driver Call
Features Panel : [
Transparence : - 7
Sync from Al-Dis. Apply to all win “ Cancel
L0 | ff 11903 | py 103798 | Mysars | & |

Step 3 Click - next to Show Tracking Box to enable tracking box function.

A tracking box is displayed in the video image when target meeting detection rule is
detected.

Step 4 Set features panel.

1) Click - next to Features Panel to enable features panel function.

Features panel will be displayed at the right side of video image when target with
selected features is detected.

2) Select a vehicle information panel. means the panel is selected.

3) (Optional) Drag " 1o adjust the transparency of panel. The higher the value, the
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more transparent the panel.
4) (Optional) Select the features to be displayed in the panel.
e Up to 4 features can be displayed.
e 4 features are selected by default. To select another feature, click the

selected feature to cancel it, and then click the feature to be displayed.
Step 5 Click OK.

6.6.5.2 Live

On the LIVE interface, select a view, and the video image of the view is displayed. See Figure
6-110.
e Tracking box is displayed in the video image.
e [Features panel is displayed at the right side of the video image.
Figure 6-110 Live

Rule box Features panel

17:26:49

Move the cursor to the features panel, and the operation icons are displayed. See Figure
6-111.
Figure 6-111 Icons

17:26:49

S
Type : Unknown

Color

Logo *Unknown

e Click B! to add license plate information to the plate database. For details, see
"6.6.3.2.3 Add by Searching."

e Click or double-click the vehicle image to play back the video image (10 s before

and after the time of taking the snapshot).
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6.6.5.3 Detection Statistics

You can view the vehicle comparison results. For example, you can view whether a vehicle is
in the blacklist database or whitelist database.

On the LIVE interface, select a view and then click a The VEHICLE TOTAL interface is
displayed.

Click T:., and then select Vehicle Comparison (Black List) and Vehicle Comparison

(White List). The vehicle comparison result is displayed. See Figure 6-112.
Figure 6-112 Vehicle comparison

VEHICLE TOTAL

Imc 2019-04-04 16:54:12 ITC 2019-04-04 16:54:12 ITc 2019-04-04 16:54:11 ITC

A Black lis! ABlack list |

Plate AS839N Plate AOB1PY g
Type Unknown Type Unknown "
Color . Color . X
v Unicwn _ o Unknown og0

BlackListDB

2019-04-04 16:54:10

A Black list
Plate AVWY.
Tom Unknown
Color

"

Logo

S

BlackListDB

‘WhiteListDB BlackListDB

Move the cursor to the information panel, and the following icons are displayed:

° : Click it to add license plate information to plate database. For details, see "6.6.3.2.3

Add by Searching."

: Click it or double-click the picture to play back the video image (10 s before and after
the time of taking the snapshot).

: Click it to export the video to specified save path (PC or USB storage device).

L_,J

Make sure USB storage device is connected if you want to store the file to such storage
device.

6.6.6 Al Search

Set search conditions such as device and properties, and then search information that meets
the conditions. IVSS supports search by property and search by database.

6.6.6.1 Search by Property

Set search conditions such as device and properties, and then search vehicle recognition
information that meets the conditions.
Step 1 On the LIVE interface, click , and then select Al Search > Search by Vehicle.

The Search by Vehicle interface is displayed.
Step 2 Select device ,and then click Property tab.

The search by property interface is displayed. See Figure 6-113.
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Figure 6-113 Search by property

AISEARCH  +

SearchbyFace  Searchby Human  Search by Vehicle Search by NonMetor Vs

Q. SearchDevice Name/IP T

- (] @ Device
Moy P
Ly IpC

$y 3333

~ [ Gy 1D01D77PAW00124.

L camerat
S camen2
L camers3

Property Vehicle DB

Event Type

Al -
Vehicle Property

Tyee| Al ~ Colorill |
Logo| All - "‘m’“.

Plate| Enter Plate Number

2019 - 04 - 16 00 : 00 : 00

2019 - 04 - 16 23 159 1 59

A Search range 30 days

Step 3 Select Plate Comparison as the Event Type.
Step 4 Set vehicle properties and time period.

ick il or ~ A
Click or to set the color. means more than one color.

Step 5 Click Query.
The search result is displayed. See Figure 6-114.

If license plate is detected, both the scenario and the license plate will be displayed.
Figure 6-114 Search result

Al SEARCH +

Search by Face Search by Human  Search by Vehicle  Search by NonMotor Vs

Al Total 64200 record(s)
Q. SearchDevice Name/IP v

2019-04-17
» B (& Device cameral 0000:10 cameral 00:00:10 cameral 0000:13 cameral 000013
[l Access ? = Plate ? = Plate 0 Ql: 7 Plate m
» (] @RTSP Media d coor [ ) coor [ ol o [ 1} [ 1
Type  UnKnown Type  Unknown Type  UnKnown Unknown
T Logo Unknow = Logo Unknow Logo Unknow Unknow
===
cameral 0000:13 cameral 000014 cameral 0000:16 000016
W e i j Plate Plate Plate.
Property MehiseDE, e | oo o coor [ coor [ coor I
= Tye UnKnown Type UnKnown Type UnKnown Type UnKnown
Event Type Logo  Unknow Logo  Unknow Logo  Unknow Logo  Unknow
Plate Comparison v
VeticeProperty K
0000:17 cameral 000017 cameral 0000:17 000017
Type| Al | cotorill
Pate C Pt Plate
= p
Logo Al plate il _ Color [ | (1] coor W
Type  Unknown Type  Unknown Unknown Type  UnKnown
BEE| Enter Plate Number logo  Unknow logo  Unknow Unknow logo  Unknow

2019 - 04 - 17 00 : 00 : 00

00:00:17 cameral 00:00:18 cameral 00:00:18 cameral 00:00:18

Pate Plate Ga Pl Plate
coor [ | — T | - oo i coor [

Type  Unknown AR Type  Unknown R, Type  Unknown Type  UnKnown
Logo Unknow s, Logo Unknow ¥ Logo Unknow = Logo Unknow

2019 -04 -17 23 : 59 : 59

Query

A\ Search range 30 days

Other Operations

Click on one displayed panel, and the icons are displayed. See Figure 6-115 and Table 6-18.
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Figure 6-115 Icons

cameral 00:00:13
Piate
Color ‘]
Type UnKnown
Logo Unknow

Table 6-18 Operation

Icon | Operation

e Select one by one: Move the cursor to the panel, and then click at the upper

right side to select the panel. means the panel is selected.

e Select in batches: Select All to select all the panels on the interface.

Move the cursor to the panel, and then click or double-click the panel to play back

the video record (10 s before and after the time of taking the snapshot).

Move the cursor to the panel, and then click to add picture to database. See

"6.2.2.2.3 Detection Add."

Move the cursor to the panel, and then click , or select the panel and then click T

to export picture, video, and Excel file to specified save path.

6.6.6.2 Search by Database

Search vehicle recognition information according to database.

Step 1 On the LIVE interface, click , and then select Al Search > Search by Vehicle.

The Search by Vehicle interface is displayed.
Step 2 Select device from the device tree, and then click Vehicle DB tab.
The search by database interface is displayed. See Figure 6-116.
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Figure 6-116 Search by vehicle database

LIVE AISEARCH +

Searchby Face  SearchbyHuman  Searchby Vehicle Search by NonMotor Vs

Q,  SearchDevice Name/IP i

Gy IPC
4 Gy 3333
v ¥ Gy 1D01D77PAW00124
Oy cameral
Ly cameraz
&y camersd

Property Vehicle DB

b [ Vehicle DB

2019 - 04 - 01 00 : 00 : 60

2019 - 04 - 14 23 : 59 : 59

A\ Search range 30 days
Step 3 Select the database to be searched.

Step 4 Click Query.
The search result is displayed. If license plate is detected, both the scenario and the

license plate will be displayed.

Other Operations

Click on one displayed panel, and the icons are displayed. For operations of icons, see
"6.6.6.1 Search by Property."
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7 General Operations

It is to introduce general operations such as preview and monitor, playback, alarm, Al function,
and IVS.

7.1 Live and Monitor

After logging in device, the Live interface is displayed. See Figure 7-1 and Table 7-1.
LI

Move the mouse to the middle of video window and left column. H is displayed. Click the icon
to hide the left column. See Figure 7-2.
Figure 7-1 Live (1)

2018-11-2209

2018-1T1-2200980)

e i e lagia

L2046 | fisis | o | & . LS
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Table 7-1 Live interface description

No. Description

1 View zone. Displays the created view and view group. Refer to "7.1.1 View
Management for detailed information."

5 Resource pool. Displays the added remote device list. Refer to "7.1.2 Resources Pool
for detailed information."

3 PTZ zone. Itis to control the PTZ. Refer to "7.1.3 PTZ for detailed information."”

4 Smart preview icons. View face statistics, person statistics, IVS statistics and Al
display.

5 Video play window. Refer to "7.1.1.3 View Window for detailed information."

7.1.1 View Management

View refers to video images of several remote devices. Go to the view panel at the upper left
corner on the LIVE interface to check the view. See Figure 7-3.

A view group is created by default. You can add view(s) to this view group, or create new
view group before adding view(s).

Double-click the view or drag the view to the play panel on the right side. IVSS begins
playing the real-time video of corresponding remote device.

Click {1 to select views and its sub-node.

Figure 7-3 View

v View

« View Group i
» View 1

| 1 ]
[ 1]
p BB View 2

E E [ @O

7.1.1.1 View Group

View group is a group of views. The view group allows you to categorize and manage view,
so you can easily search and find the view.

N

IVSS supports a maximum of 100 view groups.

The views hierarchy shall not be more than 2. For example, after you create View Group
1 under View, you can create a sub-level View Group 2 under View Group 1. However,
you cannot create sub-level group under View Group 2.
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Create view group

Step 1 Follow the steps listed below to create a view group.

e Select Views or created view group and then click L .

e Select Add View to add new view group. Set the group name, and click OK.
System creates one view group. See Figure 7-4.
Figure 7-4 Create view group

w View

 View Group i0
b BB View1l

b BB Wiew 2

Add View

K * o

Step 2 Set view group name.
e The view group name ranges from 1 to 64 digits. It can contain English letters,
number and special character.
e View group is to classify or category different view groups. We recommend the
view group name shall be easy to recognize.
Step 3 Click any spare panel on the interface.
Device pops up successfully operated.

Operation

After creating view group, view group can be renamed or deleted. Refer to Table 7-2 for
detailed information.

Table 7-2 View group

Operation | Description

e Select a view group and then click (4 Set view group name and click any

Rename
spare panel.

view grou
grotp e Right-click view group and select Rename. See Figure 7-5. Set view group

name and click any spare panel.
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Operation | Description

A\

Once you delete view group, all views under current view group will be deleted at the

Delete View
same time. Please be careful!
group
e Select view group and click m
e Right-click view group and then select Delete.
Figure 7-5 Rename
v  View
w View Group i
b EE Vipet
TR Qpen
[# Edit
Eename
m Delete
E [ o
7.1.1.2 View

View is a video component of several remote devices. You can drag several remote devices
to the same view and when view function is enabled, you can view the real-time video from
several remote devices at the same time.

7.1.1.2.1 Create View

Create view is to add several associated remote devices to the same View. It is easy to view
the real-time video from several remote devices at the same time.

Preparation

Remote device has been added. Refer to "5.4.2 Adding Remote Device" for detailed
information.

Create View

Step 1 Follow the steps listed below to create view.
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+ Resources

e Select a view group and then click I , Select Add view.

e Right-click a view group, select Add view.
The Edit interface is displayed. See Figure 7-6.
Figure 7-6 Edit

Step 2

Double-click a remote device in resource pool, or drag the remote device to the right

panel.

After one remote device is added, layout grid is displayed. See Figure 7-7.

e Each layout grid supports one remote device. If you want to add several remote
devices, drag the rest remote device to other idle layout grid.

e |If the layout grid has added the remote device, drag another remote device to
current grid is to replace the original one.

e Move the mouse to the orange panel (such asj) of the view window, press the

view window and then drag after you see the arrow icon. It is to adjust view
window size.

e Device automatically creates the view grids amount according to the selected
remote device amount. Device supports maximum 36 view windows.

e The view window fills in the whole layout grid by default. Right-click to select
Original Scale > ON, and turn on the Original Scale. The device automatically
adjusts view window size according to resolution of remote device.

e When adjusting view window position, drag the view window to the layout grid
of the green background color. You cannot drag the view window to the grid of
red background color.
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Figure 7-7 Edit view

Step 3 Set view name.
The view name ranges from 1 to 64 digits. It can contain English letters, number and
special character.

Step 4 Click OK to save the configuration.
Device pops up a prompt of Successfully operated.

Operation

After creating view, view be edited, enabled, renamed or deleted. Refer to Table 7-3 for
detailed information.

Table 7-3 View
Operation Description
Edit vi Edit remote device in the view, window layout and view name. Refer to "7.1.1.2.2
it view
Edit View" for detailed information.
_ After enabling view, view real-time image of remote device in the view. Refer to
Enable view i Lo .
"7.1.1.2.3 Enable View" for detailed information.
e Select a view group and then click [# . Set view group name and click any
Rename
. spare panel.
view
e Right-click view and select Rename. See Figure 7-8. Set view name and click
any spare panel.
e Delete: Select a view and then click @ , or right-click view and then select
Delete view Delete.
e Batch delete: Click , Select views you want to delete and then click o
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Figure 7-8 Menu

~w  View

 View Group

b EE Vimws

yomow O
@ Edit
m Delete

E ¥ @

7.1.1.2.2 Edit View

In edit view mode, it supports fol

lowing functions:

e Add, delete the remote device on the view.

e Adjust the view grid display.
e Modify view hame.
Step 1 Right-click View and the

n select Edit.

The Edit interface is displayed. See Figure 7-9.
Figure 7-9 Edit view

> P1IZ

Step 2 Edit view as your requirement.
e Add remote device: Double click remote device in the resource pool, or drag the
remote device to the free layout grid on the right panel.

e Delete remote device: Move the mouse to window on the right, and click E at

the top right corner.

e Move window position: Select and hold on a view window, move it to the proper
position and release mouse.
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e Change window position: Select and hold on one view window and then drag to
another view window.
e Change window size: Move your mouse to the orange panel on the window

(such as j) Press and drag the view window after you see the arrow icon.

e Modify view name: Set view name on | View!
(1]
When adjusting view window position, drag the view window to the layout grid of the
green background color. You cannot drag the view window to the grid of red
background color.

Step 3 Click OK to save the configuration.
Device pops up successfully operated.

7.1.1.2.3 Enable View

Right-click the view and select Open, or double-click view. The view window is displayed.
See Figure 7-10.
Figure 7-10 View window

2018-11-22 09

-

O 11,16 1811

> P1Z 226 | jhus o & a -

When enabling the view, you can change video position, zoom video window. Refer to 0 for
detailed information.

I—vJ

e When adjusting view window position, drag the view window to the layout grid of the
green background color. You cannot drag the view window to the grid of red background
color.

e Move the mouse to view window. Window task column is displayed to snapshot, enable
record and turn off view window. Refer to "7.1.1.3.2 Window task column" for detailed
information.

e Right-click view window, you can switch bit streams, set digital zoom. Refer to "7.1.1.3.3
Shortcut menu" for detailed information.
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Table 7-4 View function

Operation Description

Press one view window and drag it to another view window, it is to exchange
these view window position.

[

The exchanging window position operation is valid only once. Disable and
then enable view again, the view window restores original position. If you
want to change view window position permanently, go to the view edit mode
to set. Refer to "7.1.1.2.2 Edit View" for detailed information.

Exchange
window position

e Once current view window amount is too much (more than 9), click one
view window, device displays current view window at the center of the
window in the zoom in mode. Click any other blank position, you can

Zoom in video . . - .
view window restores original size.

window e Double click a view window, device displays view window at one
window. Double click view window again or click any blank position, the
view window restores original size.
In the resource pool, double click the remote device or drag the remote
device to the right panel, you can add remote device to current view.
Drag the remote device to the view window to replace the original remote
Add view .
) device.
window m
The modified view layout is valid only for once if you do not click OK button.
Close and enable view again, the view layout restores original layout.
Close view Move the mouse to one view window, click m to close the view window.
window Close view window, device automatically adjusts view layout according to

the rest remote device amount and play panel free space.

7.1.1.3 View Window

Right-click the view, select Open, or double click view. The view window is displayed. See
Figure 7-11.
Figure 7-11 View window

> P12 Lo | i st o i) [« M
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7.1.1.3.2 Window task column

Move the mouse to view window. The window task column is displayed. See Figure 7-12.

IP PTZ Camera

Figure 7-12 View window

In the view window task column, enable manual recording, snapshot or close view window.
Refer to Table 7-5 for detailed information.

Table 7-5 Window task column

Operation | Description
Click ﬂ to start recording manually. Now the icon becomes . Click . to
stop recording.
System stops recording according to the manual record length settings if you do
not click . again to stop. Refer to "8.2.2.2.5 Storage" for detailed information.
Open At different interfaces, recording storage path varies.
Manual e Local Configurations
Video ¢ When USB storage device is connected, recordings are saved in USB
Recording storage device.
¢ Otherwise, the recordings are saved in the device. Query or export
manual recording by playback control. Refer to "7.2.1 Playing Back
Recorded Video" for detailed information.
e Operate IVSS Client.
Default storage path of recording is C:/Program Files (x86)/iVSS/video. Set
storage path. Refer to "8.2.2.2.5 Storage" for detailed information.
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Operation

Description

Click @ to snapshot.

At different interfaces, snapshot storage path varies.
e Local Configurations
¢ When USB storage device is connected, snapshots are saved in USB
storage device.

Snapshot i . .
¢ Otherwise, the snapshots are saved in the device. Query or export the
snapshots by playback control. Refer to "7.2.3 Playing Back Snapshots”
for detailed information.
e Operate IVSS Client.
Default storage path of snapshot is C:/Program Files (x86)/iVSS/pictures.
Set storage path. Refer to "8.2.2.2.5 Storage" for detailed information.
Close view
window Click E to close view window.

7.1.1.3.3 Shortcut menu

Right-click video window. The shortcut menu is displayed. See Figure 7-13. For details, see

Table 7-6.
Figure 7-13 Shortcut menu
Stream k
Lhgital Zoom F
Bite Rate L4
Original Scale  »
e | Audio 3
Table 7-6 Shortcut menu
Parameter | Description
Stream It is to set current window stream. It includes main stream/sub stream 1/sub
stream 2.
Digital It is to set digital zoom. Zoom in one part of live image to view details. Refer to
zoom "7.1.1.3.4 Digital zoom" for detailed information.
Bit rate Displays real-time bit rate on the window or not. See Figure 7-14.
It is to set video window scale.
Original e ON: System automatically adjusts video window scale according to the
Sc:Ie resolution.
e OFF: System automatically adjusts video window scale according to the
remote device amount and the free space on the playback panel.
Audio It is to set audio output. It includes audio 1, audio 2, mixing and off.
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Figure 7-14 View window

IP PTZ Camera

e
@mesozsfps@mambps '

7.1.1.3.4 Digital zoom

The digital zoom function allows you to zoom in a specified zone to view the video details.

After enabling view, right-click Digital Zoom > ON. Select a zone in view window, and the

selected zone will be zoomed in. See Figure 7-15.

e In zoom in status, press any position on the video window and then drag, you can view
the zoom in effect of other zones.

e Select a zone you want to zoom in on the video window again, system zooms in the zone
at the larger rate.

e Right-click mouse and then select Digital Zoom > OFF, it is to cancel zoom in effect.
The video restores original effect.

Figure 7-15 Digital zoom:
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7.1.2 Resources Pool

Displays the added remote device list. The system automatically divides into groups
according to device type. See Figure 7-16. Refer to Table 7-7 for detailed information.
Figure 7-16 Resources pool

~ Resources

TPC

[F] Access
& RTSP Media

Table 7-7 Resources pool description

Operation Description

Input key words at , device displays the corresponding

Search device | remote devices.

[

Support fuzzy search.

Click V and then select all, online, offline. It is to filter the disqualified remote

Filter device

device.

Display remote device status on the resources pool.

e If the remote device name and icon is black, it means the remote device

is online. For example, & P PTZ Camera,

e If the remote device name and icon is gray, it means the remote device is
View device
status offline. For example, & '"-.

e Ifthereis an icon #* before the remote device, it means remote device is

abnormal, alarming, and so on. Move the mouse to A to view the

detailed information.

General Operations 148



Operation Description

e Move the mouse to the remote device name, you can view remote
device IP address and port number.

e On the device list, click one remote device and then press Ctrl, click
other remote device, you can select several remote devices at the same
time.

Mouse e On the device list, select one remote device and then press Shift, click
Operations other remote device, select current two remote devices and all remote
devices listed between them.

e Right-click a remote device to connect to disconnect it.

e Double click remote device or drag the remote device to the view window
on the right panel, you can enter edit view interface. Edit the view. Refer
to "7.1.1.2.2 Edit View" for detailed information.

7.1.3 PTZ

Control the PTZ, you can move the PTZ at all directions, lens zoom in/zoom out, focus control,
and so on. In this way, it can display PTZ at all angles from different positions.

On the Live interface, PTZ is displayed at the bottom left corner. See Figure 7-17. For detalils,

see Table 7-8.
LLI

The following figure for reference only. The grey button means current function is null.

Figure 7-17 PTZ
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i

| w

MIM =
'y

e & - 90O

o ] OFF I o 0
@ OFF 111 oM 8]
e

?-' OFF 111 oM [
— OFF 111 =[] 8]
»
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Table 7-8 PTZ Icons description

Signal Words Description

SPEED

MR

Press and hold on , and drag it up and down. It is to set

PTZ speed. The higher the value is, the faster the PTZ speed
is.

| —

=
=

Control PTZ movement in the following ways.

*I_’ to control PTZ

< "I" ) top/bottom/left/right/top left/top right/bottom left/bottom
right direction.

e Press and hold on

o Click & ¥ <o ? ,itis to control PTZ

v
top/bottom/left/right direction.
iQ Click to enable 3D positioning function.
= Click to enter PTZ menu mode. Refer to "7.1.3.2 PTZ Menu
“ Settings" for detailed information.
= & Zoom. Click to adjust lens zoom rate of the remote device.
i Focus. Click to adjust lens focus of the remote device.
&S O Iris. Click it to adjust iris size of the remote device.
Click to enter PTZ call interface.
L
Go to the remote device to set corresponding PTZ function
before you call it.
. " .
e Click to enter preset call interface. Refer to
r VA O e} "7.1.3.3.1 Call preset" for detailed information.

e Click W to enter call cruise interface. Refer to

"7.1.3.3.2 Call cruise" for detailed information.

-

e Click < toenter call pattern interface. Refer to

"7.1.3.3.3 Call pattern” for detailed information.

7.1.3.2 PTZ Menu Settings

Enable PTZ menu function, device displays PTZ main menu on the view window. The PTZ
main menu includes camera settings, PTZ settings, system management, and so on. Use
direction button and confirm button to set the remote device.
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N

PTZ menu function is for remote device that supports PTZ function only.
Step 1 Enable view and then select a remote device on the view.

Step 2 On PTZ panel, click = .

The OSD menu is displayed on the screen. See Figure 7-18. For details, see Table

7-9.

19 9%1

Figure 7-18 PTZ menu interface

20 1208 &0 ™ o~

Table 7-9 PTZ menu description

Parameter | Description
Enter camera interface, you can set remote device image parameters. It includes
Camera picture, exposure, backlight, WB, day and night, focus and zoom, defog, default,
and so on. (Different series products have different menu items.)
- Enter PTZ interface, you can set remote device PTZ function. It includes preset,
cruise, scan, pattern, rotation, PTZ restart and so on.
Enter system interface, you can set remote device PTZ simulator, restore default,
System manage remote device peripheral device, view remote device software version,
PTZ version and so on.
Exit Exit PTZ menu interface.

Step 3 Set PTZ menu parameters.
Enter PTZ menu interface with PTZ operation icons, and set configuration items.

Click “* or v,it is to select items.
Click < or 4 , itis to set parameters.

Click °%  to confirm current items.
<& When there is sub-menu of the item on the main menu, move the mouse to

the current item and then click % , enter sub-menu interface.

kOK

< Select Back and then clic , return to upper-level menu.
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& Select Exit and then click 2% to exit PTZ menu mode.

Step 4 Click (2 to exit PTZ menu mode.

7.1.3.3 Calling PTZ Functions
Itis to call PTZ function, control PTZ device to implement corresponding operations.
L[]

Different PTZ devices support different PTZ functions. Refer to the actual interface for
detailed information.

7.1.3.3.1 Call preset

Preset function is to save the position information (such as PTZ pan/tilt, focus) to the memory,
so that you can quickly call these parameters and adjust the PTZ to the correct position.

Step1 Click "

The Preset interface is displayed. See Figure 7-19.
Figure 7-19 Call preset

-
-

M B &

-

01 Preset()l

m

Step 2 Move the mouse to the preset name.

The e displays at the right side of the preset name.

Step 3 Click " .

PTZ device goes to the corresponding position.

7.1.3.3.2 Call cruise
Cruise is to add presets into a routine in a desired order and then set time and stop duration

for each position. The dome will begin an auto cruise between these presets.

Step1 Click ¥™.

The call cruise interface is displayed. See Figure 7-20.
Figure 7-20 Call cruise

Step 2 Move the mouse to the cruise name.

General Operations 152



The * displays at the right side of the cruise name.

Step3 Click * .

PTZ device calls cruise path and goes to the presets at the specified order and
interval.

Step 4 Click ™ to stop calling cruise.

7.1.3.3.3 Call pattern

Pattern is to memorize dome operation such as pan, tilt, and zoom to repeat. Start position of
record is starting point. You can call it to repeat the previous operation.
Step1 Click
The call pattern interface is displayed. See Figure 7-21.
Figure 7-21 Call pattern

SRV

Step 2 Move the mouse to the pattern name.

The * displays at the right side of the pattern name.

Step 3 Click ” .

PTZ device calls pattern and move back and forth according to the settings.

Step 4 Click ™ to stop calling pattern.

7.2 Search

It is to search or playback the record file or image on the device. At the same time, you can
export record file or image to designated storage path.

7.2.1 Playing Back Recorded Video

Search and playback record file according to remote device, record type, and record time.

Step 1 On the Live interface, click and then select Search.

Search interface is displayed. See Figure 7-22.
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Figure 7-22 Search

Step 2 Select a remote device, and then click Record tab.
Step 3 Select record type.
The record type includes All Record, Manual Record, Video Detect, and 10 Alarm.
e Allrecord: Search all records.
e Manual record: Search the records that are manually enabled by the user. For
manual record, refer to "7.1.1.3.2 Window task column" for detailed information.
e Video detect: Search the records of video detection. For setting of video
detection record, refer to "8.4.3.1 Video Detect".
e |O alarm: Search local alarm linkage records. For setting of local alarm linkage
record, see "8.4.2.4 Configuring Device Alarm".
Step 4 Set search time.
e Method 1: Click the date or time on the time column, change time or date value.
e Method 2: Click the date or time on the time column, use the mouse middle
button to adjust time or date value.

e Method 3: Click = , set date or time on the schedule, click OK button. See
Figure 7-23.

In the schedule interface, if there is a dot under one date (such as 2-4 ), the date

has records.
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Figure 7-23 Schedule interface
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Step 5 Click Search.

The record thumbnail is at the top of the remote device, and the time bar displays the
record period (green color means there is a record). See Figure 7-24.
L1
e The selected remote device is on the left panel. Click a remote device, and the
record file thumbnail is on the right panel.

e Click l or l to move thumbnail list or hide/display the thumbnail.

e Move the cursor to the thumbnail, you can view remote device name, record
start time, and end time of the corresponding record.

e Move the cursor to the thumbnail list. The interface displays 4. Click
the icon to hide the thumbnail list. If the thumbnail list is hidden, click ="

to display the thumbnail list.
Figure 7-24 Search result

Local Device
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Step 6 Drag the thumbnail to the playback window or double click the thumbnail.
Device begins playing the record. See Figure 7-25. Refer to Table 7-10 for detailed

information.
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e The playback window amount depends on the thumbnail amount you can drag
or select. System supports maximum 16 windows. System automatically
adjusts each window size according to the original scale of playback file.

e  The thumbnail with * means system is playing record file of current thumbnail.

Figure 7-25 Search (2)

-] =3 « <« |l W LLTiin ) e— [ T
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Table 7-10 Search icons description

Icon Description
Click to synchronize playback mode. You can use the playback control
icon to control several windows, such as fast forward/backward at the

ALL same time.
Click to cancel synchronization operation.
Play back several record files at the same time. Click the icon to switch
to time synchronization mode. All other windows play the video file of
the same time of current window.
Click I3 to cancel time synchronization.

o m
Click =4 , System enables synchronization operation function. If you want
to cancel synchronization, click 3 .
Click to play back video file at slow speed.

L | The slow speed includesX1/2,X1/4,X1/8, andX1/16. Click the icon
once, the playback speed degrades one level.
Click to switch to frame by frame backward playback.

R 1]

Itis only valid in pause mode.
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Icon

Description

Click to play backward. Now the icon becomes IE ciick 1 1o stop

backward play.

Click to start playback. Now the icon becomes ” Click " to

pause playback video.

d

Click to switch to frame by frame playback.

[l

Itis only valid in pause mode.

»

Click to playback at fast speed.
The fast speed includesX1,X2,X4,X8, and X16. Click the icon once,
the playback speed upgrades one level.

L1 Wy
X1

Displays playback speed. Drag == {0 the left or right, it is to playback

at fast forward or fast backward.

Click to snapshot an image.

[+]

Click to obtain one part of record, and save it in designated storage
path. Refer to "7.2.2 Clipping Recorded Video" for detailed information.

I‘ﬂ ——

Control volume.

e Drag to set volume level.

e click " to mute. Now the icon becomes ¥ . ciick "% 1o

cancel mute.

Click to playback at full screen.
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Icon Description

Time bar. Displays record type and record file period.

e There are two record file bars on the time bar. The top bar is to
display record time of selected window. The bottom bar is to
display record time of all selected remote devices.

e The time bar adopts color to categorize record type.
Green=Regular record. Red=Alarm record. Blank=No record.

o .I A% Time scale is to display record file date and time.
System automatically adjusts time scale according to the record
playback process.

) e On the time bar, you can:

¢ Click the time bar and rotate the mouse wheel button to adjust
the time accuracy.

¢ Press the time bar and then drag to the left or right. It is to
move the time bar to view the hidden record time.

¢ Drag time scale to adjust start time of record playback.

¢ Click or drag the time scale to position where there is a
record, system starts playing from the selected time.

¢ Click or drag the time scale to position where there is no
record, system stops playing record.

Shortcut menu: Right-click mouse on the playback window, you can

view the shortcut menu.

e Zoom: Itis to zoom in a specified zone and view the details. Refer
to "7.1.1.3.4 Digital zoom" for detailed information.

Digita e Original scale: It is to set view window scale.
Original ¢ ON: System automatically adjusts video window scale
4 | Audio according to the video resolution.
¢ OFF: System automatically adjusts video window scale
according to the remote device amount and the free space on
the playback panel.

e Audio: Set audio output.

m Move cursor to the playback window, system pops up task column.

Click the icon to close the playback window.

7.2.2 Clipping Recorded Video

Clip one part of the recorded video, and save it in designated storage path.

I—vJ

Connect USB device to IVSS if you are on the local menu to operate.

Step 1 On the Live interface, click and then select Search.

The Search interface is displayed.
Step 2 Refer to "7.2.1 Playing Back Recorded Video" to play video file.
The video playback interface is displayed. See Figure 7-26.
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Figure 7-26 Playback

120117-10-12,20:30:32
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Step 3 Click [¥1

Video clipping frame appears on the time bar. See Figure 7-27.
Figure 7-27 Video clipping frame

13-11-29" 01:34:37

f save Immediately wm 1:45:00
1 1 1 1 1

Step 4 Press the record edit column (the blue column on Figure 7-27) and drag to the left or
right, to select start time and end time of clipping.
Step 5 Click Save Immediately.
The Save interface is displayed. See Figure 7-28.
Figure 7-28 Save

Save >
(1) All Start Time End Time Record Length Size
(1) cameral 2018-11-220... 2018-11-22 01:31:43 00:12:11 644.86MB

Total 644 B6MB

Save Path: I Browser...

Step 6 Click Browser to select save path.
Step 7 Click OK.
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Save the clipping to designated storage path.

7.2.3 Playing Back Snapshots

It is to search and playback image according to remote device, image type, and snapshot
time.

Step 1 On the Live interface, click and then select Search.

The Search interface is displayed.
Step 2 Select a remote device, and then click Image.
The Search interface is displayed. See Figure 7-29.
L1]
System supports maximum 1 remote device.
Figure 7-29 Image playback (1)

Step 3 Select image type, including manual snap and video detect.
Step 4 Set search time.
e Method 1: Click the date or time on the time column, change time or date value.
e Method 2: Click the date or time on the time column, use the mouse middle
button to adjust time or date value.
e Method 3: Click = , set date or time on the schedule, click OK button. See

Figure 7-30.

In the schedule interface, if there is a dot under one date (such as 2 ), the date

has records.
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Step 5 Click Search.

Figure 7-30 Schedule interface
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System displays searched image thumbnail. See Figure 7-31.
Figure 7-31 Image thumbnail

All Total5386
228, IPC

e The selected remote device is on the left panel. Click a remote device, and the
image thumbnail is on the right panel.

e Click I or I to move thumbnail list, and display the hidden thumbnail.

e Move the cursor to the thumbnail, you can view remote device name, and
snapshot time of the corresponding thumbnail.

e Move the cursor to the thumbnail list. The interface displays 4l . Click
the icon to hide the thumbnail list. If the thumbnail list is hidden, click
to display the thumbnail list.

Step 6 Drag the thumbnail to the playback window or double click the thumbnail.
Device begins playing the image. See Figure 7-32. Refer to Table 7-11 for detailed

information.
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Figure 7-32 Image playback (2)

SEARCH  +
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Move the cursor to the playback window, you can see the following icons.

Table 7-11 Icons

Description

Icon
“ Click to switch to the previous image or the next image.

Switch image.

<= e To play one image, click to go to the previous image or the next image.

e e To play several images at the same time, click to go to the previous group or
the next group.

E Click to display at full screen. Click again to cancel full screen.

7.2.4 Exporting File

It is to export record file or image to the designated storage path.

LI

e The default record file mode is .dav and the image file mode is .jpg.
e Connect USB device to IVSS if you are on the local menu to operate.

Step 1 On the Live interface, click and then select Search.
The Search interface is displayed. See Figure 7-33.
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Figure 7-33 Search (1)

Step 2 Search record file or image.

1) Click Record or Image tab.
2) Select a remote device and then set search criteria.
3) Click Query.
System displays searched record or image thumbnail. See Figure 7-34.
Figure 7-34 Thumbnail
Total5 i | Cancel
2281PC

2(118—11—22 06:20:02

Step 3 Select the record file or image you want to export.

Move the cursor to the thumbnail and then click to select the thumbnail.

means checked.
Click Cancel, itis to cancel all record files or images.

Step 4 Select file storage path.

1)

2)

Click A and then select Export record or Export image.

L1

The following steps are to export video file. Refer to the actual interface for
detailed information.

Click OK.
The Save interface is displayed. See Figure 7-35.
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Figure 7-35 Save

Save

(1) All Start Time End Time Record Length Size
1) 228 I1PC 2018-11-22 0... 2018-11-22 10:33:12 02:06:30 3.98GB
Total 3.98GB
Save Path Browser...
“ Cancel
3) Click Browser to select save path.
L]
For local menu operation, after you set storage path, the Save interface displays
Format button. Click Format button to clear all data on the USB storage device.
4) Click OK.

Device goes back to Save interface.

Step 5 Click OK.

The system starts to export files. The file downloading interface is displayed. See

Figure 7-36.
Figure 7-36 Download
Download x
» Resume All 11 Pause All W Clear Complete
Device Name Start Time End Time Process Operate
228 IPC 2018-11-22 08:26:42 2018-11-22 10:33:12 o CadnsEiin @
[ ]

tasks.

Click Pause all to pause all download tasks. Click Start all to resume download
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e Click Clear completed columns to delete all downloaded tasks.

e Click ' of the corresponding task to pause download task. Click P to

resume download.

e Click M ofthe corresponding task to delete download task.

7.3 File Management

It is to add face image to the face database. It is to manage and maintain the human face
images to guarantee information is correct.

On the Live interface, click , select File > Face Database. The Face Database interface

is displayed. Double click a face database to show it. See Figure 7-37.

At Face Database interface, edit face image information, copy face image to other databases
or delete face image.
Figure 7-37 Face database

&2 ¥ &0

7.3.2 Editing Face Image

Step 1 Enter face database, move the cursor to the face image and then click [#

The Edit face interface is displayed. See Figure 7-38.
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Figure 7-38 Edit face

Edit face x

* Name

Gender Male Female

E Birthday - -

Country or Region -

- Address
; 1D Type -
\, .

1D No.

Step 2 Change face information according to your actual situation.
Step 3 Click OK to save the configuration.

7.3.3 Copying Face Image

Step 1 Enter face database, move the cursor to the face image and then click
L]

e You can select several face images at the same time.
e Check All button to select all face images on current page.
Step 2 Click Copy to.
The Copy to interface is displayed. See Figure 7-39.
Figure 7-39 Copy to

Copy to x

Face database name Reset

aa

Retain Original Face “ Cancel

Step 3 Select the face database to receive the image.
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e You can select several face images at the same time. Blue means it is selected.

For example, S

e Enter face database name in Face database name text box, and click Query to
search it. After face database name is entered, click Reset to clear the entered
content.

e Select Retain Original Face to retain face images in the current face database.
It is selected by default.

Step 4 Click OK to save the configuration.

7.3.4 Deleting Face Image

Enter face database, and delete the created human face image.

e Delete: Move the cursor to the face image and click @ at the top right corner of the face
image to delete it.

e Batch delete:
¢ Move the cursor to the face image and then click ' at the top left corner of the

several human face images. Click Delete to delete the selected human face images.
¢ Check All box and then click Delete to delete all human face images on the current

page.

7.4 Alarm List

Click - to display alarm list. See Figure 7-40. It is to view alarm device name, alarm time

and alarm type.

Figure 7-40 Alarm list

e Number 9 is the number of alarm event to be processed. The value changes according
to alarm amount. It displays maximum 200 unprocessed alarm events.

e Click to lock alarm list. The alarm list is open and cannot hide. Click the icon again

to cancel lock function. Move the cursor to other position, and the alarm list displays for a
period of time and then automatically hides.

e Click . to confirm alarm event. The confirmed event will be removed from the alarm

list.
e Click the alarm event on the alarm list. The device displays the 20 seconds video before
and after the alarm event occurred. See Figure 7-41.
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¢ Click [Il to pause play. Now the icon becomes [] Click [] again to continue

to play.
& Click OK and close, confirm the alarm event and then exit the interface.
Figure 7-41 Alarm video

Device Name 228 IPC

Alarm type Motion

Alarm time 2018-11-22 16:13:18

7.5 Display Management

It is to enable connected display or lock the screen.

7.5.1 Multiple-screen Control

Device can connect to multiple displays at the same time. You can select a display you want
to use.

L]

e The multiple-screen control function is for local menu only.

e Enter Display Output interface, you can enable a display or set its resolution. Refer to
"8.8.3 Display" for detailed information.

e The interface may vary since the connected display amount is not the same.

Click @ The Display interface is displayed. See Figure 7-42.

e SN 1-3 represent displays connected to HDMI 1-HDMI 3. The main screen refers to the
device connected to VGA and HDMI 1 port (The HDMI/VGA port on Figure 7-42.). The
displays connected to the HDMI 2 and HDMI 3 are the sub screens. The output
interfaces of main screen and the sub screen are not the same and the supported
functions are different. Refer to Table 7-12 for detailed information.

e VGA and HDMI 1 are outputting the same video source. Three HDMI ports can output
different video sources.

‘LJ -

° ~ means connected and enabled display. means connected but not

enabled display.
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e Click ] or - to disable or enable display. Device adopts main screen by default

and the main screen cannot be disabled.
Figure 7-42 Display

DISPLAY

1

HDMI/VGA HDMI |

Table 7-12 Difference between main screen and sub screen

Name Main screen Sub screen
User operation (Login, log out, modify Supported Supported
password, lock)

Preview and Monitor Supported Supported
Search Supported Supported
Confirm alarm Supported N/A

Function File Management Supported Supported

Operations Intelligent Analytics Supported Supported
Multiple-screen control Supported N/A
System Info Supported Supported
Background Task Supported Supported
Operation and Maintenance Management | Supported Supported
Device Operation (Reboot, shut down) Supported N/A
Device, network, event, storage, Account,

System security strategy, and system Supported N/A

Configuration
management.

7.5.2 Locking Screen

Click E and then select Lock to lock the screen. The screen stops at current interface and
cannot operate other functions.

If you want to unlock the screen, click any position on the screen, enter password or user
other account to login. See Figure 7-43.
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Figure 7-43 Unlock screen

Unlock 4

Switch User Cancel

7.6 System Info

It is to view system information including system error, system alarm and system notification.

Click E to display background task list. See Figure 7-44.
Figure 7-44 System info

Error Warning Motification

[ -
m Clear

e Click All, Error, Warning, or Notification tab to view the corresponding system
information list.
e Click O to clear the corresponding system information.

e Click Clear to clear system information under current tab.
For example, click All tab and then click Clear button to clear all system information.
Click Error tab and then click Clear button to clear all system error information.

7.7 Background Task

It is to view background task running status.

Click @ device displays background task list. See Figure 7-45. Click All, Running, or

Waiting to view the corresponding background task list.
Figure 7-45 Background task

Running Waiting
- -
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8 System Configuration

This chapter is to introduce system configuration such as manage remote device, set network,
set alarm event, set HDD storage, manage user information, set device security strategy, set
system parameters.

8.1 Configuring Interface

Click . The setting interface is displayed. See Figure 8-1.

Figure 8-1 Setting interface

DISPLAY

nemiie =

On the setting interface, you can:

e Click to display or hide applications interface. When all applications are open,
device does not display this icon any more.

e Click the corresponding app icon to go to the corresponding interface. The task column
displays current running app name. Move the cursor to the app name and then click ﬂ

to close the app.
e Click Exit to exit the interface.

8.2 Device Management

Click or click on the setting interface, select DEVICE. The DEVICE interface is

displayed. See Figure 8-2. You can set IVSS or remote device.

e Select root node in the device list to set IVSS name and storage plan.

e Select a remote device in the device list. Set its attribute, connection, video, OSD, and
storage plan.
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N

Click ¥ or click Add to add remote device to the system. Refer to "5.4.2 Adding Remote

Device" for detailed information.

Figure 8-2 Device management

h 979Mbps400.00MBps

VZ000.0000000,0 % Buid Daie2016-11-05 224731

8.2.1 Local Device

It is to set device attribute and record storage plan.

8.2.1.1 Set attribute parameters.

It is to set device name, view device information.

Step 1 Click , or click on setting interface, and then select DEVICE.

The Device interface is displayed. See Figure 8-3.
Figure 8-3 Device

¥ DEVICE INFO

Ivss

¥2.000.0000000.0.R Bulld Date:2018-11-05 22:47:31

WEB Version  ¥4.0.0.106040

Step 2 Select the root node in the device list, and then click Attribute tab.
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The Attribute interface is displayed.
Step 3 Set parameters. For details, refer to Table 8-1.

Table 8-1 Attribute parameters description

Parameter Description

Name It is to set device name.

Description | It is to input device description.

Displays device info, including type, SN, MAC, video infout, audio in/out, Alarm
in/out and system version.

Device info

Step 4 Click Save.

8.2.1.2 Storage

It is to set device global record and image storage plan according to the actual scene.

L1

In this interface, the record and image storage plan is for all registered remote device. You
can select one remote device to set specified storage plan. Refer to "8.2.2.2.5 Storage" for
detailed information.

Step 1 Click , or click on setting interface, and then select DEVICE.

The Device interface is displayed.
Step 2 Select root node in the device list and click Storage tab.
The storage interface is displayed. See Figure 8-4.
Figure 8-4 Storage

| Attribute Eo Storage

Refresh

Step 3 Set parameters. For details, refer to Table 8-2.

Table 8-2 Storage parameters description
Parameter Description
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Parameter

Description

Record

Record plan

It is to set record strategy.

e Continuous recording: 24-hour continuous recording.

e Not recording: Device is not recording.

e Event recording: Device only records when there is
corresponding alarm event.

Manual record
length

It is to set manual record file length.

On the Live interface, click E to start record. If you do not click

the icon to stop record, system stops recording automatically
according to the record length here.

Storage path

Click Browser to set manual record storage path.

[l

Only IVSS client supports this function.

Image

Manual snap It is to set manual snapshot amount and snapshot speed.
It is to set event snapshot interval.
Event snap Select Customize to set customized interval. The maximum

internal is 3600 seconds.

Image storage
path

Click Browser to set snapshot image storage path.

[

Only IVSS client supports this function.

Step 4 Click Save.

8.2.2 Remote Device

IVSS supports to add remote device, modify its IP address and configurations, and export its
information.

In—v—-l

Refer to "5.4.2 Adding Remote Device" for detailed information.

8.2.2.1 Changing IP Address

It is to change IP address of the remote device. Pay attention that the device shall have not
registered to the system.

In—v—-l

e It only supports to modify the IP address of initialized device. For remote device
initialization, refer to "5.4.1 Initializing Remote Device" for detailed information.

e It only supports to modify the IP address of remote device connected with private
protocol.

e Refer to "8.2.2.2.2 Setting Connection Information” to change the IP address of
registered device.

Step 1 Click , or click on setting interface, and then select DEVICE.

The Device interface is displayed. See Figure 8-5.
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Figure 8-5 Device management

DEVICE  +

wss

12803

5.79Mbps/400.00Mbps

T

» V20000000000.0R,Buld Dote2018-11-05 22:47:31

¢ VADD106040

Step 2 Click + or click Add, and then select Smart Add.

The Smart Add interface is displayed.

Step 3 Search remote device.
LL]

System searches the remote devices of current IP segment by default.
1) Click {‘:’I’

The Add interface is displayed. See Figure 8-6.
Figure 8-6 Add

Add X
Manufacturer

Al

Private Panasonic Sony Dynacolor Samsung AXIS

Arecont Airlive Canon e LG Felco

SANYO ‘Watchnet Xunmei Other

IP Address

IP Address (@) IP Segment

from . . . to

2) Select manufacturer and set IP address you want to search.
e ltis to set remote device IP address. System can search the corresponding
remote device.
e It is to set remote device IP segment. System can search the remote
devices of current IP segment.
3) Click OK to save the configuration.
System goes back to Device interface.
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4) Click Start Search.

System starts to search and displays result. See Figure 8-7.
Figure 8-7 Remote device

Add Device %
Smart Add Manual Add Import C5V File
@
(0) Initialization State Address Product Model Manufacturer Product Type Sn Operate
i IPC-HF57229-.. Private IPC -
~  Initialized pRF-EN B H4D3PRVZ Meutral H4D3PRV2 o M |:
1M IP Camera Private IP Camera LIvE
v Initialized 1 PC-NVR Private
HFDSPR1 Neutral HFD5PR1 ] LIe
~  Initialized PRP i ) i MCS7024R Private MCS LT [
PI-HDW11205.. Private IPC e, LIVE
‘m 172 1k Private NVR 2 R A, ™
Total 116 Item(s) Show up to | 50 - T > GO
Bandwidth : 11.93Mbps/400Mbps Cancel
Step 4 Select a remote device and then click Modify IP.
The Modify IP interface is displayed. See Figure 8-8.
Figure 8-8 Modify IP (1)
Modify IP address ¢
(1)  Sn IP Address
! L]
DHCP (@  Static
Incremental
Static IP Address ‘ WValue 1
Subnet Mask ‘
Gateway ‘
2 U
o
b support Private only Cancel

Step 5 Select IP mode.
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e Check DHCP, there is no need to enter IP address, subnet mask, and default
gateway. Device automatically allocates dynamic IP address to the remote

device.
e Check Static, and then enter IP address, subnet mask, default gateway and

incremental value.

e Enter incremental value only when multiple remote devices are modified. If you
want to change several devices IP addresses at the same time, system
allocates IP address one by one according to you set at the fourth bit of the IP
address.

e If there is IP conflict when changing static IP address, device pops up IP conflict
dialogue box. To batch change IP address, device automatically skips the
conflicted IP and begins the allocation according to the incremental value.

Step 6 Enter the user name and password of remote device.
L1]
When you are changing several device IP addresses, make sure the user name and
password of these remote devices are the same.

Step 7 Click Next button.
System displays IP address modification interface.
Step 8 Click OK to complete the modification.

8.2.2.2 Configuring Remote Devices

It is to set remote device attributes, connection information, and video parameters.

L1

Different remote devices have different interfaces. Refer to the actual interface for detailed
information.

8.2.2.2.1 Setting Device Attribute
It is to set remote device name, and view device information.

Step 1 Click , or click on setting interface, and then select DEVICE.

The Device interface is displayed.
Step 2 Select a remote device on the left panel and then click Attribute tab.
The Attribute interface is displayed. See Figure 8-9.
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Figure 8-9 Attribute

¥ DEVICE INFO

e IPCHFI241F

111

out 22

2.622.0000000.15 R 2016-10-22

Refresh

Step 3 Set parameters. For details, refer to Table 8-3.

Table 8-3 Attribute parameters description

Parameter Description
It is to set remote device name.

Name After enabling Sync to remote device and save the settings. It is to
synchronize new name to the remote device.

Description | Input remote device description.

Device info Displays remote device information. It includes remote device type, SN, MAC
address, video in/out, audio in/out, alarm in/out, and system version.

Step 4 Click Save.

8.2.2.2.2 Setting Connection Information

It is to set connection information of remote device, such as IP address, and port number.

Step 1 Click , or click on setting interface, and then select DEVICE.

The Device interface is displayed.
Step 2 Select a remote device on the left panel and then click Connection tab.
The Connection interface is displayed. See Figure 8-10.
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Figure 8-10 Connection information

B Attribute A Connection B Video @ 0sD Storage

a
Link Type Self-Adaptive e

Cache Strategy Self-Adaptive -

Refresh Cancel
Step 3 Change IP address.

1) Click L4 of the corresponding address.

The Modify IP interface is displayed. See Figure 8-11.
Figure 8-11 Modify IP

Modify IP X

IPv4 -
DHCP (®  Static
IP Address
Subnet Mask 255 . 255 . 0] . 0

Gateway

2) Select IP mode.

e Check DHCP, there is no need to enter IP address, subnet mask, and
default gateway. Device automatically allocates dynamic IP address to the
remote device.

e Check Static, and then enter IP address, subnet mask, default gateway and
incremental value.

e Enter incremental value only when multiple remote devices are modified. If
you want to change several devices IP addresses at the same time, system
allocates IP address one by one according to you set at the fourth bit of the
IP address.

e If there is IP conflict when changing static IP address, device pops up IP
conflict dialogue box. To batch change IP address, device automatically
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skips the conflicted IP and begins the allocation according to the
incremental value.

3) Click OK to save setting.
Step 4 Change port number.

1) Click L4 of the corresponding port.

The Modify Port interface is displayed. See Figure 8-12.

Figure 8-12 Port

Modify Port 4

Port 3777

2) Change port number.
3) Click OK to save setting.
Step 5 Set other parameters. Refer to Table 8-4 for detailed information.

Table 8-4 Connection parameters description

Parameter Description
Manufacturer | Displays the connection protocol of the remote device.
It is to input user name and password of remote device.
Username The new password can be set from 8 characters through 32 characters and
contains at least two types from number, letter and special characters
Password (excluding ™", ™", ";", ":" and "&"). Enter a strong password according to the
password strength indication.
Link type Displays link type of the system and remote device. It is self-adaptive.
It is to set cache strategy of remote device video stream.
e Self-adaptive: System automatically adjusts video stream cache status
Cache according to the network bandwidth.
strategy e Realtime: It is to guarantee video realtimeness. When the network
bandwidth is not sufficient, the video may not be fluent.
e Fluency: Itis to guarantee video fluency. When the network bandwidth is
not sufficient, the video may not be clear.

Step 6 Click Save.

8.2.2.2.3 Setting Video Parameters

It is to set different video parameters according to different bit stream types based on the

bandwidth.

Step 1 Click , or click on setting interface, and then select DEVICE.

The Device interface is displayed.
Step 2 Select a remote device on the left panel and then click Video tab.
The Video interface is displayed. See Figure 8-13.
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Figure 8-13 Video

Step 3 Set main stream, sub stream 1, or sub stream 2.
Step 4 Set general video quality parameters. Refer to Table 8-5 for detailed information.

Table 8-5 Video parameters description

Parameter

Description

SVvC

Check the box to enable SVC function. Select 1 or 2 from the drop-down list on

the right. The default setup is 1, there is no scaled encoding.
L]

SVC refers to the scaled video coding. It can split the video stream to basic
stream and enhanced scale.

Encode
mode

It is to set video encode mode.

e H.264: It is a highly compressed video encode/decode standard. At the
same video quality, it has increased the compression rate by 2X compared
with the MPEG-2.

e H.265: It is a new video encode standard coming after H.264. It has
improved the complicated relationship among bit stream, encode quality,
latch and algorithm on the previous standard. It can get the best encoding.

Resolution

It is to set video resolution. The higher the resolution is, the better the video
quality is.

Different series products support different resolutions. Refer to the actual
interface for detailed information.

FPS

It is to set the frame amount displayed at each second. The higher the frame rate
is, the more vivid and fluent the video is.

Stream
mode

It is to set video bit stream control mode.

e CBR: The bit stream changes slightly. The bit stream is near the value you
set here.

e VBR: The bit stream may change according to the environment.

Quality

It is to set video quality. It includes low, middle, high.

It is null when the stream mode is CBR.
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Parameter | Description

It is to set video bitrate.

e Main Stream: In the Bit Rate list, select a value or enter a customized value
to change the image quality. The bigger the value is, the better the image

Bitrate will become.

e Sub Stream: In CBR mode, the bit stream changes around the value you
set. In VBR mode, it changes according to the bit stream value, but its max
value is near the specified value.

| frame Itis to set the P frame amount between two | frames. Usually we recommend it is
interval the 2X of the frame rate.

Step 5 Enable Event Video Quality and set FPS and stream mode.

[

Event video quality is for main stream only.
Step 6 Click Save.

8.2.2.2.4 0SD

It is to overlay time information, and channel information on the video.

pr-
Step 1 Click , or click on setting interface, and then select DEVICE.

The Device interface is displayed.
Step 2 Select a remote device on the left panel and then click OSD tab.
The OSD interface is displayed. See Figure 8-14.
Figure 8-14 OSD

Step 3 Enable OSD information according to actual requirements.
1) Click - to enable OSD function.
2) click .

The video displays the text boxes. See Figure 8-15, Figure 8-16 or Figure 8-17.
Figure 8-15 Device name

IP FTZ Camera
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Figure 8-16 Time

2018-11-20 14:25:34

Figure 8-17 Geographical position

A4 ﬁ
bbb [i]
CCC ﬁ
ddd [i1]

3) Set device name.

I-—-—-l

Skip this step if you do not want to use device name function.
4) Set geographical position information.

u

Skip this step if you do not want to use geographical position function.

Click or to create a text box. Input the geographical position

information.

< Click E to adjust font alignment mode.

< Click or again, add one text box at the top or the bottom of the text

box.

& Click T to delete the text box.

5) Drag the text box to the proper position.

6) Click & to save.
Step 4 Click Save.

8.2.2.2.5 Storage

It is to set video file and image storage plan of remote device according to the actual
situation.
Step 1 Click , or click on setting interface, and then select DEVICE.

The Device interface is displayed.
Step 2 Select a remote device on the left panel and then click Storage tab.
The Storage interface is displayed. See Figure 8-18.
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Figure 8-18 Storage

Refresh

= 0SD Ee Storage

Step 3 Select Inherit local storage plan or Customize.
e Inherit local storage plan: The remote device adopts global storage plan of the

device.

e Customize: Set customized storage plan.
Step 4 Set parameters. For details, refer to Table 8-6.

I-—-—-l

Set record streams only if you select Inherit local storage plan.

Table 8-6 Storage parameters description

Manual record

Parameter Description
It is to set record strategy.
e Continuous recording: Device records for all day.

Record plan e Not recording: Device does not record.
e Event recording: Device only records when there is
corresponding alarm event.

It is to set manual record file length.

Record

On the Live interface, click ﬂ to start record. If you do not click

length the icon to stop record, system stops recording automatically
according to the record length here.
Record It is to set record stream type. It includes main stream, sub
stream stream 1, and sub stream 2.
Manual snap | Itis to set manual snapshot amount and snapshot speed.
Image It is to set event snapshot interval.
Event snap Select Customize to set customized interval. The maximum

internal is 3600 seconds.

Step 5 Click Save.

System Configuration 184




8.2.2.3 Exporting Remote Device

Export the added remote device. When the device restores factory default settings or
information of remote device is lost, export information of remote device to recover quickly.

I—vJ

Refer to "5.4.2 Adding Remote Device" for detailed information.

Step 1 Click , or click on setting interface, and then select DEVICE.

The Device interface is displayed.

Step 2 Click - at the bottom left corner.
The Export interface is displayed. See Figure 8-19.
LL]

Click Download Template to download template file of the remote device, and add
remote device through the template.
Figure 8-19 Export

Export x

Download Template “ Cancel

Step 3 Select encryption or not.
e If you select Yes, the system exports encrypted .backup file. View this file with
IVSS.
e If you select No, the system exports .csv file, which can be opened with Excel.
The exported .csv file contains IP address, port number, channel number,
channel name, manufacturer and user name (excluding password) of the remote
device.

A\

When unencrypted file is exported, keep the file properly to avoid data leakage.
Step 4 Click OK.
The following prompt interface is displayed.
Step 5 Click Save.
File path might be different depending on interface operations. Refer to actual
interfaces.

e At IVSS client, click = , select Download content to view file saving path. For

details, see 10.3 View Downloads
e Select file saving path during local operation.

I-—-—-l

Connect USB device to IVSS if you are on the local menu to operate.
e During web operations, files are saved under default downloading path of the
browser.
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8.2.2.4 Connecting Remote Device

On the Device interface, view connection status of remote device in the device list. See

Figure 8-

20.

When the remote device name and icon is black, it means the remote device is online. For

example,

example,

e Righ
e Righ

8.2.2.5 Deleti

Onthe D
e Dele

&

<&
e Baitc

&

S SDTSA403  \When they are gray, it means the remote device is offline. For

& C2 824

t-click the offline device, select Connect to connect the device.
t-click the online device, select Disconnect to disconnect the device.
Figure 8-20 Device list

TPC

[F]] Access
& RTSP Media

ng Remote Device

evice interface, delete the registered remote device.
te one by one:

o

Select a remote device and then click @ to delete.

On the device list, right-click the remote device and then click Delete.
h delete:

Click , device list displays check box for you to select multiple remote devices.
Click @ to delete the selected devices.
On the device list, click one remote device, press Ctrl to select other remote devices

and then click @ to delete them.

On the device list, click one remote device, press Shift and then click another
remote device, it is to select all remote devices between these two, and then click

O to delete them.
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8.3 Network Management

Click or click on setting interface, select NETWORK. The NETWORK interface is

displayed. See Figure 8-21. You can set basic network parameters and application.
Figure 8-21 Network management

DNS Server Default NIC

8.3.1 Basic Network

It is to set basic network parameters of the device, such as IP address, port aggregation and
port number, to connect with other devices in the network.

8.3.1.1 Configuring IP Address

It is to set device IP address, DNS server information and other information according to
network planning.

L]

Device has 4 Ethernet ports by default. Make sure at least one Ethernet port has connected
to the network before you set IP address.

Step 1 Click or click on setting interface, and then select Network > Basic

Network > TCP/IPv4.
The TCP/IPv4 interface is displayed. See Figure 8-22.
L[]

Click “ to view the NIC parameter information.
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Figure 8-22 TCP/IPv4

NIC NIC Type Dhep 1P Address Subnet Mask Mac Speed

DNS Server Default NIC

BEx -
Step 2 Click L4 of the corresponding NIC.
The Edit Ethernet Network interface is displayed. See Figure 8-23.
Figure 8-23 Edit Ethernet network
Edit Ethernet Network?2 X
Speed 100 MbJs
Use Chynamic IP Address
(@  Use Static IF Address
Static IP Address 192 168 . 2 . 108
Subnet Mask 255 255 255 i
Gateway 192 i 148 ; 2 ; 1
MTU 1500 o
OK Cancel

Step 3 Set parameters. For details, refer to Table 8-7.

Table 8-7 TCP/IP parameters description

Parameter Description

Speed Current NIC max network transmission speed.

When there is a DHCP server on the network, check the box to use dynamic

Use dynamic IP . . )
IP address, system can allocate an dynamic IP address to the device. There is

address

no need to set IP address manually.
Use static IP Check the box to use static IP address. Set static IP address, subnet mask
address and gateway. It is to set a static IP address for the device.
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Parameter Description

Set NIC MTU value. The default setup is 1500 Byte.

We recommend you to check the MTU value of the gateway first and then set
the device MTU value equal to or smaller than the gateway value. It is to
reduce the packets slightly and enhance network transmission efficiency.

MTU :

Changing MTU value may result in NIC reboot, network offline and affect
current running operation. Please be careful!

Step 4 Click OK.
Go back to TCP/IPv4 interface.
Step 5 Set DNS server information.
You can select to get DNS server manually or input DNS server information.
L]
This step is compulsive if you want to use domain service.
e Check the box to auto get DNS server address, device can automatically get the
DNS server IP address on the network.
e Check the box to use the following DNS server addresses, and then input
primary DNS and alternate DNS IP address.
Step 6 Set default NIC.
Select default NIC from the dropdown list.

L]

Make sure the default NIC is online.
Step 7 Click Save.

8.3.1.2 Port Aggregation

It is to bond multiple NIC and create one logic NIC and use one IP address for peripheral
device. The bonded NIC can work as the specified aggregation mode to work. It enhances
network bandwidth and network reliability.

8.3.1.2.1 Binding NIC

System supports load balance, fault-tolerance, and link aggregation. Select bind mode
according to your actual requirements.

Step 1 Click or click on setting interface, and then select Network > Basic

Network > TCP/IPv4.
The TCP/IPv4 interface is displayed. See Figure 8-24.
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Figure 8-24 TCP/IPv4

1P Address

Default NIC

Default Ethernet Ethernet Networkl

Subnet Mask

Mac Speed Operate -

10M/100M/ 1000MSelf-Adaptive [F

10M/100MSelf-Ada

Step 2 Bind NIC card.
1) Click Port Aggregation.
The Port Aggregation interface is displayed. See Figure 8-25.
Figure 8-25 Port aggregation
Port Aggregation X
{0 Nic Dhep 1P Address Subnet Mask Gateway Mac Speed
Ethernet Networkl No 192.1681.108 25525500 19216811 3cef8c:39:23:46  10M/100MSelf-A
Ethernet Network2 No 192.168.2.108 255.255.2550 19216821 3cef:8c:39:23:47  10M/100MSelf-A
Ethernet Network3 No 192.168.3.108 2552552550 19216831 3cef8c:39:23:44 10M/100OMSelf-A
Ethernet Networkd No 1921684108 2552552550 19216841 3cef:8c:39:23:45  10M/100MSelf-A
Aggregation Mode O Load Balance Fault-Tolerance Link Aggregation
Cancel

2) Select the NIC you want to bind.

3) Select NIC aggregation mode. For details, see Table 8-8.

Table 8-8 Aggregation mode description

Aggregation

Description
mode P
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Aggregation
mode

Description

Load balance

Device has bonded several NICs at the same time and use one IP address to
communicate with the external device. The bonded NICs are working
together to bear the network load.
The load balance mode adds the network throughput data amount and
enhances network flexibility and availability. In this mode, the network is
offline once all NICs break down.

Fault-tolerance

In this mode, device has bonded several NICs and set one NIC as the master
card and the rest NICs are the alternative NICs. Usually, only the master NIC
card is working. System can automatically enable other alternate cards to
work when the master card breaks down.

Fault-tolerance is a network mode to enhance NIC reliability. In this mode,
the network is offline once all NICs break down.

Link
aggregation

Device has bonded several NICs and all NICs are working together to share
the network load. System allocates data to each NIC according to your
allocated strategy. Once the system detects that one NIC breaks down, it
stops sending data with this NIC, and then system transmits the data among
the rest NICs. System calculates transmission data again after
malfunctioning NIC resumes work.

In this mode, the network is offline once all bonded NICs are malfunctioning.

Make sure the switch supports link aggregation and you have set the link
aggregation mode.

4) Click Port Aggregation.
The Port Aggregation interface is displayed. See Figure 8-26, Figure 8-27 or

Figure 8-28.
Figure 8-26 Port aggregation (load balance)
Edit Load-Balance(Ethernet Network1+2) X
Speed 1100 Mb/s
Use Dynamic IP Address
O Use Static IP Address
Static IP Address 192 168 200 201
Subnet Mask 255 255 0 0
Gateway 192 168 0 1
MTU 1500 E)
NIC Mac Speed
Ethernet Network1 34:22:3d:da:32:22 10M/100M/1000MSelf-Adaptive
Ethernet Network2 34:22:3d:da:32:23 10M/100MSelf-Adaptive
m Cancel
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Figure 8-27 Port aggregation (fault-tolerance)

Edit Fault-Tolerance(Ethernet Network1+2)

Use Dynamic IP Address

@ Use Static IP Address

Static IP Address

Subnet Mask

Gateway

MTU

NIC

Ethernet Networkl

Ethernet Network2

Speed 1100 Mb/s

192

255

192

1500

168 i 200 . 201

255 5 0 X 0

168 3 0 A 1
Mac

34:22:3d:da:32:22

34:22:3d:da:32:23

Speed
10M/100M/1000MS elf-Adaptive

10M/100MSelf-Adaptive

e

Figure 8-28 Port aggregation (link aggregation)

Edit Linkage Aggregation(Ethernet Network1+2)

Use Dynamic IP Address

® Use Static IP Address

Static IP Address

Ethernet Network1

Ethemnet Network2

Speed 1100 Mb/s

192
Subnet Mask 255
Gateway 192
MTU 1500
NIC

168 200 . 201

255 5 0 : 0

168 ; 0 - 1
Mac

34:22:3d:da:32:22

34:22:3d:da:32:23

Speed
10M/100M/1000MSelf-Adaptive

10M/100MSelf-Adaptive

Cancel

5) Set parameters. For details, refer to Table 8-9.

Table 8-9 TCP/IP parameters description

Parameter

Description

Speed

Maximum network transmission speed of current NIC.
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Parameter Description
. When there is a DHCP server on the network, check the box to use
Use dynamic IP ) )
address dynamic IP address. System can allocate a dynamic IP address to the
device. There is no need to set IP address manually.
Use static IP Check the box to use static IP address. Set static IP address, subnet
address mask and gateway. It is to set a static IP address for the device.
Set NIC MTU value. The default setup is 1500 Byte.
We recommend you to check the MTU value of the gateway first and
then set the device MTU value equal to or smaller than the gateway
value. It is to reduce the packets slightly and enhance network
MTU transmission efficiency.
Changing MTU value may result in NIC reboot, network offline and affect
current running operation. Please be careful!
6) Click OK.

Go back to TCP/IPv4 interface.

Step 3 Click Save.

System pops up a confirmation box. See Figure 8-29.

Figure 8-29 Confirmation

x

Are you sure to continue and reboot the
device now?

Step 4 Click OK to save the configuration.
Auto Reboot The binding card information becomes activated after reboot operation.

8.3.1.2.2 Cancelling Binding NIC

It is to cancel port aggregation and allow the bonded NICs to work as independent card.

Step 1 Click or click on setting interface, and then select Network > Basic

Network > TCP/IPv4.
The TCP/IPv4 interface is displayed.
Step 2 Select bonded NIC.
System displays Split Port Aggregation interface. See Figure 8-30.
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Figure 8-30 TCP/IPv4

W etk Apos

Step 3 Click Split Port Aggregation.
System pops up confirmation interface.

Step 4 Click OK.
System splits the bonded NIC.
L]
After splitting NIC binding, the first NIC reserves the IP address configured during
binding, while the rest NICs restore default IP addresses.

8.3.1.3 Setting Port Number

It is to set device port number.

Step 1 Click . or click on setting interface, and then select Network > Basic

Network > Port.
The Port interface is displayed. See Figure 8-31.
Figure 8-31 Port

RTSP Format
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Step 2 Set parameters. For details, refer to Table 8-10.

N

Login again after modifying parameters, except Max Connection.

Table 8-10 Connection setting parameters description

Parameter Description
Max The allowable maximum clients accessing the Device at the same time,
) such as WEB, IVSS client, and Platform. Select a value between 1 and 128.
Connection N
The default value setting is 20.
TCP Port Set according to the actual requirements. The default value is 37777. The
value ranges from 1025 to 65535.
Set according to the actual requirements. The default value is 554. The
RTSP Port
value ranges from 1 to 65535.
Set according to the actual requirements. The default value is 80. The value
ranges from 1 to 65535.
HTTP Port i
If the value you set is not 80, please add the port number after the IP
address when you are using browser to login the device.
Set according to the actual requirements. The default value is 443. The
HTTPS Port
value ranges from 1 to 65535.
UDP Port Set according to the actual requirements. The default value is 37778. The
value ranges from 1025 to 65535.

Step 3 Click Save.

System reboots corresponding service of the port.

8.3.2 Network Apps

It is to set device network parameters, so that system can connect to other devices.

8.3.2.1 P2P

P2P is a peer to peer technology. You can scan the QR code to download cellphone APP
without DDNS service or the port mapping or installing the transmission server. After register
the device to the APP, you can view the remote video, playback record file and so on.

L

e Make sure the system has connected to the network. Otherwise, the P2P function is null.

e When using the P2P function, we will collect device information such as IP address,
MAC address, name and serial number. The collected information is only used for
remote access.

Step 1 Click , or click on setting interface, and then select Network > Network

Apps> P2P.
The P2P interface is displayed. See Figure 8-32. Scan the QR code on the actual

interface.
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Figure 8-32 P2P

NETWORK +
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B Network Apps ~
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Step 2 Click E. to enable P2P function.

Step 3 Click Save.
After the configuration, you can register a device to the APP to view remote video,
playback record file, and so on. Refer to corresponding cellphone APP for detailed
information.

I-—-—-l

After successfully connected to the P2P, the status displayed as Success.

8.3.2.2 DDNS

After setting DDNS parameters, when IP address of IVSS changes frequently, the system
dynamically updates the relation between domain name and IP address on DNS server. You
can use domain name to remotely access IVSS, without need to note down IP address.

Preparation

Confirm whether IVSS supports the DDNS Type and log in the website provided by the DDNS
service provider to register the information such as domain from PC located in the WAN.

L.—_.l

After you have registered and logged in the DDNS website successfully, you can view the
information of all the connected devices under this user name.

Procedure

Step 1 Click , or click on setting interface, and then select Network > Basic

Network > DDNS.
The DDNS interface is displayed. See Figure 8-33.
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Figure 8-33 DDNS

Enable [m |

DDNS Type CN99 DDNS

After enabling DDNS function, third-party server may collect your device info.

Step 2 Click E. to enable DDNS function.

I-—-—-l

After enabling DDNS function, the third-party server might collect your device
information. Pay attention to privacy security.
Step 3 Set the corresponding parameters. For details, see Table 8-11.

Table 8-11 DDNS setting parameters description

Parameter Description

Name and address of DDNS service provider.
DDNS Type

e Dyndns DDNS: members.dyndns.org

e NO-IP DDNS: dynupdate.no-ip.com
Server IP

e CN99 DDNS: members.3322.0rg

Domain Name

The domain name for registering on the website of DDNS service provider.

Username

Password

Enter the user name and password obtained from DDNS service provider. You
need to register (including user name and password) on the website of DDNS
service provider.

Update circle

Enter the amount of time that you want to update the DDNS.

Current WAN IP

Displays the WAN IP address of IVSS.

Status

Displays DDNS registration result or update status.

Step 4 Click Save.
After successful configuration, enter domain name in address bar of the browser or
IVSS client, and press Enter key to access the IVSS.

8.3.2.3 Configuring Email Settings

Configure email information, and enable alarm linkage Email. When NVR has alarm events,
the system automatically sends Email to the user.

Step 1 Click , or click on setting interface, and then select Network >Network Apps >

Email.
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The Email interface is displayed. See Figure 8-34.
Figure 8-34 Configuring Emalil

¥ SMTP Server

Enable [m |

v TEST

Step 2 Click [l to enable Email function.
Step 3 Set parameters. For details, refer to Table 8-12.

Table 8-12 EMAIL parameter description

Parameter Description
Email Server | Select Email server type, including Customize, Gmail, Hotmail, and Yahoo.
Server . .
Enter Email server address. For details, see Table 8-13.
Address
i Select encryption type of Email server, including NONE, SSL, and TLS. For
Encryption .
details, see Table 8-13.
Port Enter the port number of Email server. For details, see Table 8-13.
User name . . .
and Enter the configured user name and password of Email server. For details, see
Table 8-13.
password
Table 8-13 Common Email parameters
Email . . .
type Email Server | Encryption | Port Description

e Do not select NONE for encryption.

e The mailbox must have applied
SMTP service.

e The password must be an
"authorized password". Both the QQ

QQ smtp.qg.com | SSL 465 login password and email login
password are invalid.

(|

Obtain the authorized password when
your mailbox is applying for SMTP
service.

163 smtp.163.com | SSL 465/994 | ¢ The mailbox must have applied
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Email . . o
Email Server | Encryption | Port Description
type
TLS 25 SMTP service.
e The password must be an
"authorized password”. The email
login password is invalid.
NONE 25 I
Obtain the authorized password when
your mailbox is applying for SMTP
service.
The mailbox must have applied SMTP
126 smtp.126.com | NONE 25 service.

Step 4 Add the information of mail receiver.
1) Click Add.
The Add interface is displayed.
2) Enter a receiver’ Email address. See Figure 8-35.
Figure 8-35 Email address

B

3) Click Add or * o add other receivers’ Email address.

.

e Click @ to delete the added receiver.

e Select a receiver. The Delete button is displayed. Click Delete button to
delete the selected receiver.
Step 5 Click Save.
Step 6 (Optional) Test the email sending function.
1) In Test Mail, select or enter a receiver’s Email address.
2) Click Send.
e When the configuration is correct, the system pops up a message of
success, and the receiver will receive the test mail.
e Otherwise, the system pops up a message of failure, and the receiver will
not receive the test mail.

8.3.2.4 Register

Register is to register the device on designated proxy server, and client software visits the
device through the proxy server.

Step 1 Click , or click on setting interface, and then select Network > Network

Apps > Register.
The REGISTER interface is displayed. See Figure 8-36.
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Figure 8-36 Register

Server

Step 2 Click - to enable register function.
Step 3 Set parameters. For details, refer to Table 8-14.

Table 8-14 Register

Parameter | Description

IP Type Select IP address of server for register.
Server In the Server box, enter the IP address of server for register.
Port Enter the port number of the server for register.

Enter Device ID to identify IVSS uniquely. Device ID shall be consistent with

Device ID i )
server configuration.

Step 4 Click Save.

8.4 Event Management

Click . or click on setting interface, select EVENT. The EVENT interface is displayed.
See Figure 8-37.

On the interface, configure alarm event, including alarm event of IVSS and remote device.

e Select root node in the device tree on the left to set IVSS alarm event. Refer to "8.4.2
Local Device" for detailed information.

e Select remote device in the device tree on the left, to set alarm event of this remote
device. Refer to "8.4.3 Remote Device" for detailed information.

e The alarm event might be different depending on the model you purchased. The actual
interface shall prevail.

e “ inthe right of alarm event means that this alarm event has been enabled.
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e " inthe right of Al detection means that Al by camera has been enabled; = means

that Al by device has been enabled; ™I means that both have been enabled.

Figure 8-37 Event management

Abnormal Event

Device Offfine.

AlPln

8.4.1 Alarm Actions

System can trigger the corresponding actions when an alarm occurs.

L.—_.l

The supported actions might be different depending on the model you purchased. The actual
interface shall prevail.

On the alarm configuration interface, click Actions to display actions. See Figure 8-38. Refer
to Table 8-15 for detailed information. Configure actions according to your actual need.
e After setting actions, click Save on the interface.

e After enabling actions, click X {0 disable the corresponding actions.
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Figure 8-38 Actions

+ Actions

Record
Snap
Buzzer
Log
Email
Preset
Local Alarm...
IFC Alarm ...
Access

Voice Prompt

Table 8-15 Actions description

Actions Description Preparation
, Remote device, such as IPC,
The system links the selected remote
, .| has been added. Refer to
Record device to record when there is ) )
i "5.4.2 Adding Remote Device"
corresponding alarm event. - )
for detailed information.
The system links the selected remote
Snapshot device to snapshot when there is| -
corresponding alarm event.
Buzzer The system activates a buzzer alarm when
there is corresponding alarm event.
The system notes down the alarm
Log information in the log when there is
corresponding alarm event.
) Email configuration has been
The system sends alarm Email to all added g .
) ) ) ) completed. Refer to "8.3.2.3
Email receivers when there is corresponding . _ o
Configuring Email Settings" for
alarm event. L .
detailed information.
) PTZ device has been added,
The system links the selected remote .
i ) and preset point has been
device to rotate to the designated preset i
Preset ) , ) added. Refer to "5.4.2 Adding
point when there is corresponding alarm ) i
Remote Device" for detailed
event. . .
information.
When there is an alarm, system can trigger ) )
Local Alarm ) i IVSS is connected with alarm
the corresponding device to generate )
Output output device.

alarm.
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Actions Description Preparation

IPC has been added, and IPC

IPC Alarm When there is an alarm, system can trigger | is connected with alarm output

Output the corresponding device to generate | device. Refer to "5.4.2 Adding

Settings alarm. Remote Device" for detailed
information.

When there is an alarm, system can trigger | Refer to "5.4.2 Adding Remote

Access the corresponding access control device to | Device" for detailed
open door and close door. information.

Audio function has been

, configured. Refer to "8.8.5
When there is an alarm, system can play

Voice Prompt Enablin \oice Manage
P the selected audio file. i g _g
Function" for detailed

information.

8.4.1.1 Record

Enable record control function. The system links the selected remote device to record when
there is corresponding alarm event.
L]
Make sure the remote device, such as IPC, has been added. Refer to "5.4.2 Adding Remote
Device" for detailed information.
Step 1 Click Actions and select Record.

The record setting interface is displayed. See Figure 8-39.

Figure 8-39 Record

¥ Record | IPC x®

+ Actior

Step 2 Select a remote device.
Step 3 (Optional) Repeat Step 1-Step 2, and link multiple remote devices to record.

8.4.1.2 IPC Alarm Out

The system links the selected remote device to snapshot when there is corresponding alarm
event.

Click Actions and select IPC Alarm Out to enable this function. See Figure 8-40.

L1

Only remote device supports this function, and only the current remote device can be linked

to snapshot.
Figure 8-40 IPC alarm out

¥ Snap | IPC X
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8.4.1.3 Buzzer

The system activates a buzzer alarm when there is corresponding alarm event.

Click Actions and select Buzzer to enable this function. See Figure 8-41.
Figure 8-41 Buzzer

8.4.1.4 Log

Enable the log function. The system notes down the alarm information in the log when there
is corresponding alarm event.

Click Actions and select Log to enable this function. See Figure 8-42.
Figure 8-42 Log

Log | Enable

+ Actior

I._.—_.l

When log function is enabled, after an alarm is triggered, click on LIVE interface, select

Maintain > Log > Event.

8.4.1.5 Email

Enable Email function. The system sends alarm email to all added receivers when there is
corresponding alarm event.

L]

Make sure the Email configuration has been completed. Refer to 8.3.2.3 Configuring Email
Settings for detailed information.

Click Actions and select Email to enable this function. See Figure 8-43.
Figure 8-43 Email

Email | Enable

8.4.1.6 Preset

Set preset point function. The system links the selected remote device to rotate to the
designated preset point when there is corresponding alarm event.
[
Make sure the PTZ device has been added, and preset point has been added. Refer to "5.4.2
Adding Remote Device" for detailed information.
Step 1 Click Actions and select Preset.

The Preset interface is displayed. See Figure 8-44.
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Figure 8-44 Preset

¥ Preset|IP PTZ Camera | 1

Device 1P PTZ Camera -

+ Actio

Step 2 Select PTZ device, and enter preset point number.
Step 3 (Optional) Repeat Step 1-Step 2, and link multiple PTZ devices to turn to designated

preset points.

8.4.1.7 Local Alarm Out

Set local alarm output. System can trigger the corresponding alarm event when an alarm
occurs.
[
Make sure IVSS is connected with alarm output device.
Step 1 Click Actions and select Local Alarm Out.
The Local Alarm Out interface is displayed. See Figure 8-45.
Figure 8-45 Local alarm out

% Local Alarm Out | Output Portl

Step 2 Select alarm output port.
Support to select multiple alarm output ports.

Step 3 Set delay time.
Set a delay time. After alarm event is ended, alarm will end after the delay time. You

can configure from 0 seconds through 300 seconds, and the default value is 10
seconds.

8.4.1.8 IPC Alarm Out

Set IPC alarm output. System can trigger the corresponding alarm output device when an
alarm occurs.
[
Make sure the IPC has been added, and IPC is connected with alarm output device. Refer to
"5.4.2 Adding Remote Device" for detailed information.
Step 1 Click Actions and select IPC Alarm Out.

The IPC Alarm Out interface is displayed. See Figure 8-46.

Figure 8-46 IPC alarm output settings

w7 IPC Alarm Out | Output Port1
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Step 2 Select IPC and alarm output port.
Support to select multiple alarm output ports.
Step 3 (Optional) Repeat Step 1-Step 2, and link multiple IPC alarm output devices.

8.4.1.9 Access

Set access control function. When there is an alarm, system can trigger the corresponding
access control device to open door and close door.

I_,_,J

Make sure that access control device has been added. Refer to "5.4.2 Adding Remote
Device" for detailed information.
Step 1 Click Actions and select Access.
The Access setting interface is displayed. See Figure 8-47.
Figure 8-47 Access

Step 2 Select access control device.

L1]

Not all models support this function. The actual interface shall prevail.
Step 3 (Optional) Repeat Step 1-Step 2, and link multiple access control devices.

8.4.1.10 Voice Prompt

Set voice prompt function. When there is an alarm, system can play the selected audio file.
(1]
Make sure the voice function has been configured. Refer to "8.8.5 Enabling Voice Manage
Function" for detailed information.
Step 1 Click Actions and select Voice Prompt.
The Voice Prompt interface is displayed. See Figure 8-48.
Figure 8-48 Voice prompt

Step 2 In the File Name list, select the audio file that you want to play for this configured
period.
Step 3 Set delay time.

e Playtimes: Select Play Times and enter the times to play the file. After the alarm
event is ended, system will continue to play the voice file according to the play
times.

e Duration: Select Duration and enter the delayed play duration. After the alarm
event is ended, system will continue to play the voice file according to the
duration.
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8.4.2 Local Device

Set IVSS alarm event, including abnormal event, device offline alarm, Al plan, and local

device alarm.

8.4.2.1 Abnormal Event

It is to set alarm mode when an abnormal event occurs.

Name

IVSS supports HDD, storage error, network, Al module, fan and power fault alarm. For details,

see Table 8-16.

Table 8-16 Abnormal event description

Name Description

No HDD System triggers an alarm when there is no HDD. It is enabled by default.
System triggers an alarm when the HDD or the RAID has error. It is enabled

Storage error
by default.

Storage full System triggers an alarm when HDD space is full. It is disabled by default.

P conflict System triggers an alarm when its IP address conflicts with IP address of
other device in the same LAN. It is enabled by default.

MAC conflict System triggers an alarm when its MAC address conflicts with MAC address
of other device in the same LAN. It is enabled by default.
System triggers an alarm when an account login error has reached the
threshold. At the same time, system locks current account. It is disabled by
default.

Lock in m
Go to the Security interface to set account error threshold. Refer to "8.6.3
Safety Protection" for detailed information.

Al module When Al module temperature is higher than the specified value, system

temp triggers an alarm. It is enabled by default.

Al module When Al module and system is disconnected, system triggers an alarm. It is

offline enabled by default.

Fan speed When IVSS fan speed is abnormal, system triggers an alarm. It is enabled by

alarm default.

Power fault When IVSS power supply is abnormal, system triggers an alarm. It is disabled
by default.

Operation Steps

I._.—_.l

Here we use Al module temp for example. For other events, the setting steps are similar.
Refer to the actual interface for detailed information.

Step 1 Click , or click on setting interface, and then select Event.
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The Event interface is displayed.
Step 2 Select root node on the left list.
Step 3 Select Abnormal Event > Al Module TEMP.
The Al Module TEMP interface is displayed. See Figure 8-49.
Figure 8-49 Al module temp
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Step 4 Click - to enable Al module temperature alarm function.

L ]

Step 5 Drag to set alarm temperature threshold.

LL]
The above step is for Al module temperature alarm only.

Step 6 Click Actions to set alarm actions. Refer to "8.4.1 Alarm Actions" for detailed
information.

Step 7 Click Save.

8.4.2.2 Offline Alarm

Set IVSS network offline alarm. If you have not set offline alarm for a specified remote device,
once the remote device is disconnect from the system, system adopts alarm strategy of IVSS
to trigger an alarm.

Step 1 Click . or click on setting interface, and then select EVENT.

The EVENT interface is displayed.
Step 2 Select root node on the left list.
Step 3 Select Device Offline > Device Offline.
The Device Offline interface is displayed. See Figure 8-50.
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Figure 8-50 Network offline

Step 4 Click E. to enable device offline alarm.

Step 5 Click Deployment Time to select schedule from the drop-down list.
After setting deployment period, system triggers corresponding operations when
there is a motion detection alarm in the specified period.
e Click View Schedule to view detailed schedule settings.
e |f the schedule is not added or the added schedule does not meet actual needs,

click Add Schedule. Refer to "8.8.4 Schedule" for detailed information.

Step 6 Click Actions to set alarm actions. Refer to "8.4.1 Alarm Actions" for detailed
information.

Step 7 Click Save.

8.4.2.3 Configuring Al Plan

Configure Al detection result display strategy of IVSS. If you have not set Al display settings
for current remote device, the remote device inherits Al display mode of IVSS.

8.4.2.3.1 Viewing Al Plan
After adding remote device, on IVSS, obtain Al detection type and status of the remote
device.

On the EVENT interface, select root node on the left device tree. Select Al Plan > Al Plan >
Al Plan. The Al Plan interface is displayed. See Figure 8-51.

After installing the Al module, and the remote device supports Al detection, and you have
enabled the Al detection function, you can view channel name of the remote device on the
corresponding Al detection panel.
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Figure 8-51 Al plan

Al Plan Al Display

8.4.2.3.2 Setting Al Display

Set the attribute that shall be displayed in rule box and feature attribute panel. View Al
detection result through smart preview, and support to display face, human and vehicle.

Step 1 Click , or click on setting interface, and then select EVENT.

The EVENT interface is displayed.
Step 2 Select root node on the left device tree.
Step 3 Select Al Plan > Al Plan > Al Display > Face, or select Al Plan > Al Plan > Al
Display > Human.
The Face or Human interface is displayed. See Figure 8-52 or Figure 8-53.
Figure 8-52 Face
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Figure 8-53 Human

Step 4 Configure display filter information.
After setting filter criteria, only the qualified detection result will be displayed. For
example, enable Age, and then select youth from the drop-down list. The tracking box
and the features panel only display the human face of the youth age.

1) Click - to enable corresponding filter type.

2) ltisto set display filter criteria.

Click O to set the filter color.

Step 5 Click - in the right of Show Tracking Box to enable.

After enabled, when the system detects face or human, tracking box will be shown
beside the face or human in the view window. See Figure 8-54.
Figure 8-54 Tracking box
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Step 6 Click - in the right of Features Panel to enable, and select the features that

shall be displayed on the Live interface.
After enabled, there is a features panel on the right side of the view window. See
Figure 8-55.

e Drag to adjust features panel transparency. The higher the value, the more

transparent the features panel.
e System supports maximum 4 features. System has checked four features by
default. To select other features, cancel the selected features, and then select

the ones you need.
e Click to display the features panel on the LIVE interface, including face
detection panel, stranger panel and face DB panel.
Figure 8-55 Features panel
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Step 7 Click Save.

8.4.2.4 Configuring Device Alarm

Set device alarm. When alarm input device sends an alarm signal to IVSS, an alarm is
triggered.

Preparation

IVSS is connected with alarm input device.

Operation Steps

IVSS supports 16-channel alarm input. Configure according to actual port of alarm input
device. Take ALARML1 port connection for example.
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Step 1 Click , or click on setting interface, and then select EVENT.

The EVENT interface is displayed.
Step 2 Select root node on the left device tree.
Step 3 Select Device Alarm > |O1.
The 101 interface is displayed. See Figure 8-56.
Figure 8-56 101
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Step 4 Click - to enable local alarm.
Step 5 Set parameters. For details, refer to Table 8-17.

Table 8-17 Local alarm parameters description

Parameter Description

Name In the Alarm name box, enter a name for the alarm.

Type Select alarm input device type. Both NO and NC are supported.
Debouncing The system records only one event during this period.

Step 6 Click Deployment Time to select schedule from the drop-down list.
After setting deployment period, system triggers corresponding operations when
there is a motion detection alarm in the specified period.
e Click View Schedule to view detailed schedule settings.
e If the schedule is not added or the added schedule does not meet actual needs,

click Add Schedule. Refer to "8.8.4 Schedule" for detailed information.

Step 7 Click Actions to set alarm actions. Refer to "8.4.1 Alarm Actions" for detailed
information.

Step 8 Click Save.

8.4.3 Remote Device

Set alarm actions of remote device, including video detection alarm, offline alarm and Al plan
of remote device.
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The parameters might be different depending on the model you purchased. The actual
interface shall prevail.

8.4.3.1 Video Detect

Video detection function adopts the PC visual, image and graphical processing technology to
analyze the video image and check there is considerable changes on the video. Once there is
considerable video changes (such as there is any moving object, or the video is blurred),
system triggers corresponding alarm event.

8.4.3.1.1 Configuring Video Motion

After analyzing video, system can generate a video motion alarm when the detected moving
target reaches the sensitivity you set here.

1*-"‘- . . .
Step 1 Click , or click on setting interface, and then select EVENT.

The EVENT interface is displayed.
Step 2 Select remote device in the device tree on the left.
Step 3 Select Video Detect > Video Motion.
The Video Motion interface is displayed. See Figure 8-57.
Figure 8-57 Video motion

Bl -
Step 4 Click - to enable video motion detection.
Step 5 Set parameters. For details, refer to Table 8-18.
Table 8-18 Motion detect parameters description
Parameter Description
Debouncing System only records one alarm event during the debouncing period.
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Parameter Description

After enabling exclude PTZ control, system does not trigger an alarm when you
Exclude PTZ are manually control the PTZ.

control m

Itis for PTZ camera only.

Step 6 Set motion detection region.
System supports maximum four detection zones. After setting, once there is an alarm
from any of these four zones, the remote device trigger an alarm.

1) Click motion detection zone icon 'Q' @ ﬁ
2) On the surveillance video, press and hold on the left button of mouse to select

detection zone.
e Select the motion detect zone you have drawn. Click X to delete the

zone.

o

e Click @ toclear the zone you have drawn.

3) Set parameters. For details, refer to Table 8-19.

Table 8-19 Description of zone parameters

Parameter Description

Name It is to set detection zone name to distinguish different zones.

Drag '®" to set sensitivity.

Sensitivity The higher the sensitivity is, the easier it is to trigger an alarm. At the same
time, the false alarm rate increases as well. Usually we recommend the default
value.

Drag "* 1o adjust threshold.

Once the detected percentage (the percentage of target to detection zone) is
equivalent to or larger than the specified threshold, system triggers alarm. For
example, the threshold is 10. Once the detected target occupies the 10% of the
detection zone, system triggers an alarm.

Threshold

Step 7 Click Deployment Time to select schedule from the drop-down list.
After setting deployment period, system triggers corresponding operations when
there is a motion detection alarm in the specified period.
e Click View Schedule to view detailed schedule settings.
e If the schedule is not added or the added schedule does not meet actual needs,

click Add Schedule. Refer to "8.8.4 Schedule" for detailed information.

Step 8 Click Actions to set alarm actions. Refer to "8.4.1 Alarm Actions" for detailed
information.

Step 9 Click Save.

8.4.3.1.2 Tampering

Once something tampers the surveillance video, and the output video is in one color, the
system can generate an alarm.
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Step 1 Click , or click on setting interface, and then select EVENT.

The EVENT interface is displayed.
Step 2 Select remote device in the device tree on the left.
Step 3 Select Video Detect > Tampering.
The Tampering interface is displayed. See Figure 8-58.
Figure 8-58 Tampering

Step 4 Click - to enable tampering alarm.

Step 5 Click Deployment Time to select schedule from the drop-down list.
After setting deployment period, system triggers corresponding operations when
there is a motion detection alarm in the specified period.
e Click View Schedule to view detailed schedule settings.
e |f the schedule is not added or the added schedule does not meet actual needs,

click Add Schedule. Refer to "8.8.4 Schedule" for detailed information.

Step 6 Click Actions to set alarm actions. Refer to "8.4.1 Alarm Actions" for detailed
information.

Step 7 Click Save.

8.4.3.2 Offline Alarm

When the remote device and the IVSS is disconnected, system can trigger an alarm.

Step 1 Click , or click on setting interface, and then select EVENT.

The EVENT interface is displayed.
Step 2 Select remote device in the device tree on the left.
Step 3 Select IPC Offline > IPC Offline.

The IPC Offline interface is displayed. See Figure 8-59.
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Figure 8-59 IPC offline

Step 4 Click E. to enable IPC offline alarm.
LL]

The IPC offline alarm is enabled by default. You can skip this step.

Step 5 Click Deployment Time to select schedule from the drop-down list.
After setting deployment period, system triggers corresponding operations when
there is a motion detection alarm in the specified period.
e Click View Schedule to view detailed schedule settings.
e If the schedule is not added or the added schedule does not meet actual needs,

click Add Schedule. Refer to "8.8.4 Schedule" for detailed information.

Step 6 Click Actions to set alarm actions. Refer to "8.4.1 Alarm Actions" for detailed
information.

Step 7 Click Save.

8.5 Storage Management

Click or click on setting interface, select Storage. The Storage interface is

displayed. See Figure 8-60. Manage storage resources (such as recording file) and space, so
you can use and improve utilization ratio of storage space.

I—vJ

The system supports pre-check and routine inspection function, displays health status on the

Storage interface, so you obtain real-time status of device and avoid data loss.

e Pre-check: during device operation, the system automatically detects disc status in case
of change (reboot, insert and pull the disc).

e Routine inspection: the system carries out routine inspection of the disc continuously.
During device operation, the disc may go wrong due to service life, environment and
other factors. Find out any problems during routine inspection.

System Configuration 217



Figure 8-60 Storage management

= STORAGE -
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8.5.1 HDD

The physical HDD refers to the HDD installed on the system. On this interface, you can view
HDD space (free spacef/total space), temperature (centigrade/Fahrenheit), HDD information
and so on.

Click , or click on setting interface, and then select Storage > HDD. The HDD

interface is displayed. See Figure 8-61. There is a corresponding icon near the HDD name
after you create the RAID and hot spare HDD.

e f®.RAIDHDD.

Bl
e ™ : Global hot spare HDD.
o

I—vJ

Slight difference may be found on the user interface. The actual interface shall prevail.

: Invalid private hot spare HDD.
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Figure 8-61 HDD
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8.5.1.1 View SM.A.R.T

S.M.A.R.T is so called Self-Monitoring Analysis and Reporting Technology. It is a technical
standard to check HDD drive status and report potential problems. System monitors the HDD
running status and compares with the specified safety value. Once the monitor status is
higher than the specified value, system displays alarm information to guarantee HDD data
security.

L1
Check one HDD to view S.M.A.R.T information at one time.

On the HDD interface, select a HDD, and then click S.M.A.R.T. The S.M.A.R.T interface is
displayed. See Figure 8-62. Check whether the HDD status is OK or not. If there is any
problem, fix it in time.
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Figure 8-62 S.M.A.R.T
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8.5.1.2 Set storage strategy

It is to set storage strategy when HDD space is full.

Step 1 Click , or click on setting interface, and then select Storage > HDD.

The HDD interface is displayed.
Step 2 Click Storage Strategy.
The Storage Strategy interface is displayed. See Figure 8-63.
Figure 8-63 Set storage strategy

Set Storage Strategy x

HCC full @ Ovenwrite Stop

==

Step 3 Set storage strategy.

e Overwrite: When HDD free space is less than 50G or it is less than 1% of the
total space, which one it is larger, system continues to record and begins
overwriting the oldest record file.

e Stop: When HDD free space is less than 50G or it is less than 1% of the total
space, which one it is larger, system stops recording.

Step 4 Click OK to save the configuration.
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8.5.1.3 HDD Clearup

After the HDD is working for a period time, since it is repeatedly written or files are deleted,
the files are saved on the discontinued physical position on the HDD. It may result in too
much HDD fragmentation and slow down the HDD access speed. The HDD cleanup is to
organize the fragmentation files on the HDD and make the fragmentation files become the
continuous files. It can enhance HDD whole performance and running speed.

A\

HDD cleanup may result in some record file loss.

Step 1 Click , or click on setting interface, and then select Storage > HDD.

The HDD interface is displayed.
Step 2 Select one and more HDD(s) and then click HDD Optimization.
The Set Defragmentation Strategy is displayed. See Figure 8-64.
Figure 8-64 Set defragmentation strategy

Set Defragmentation Strategy X

Strategy Speed First r 2

Cancel

Step 3 Select HDD defragmentation strategy.
e Speed first: Cleanup HDD at fast speed. The max speed is 100M/s.
e Business first: System automatically adjusts HDD Cleanup speed according to
current business load status.
Step 4 Click OK.
The following prompt interface is displayed.
Figure 8-65 Prompt interface

Fragments cleanup may result in record file
loss, are wou sure to continue?

CHE Cancel

Step 5 Click OK.
System begins clearing up HDD. Now the HDD status displays as "Cleanup"”. After
the HDD Cleanup, status becomes "Running".
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8.5.1.4 Format

A\

The format HDD operation is going to clear all data on the HDD. Be careful!

Enter HDD interface, select one or more HDD(s), and click Format. It is to format the
selected HDD.

8.5.1.5 File system repair

Once you cannot mount the HDD or you cannot properly use the HDD, you can try to use
repair file system function to fix.

Enter HDD interface, select one or more HDD(s) you cannot mount, and click File System
Repair, you can repair the selected file system of the corresponding HDD(s). The repaired
HDD can work properly or to be mounted.

8.5.2 RAID

RAID (Redundant Array of Independent Disks) is a data storage virtualization technology that

combines multiple physical HDD components into a single logical unit for the purposes of

data redundancy, performance improvement, or both.

[

e Right now, device supports RAID 0, RAID 1, RAID 5, RAID 6, and RAID 10. Refer to
"Appendix 2 RAID" for detailed information.

e |t is recommended to use enterprise HDD when you are creating RAID. It is
recommended to use surveillance HDD in case of one HDD.

8.5.2.1 Create RAID

RAID has different levels such as RAID 5, RAID 6 and so on. Different RAID levels have
different data protection, data availability and performance levels. Create RAID according to
your actual requirements.

A\

Creating RAID operation is going to clear all data on these HDD. Be careful!

Shortcut menu to create RAID

Shortcut menu to create RAID 5. To create RAID 5 with shortcut menu, the system adopts
different creation strategies according to disc quantity. For details, see Table 8-20.

I._.—_.l

In the following table, among the numbers in the creation strategy, the number without ()
represents the disk number of the RAID group. The number with () represents the number of
hot spare disks. For example, for 24 HDD, the creation strategy is 7+7+9+(1). It means three
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RAID 5 and one hot spare, and each RAID 5 respectively contains 7 disks, 7 disks and 9
disks.

Table 8-20 Shortcut menu to create RAID

HDD No. Creation Strategy HDD No. Creation Strategy
3 Not recommended 14 6+7+(1)

4 Not recommended 15 7+7+(1)

5 5 16 5+5+5+(1)
6 5+(1) 17 5+5+6+(1)
7 6+(1) 18 5+6+6+(1)
8 7+(1) 19 6+6+6+(1)
9 8+(1) 20 6+6+7+(1)
10 9+(1) 21 6+7+7+(1)
11 5+5+(1) 22 T+7+7+(1)
12 5+6+(1) 23 7+7+8+(1)
13 6+6+(1) 24 7+7+9+(1)

Create RAID

Step 1 Click , or click on setting interface, and then select Storage > RAID > RAID.

The RAID interface is displayed. See Figure 8-66.
Figure 8-66 RAID (1)

& RAID = Hotspare

vice v Name Space RAID Type Working Mode State \

Step 2 Click Add.
The Create RAID interface is displayed. See Figure 8-67.
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Figure 8-67 Create RAID (1)
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Step 3 Set RAID parameters.
Select RAID creation type according to actual situation. It includes Manual RAID and

Auto RAID.
e Manual RAID: System creates a specified RAID type according to the selected
HDD amount.

1. Select Manual RAID.
2. Select HDD you want to use.
3. Set parameters. For details, refer to Table 8-21.

Table 8-21 Manual creation parameters description

Parameter | Description
It is to select storage device of the HDD and select the HDD you want to add to the
RAID.
Storage L.._!|
Device
Different RAID types need different HDD amounts, and the actual situation shall
prevail.
RAID Select a RAID type you want to create.
It is to set RAID resources allocation mode. The default setup is self-adaptive.
e Self-adaptive means the system can automatically adjust RAID synchronization
speed according to current business load. When there is no external business,
Working the synchronization speed is at high speed. When there is external business,
mode the synchronization speed is at low speed.
e Sync first: Allocate resources to RAID synchronization first.
e Business first: Allocate resources to business first.
e |oad-Balance: Allocate resources to business and RAID synchronization
equally.
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Parameter | Description

Name It is to set RAID name.

e Auto: System creates RAID 5 according to the HDD amount.
1. Select Auto.
The Auto interface is displayed. See Figure 8-68.
Figure 8-68 Create RAID (2)
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2. Set parameters. For details, refer to Table 8-21.

Table 8-22 Auto parameters description

Parameter | Description

Storage ) .
. It is to select storage device of the HDD.
Device
It is to set RAID resources allocation mode. The default setup is self-adaptive.
e Self-adaptive means the system can automatically adjust RAID synchronization
speed according to current business load. When there is no external business,
Worki the synchronization speed is at high speed. When there is external business,
orkin
g the synchronization speed is at low speed.
mode

e  Sync first: Allocate resources to RAID synchronization first.

e Business first: Allocate resources to business first.

e Load-Balance: Allocate resources to business and RAID synchronization
equally.

Step 4 Click Next button.
The Confirm Info interface is displayed. See Figure 8-69 or Figure 8-70.
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Figure 8-69 Confirm info (manual)
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Figure 8-70 Confirm info (Auto)
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Step 5 Confirm info.
LL]

If the input information is wrong, click Back to set RAID parameters again.

Step 6 Click Create.

System begins to create RAID. It displays RAID information after creation. See

Figure 8-71.

Figure 8-71 RAID (2)

Working Mode. st

Operation

After creating RAID, view RAID disk status and details, clear up RAID, and repair file system.

For details, see Table 8-23.

Table 8-23 RAID operation
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Name

Operation

View RAID HDD
status

Click * atthe right side of the RAID name to open the RAID HDD list. It is

to view RAID HDD space, status and so on.

View RAID detail

Click "1t displays detailed information. See Figure 8-72. It is to view RAID

detailed information.

RAID Clearup

Enter RAID interface and then select one or more RAID, click HDD Cleanup. It
is to Cleanup HDD and files. Refer to "8.5.1.3 HDD for detailed information.

File system repair

Once you cannot mount the RAID or you cannot properly use the RAID, you
can try to use repair file system function to fix.

Enter RAID interface, select one or more RAID(S) you cannot mount, click File
System Repair, you can repair the selected file system of the corresponding
RAID(s). The repaired RAID can work properly or to be mounted.

A\

Formatting RAID is to clear all data on the RAID and cancel the RAID group.

Format RAID
Please be careful.
Enter RAID interface, select one and more RAID groups. Click Format to
format the selected RAID.

Delete RAID Deleting RAID is to clear all data on the RAID and cancel the RAID group.

Please be careful.
Enter RAID interface, select one and more RAID groups. Click Delete to
delete the selected RAID.

Figure 8-72 RAID detail
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8.5.2.2 Create Hot spare HDD

When a HDD of the RAID group is malfunctioning or has a problem, the hot spare HDD can
replace the malfunctioning HDD. There is no risk of data loss and it can guarantee storage

system reliability.

Step 1 Click , or click on setting interface, and then select Storage > RAID > Hot

spare.

The Hot spare interface is displayed. See Figure 8-73.
Figure 8-73 Hot spare (1)

Step 2 Click Add.
The Add interface is displayed. See Figure 8-74orFigure 8-75.

Figure 8-74 Global hot spare
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Figure 8-75 Private hot spare
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Step 3 Select hot spare creation type.
e Global hot spare: It is to create hot spare for all RAID. It is not a hot spare HDD
for a specified RAID group.
e Private hot spare: Select Private Hot spare and Add it to a RAID group. The
private hot spare HDD is for a specified RAID group.
Step 4 Select one or more HDD(s) and then click Next.
The Confirm Info interface is displayed. See Figure 8-76.
Figure 8-76 Confirm info
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Step 5 Confirm info.
LL]

Click Back to select hot spare HDD(s) again if you want to change settings.
Step 6 Click Create to save settings.
System displays the added hot spare HDD information. See Figure 8-77.
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Figure 8-77 Hot spare (2)
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L]
Select a hot spare HDD and then click Delete, it is to delete hot spare HDD.

8.5.3 Storage Strategy

Allocate disks or RAID groups to different disk groups, and store video and image to specified
disk group.

8.5.3.1 Setting Disk Group

Disk and created RAID group are allocated to group 1 by default. You can allocate disk and
RAID group to other groups according to your actual needs.

The default number of disk group is the same as the maximum number of HDD that IVSS
supports. Fox example, IVSS supports a maximum number of 16 HDDs, then the default
number of disk group is 16.

Step 1 Click , or click on the setting interface, and then select STORAGE >

Storage Strategy > Disk Group.
The Disk Group interface is displayed. See Figure 8-78.
L1

e Select HDD or RAID group from ”, and then click Query
to search the disk group of HDD or RAID group.

e The value (such as ) next to the group name refers to the number of HDD

and RAID group in the disk group. If instead, 0 s displayed, it means no

available HDD or RAID group in the disk group, but there is video or image
stored in the disk group.
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Figure 8-78 Disk group
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Step 2 Click a disk group.
The disk information of the group is displayed.

Step 3 Select HDD or RAID group from Disks, and then drag the HDD or the RAID group to
another disk group.
Disk grouping takes effect immediately.

L]
Select All to select all the HDDs and RAID groups of the disk group.

8.5.3.2 Setting Video/lImage Storage

Videos/images of all channels are stored in disk group 1 by default. You can store the
videos/images in different disk groups according to actual needs. Two methods are available
to set video/image storage.

L.—_.l

This section takes storing video for example. To store images, refer to this section.

Method 1

Step 1 Click , or click on the setting interface, then select STORAGE > Storage

Strategy > Video.
The Video interface is displayed. See Figure 8-79.
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Figure 8-79 Video
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Step 2 Select filtering way from the Batch Process dropdown list.
e By Channel Name: Select channel according to the channel name.
e By Logical Channel No.: Select channel that is connected to IVSS. In this case,
Start Channel No. and End Channel No. need to be configured.
Step 3 In the Select Disk Group dropdown list, select target disk group.
1]
In the dropdown list, only disk group with available HDD or RAID group is displayed.

Step 4 Click OK.
Disk grouping takes effect immediately.

Method 2

Step 1 Click , or click on the setting interface, then select STORAGE > Storage

Strategy > Video.
The Video interface is displayed. See Figure 8-79.

Step 2 Click a disk group.
The linked channels of the disk group are displayed in Device List. See Figure 8-80.

L[]

e Only disk group with available HDD or RAID group or linked channel is
displayed.

e The value (such as ) next to the group name refers to the number of HDD
and RAID group in the disk group. If instead, 0s displayed, it means no
available HDD or RAID group in the disk group, but there is video or image
stored in the disk group.

[ J

System Configuration 232



Figure 8-80 Device list
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Step 3 Select channel from the device list, and drag the channel to the target disk group.

Disk grouping takes effect immediately.

8.6 Security Strategy

Click . or click on setting interface, select Security. The Security interface is

displayed. See Figure 8-81.

It is to set security strategy to guarantee device network and data safety. It includes HTTPS,
set host IP access rights, enable network security protection.

I—vJ

HTTPS function is for WEB and IVSS Client only. Refer to the actual interface for detailed

information.

Figure 8-81 Security center
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8.6.1 HTTPS

HTTPS can use the reliable and stable technological means to guarantee user information
and device security and communication data security. After installing the certificate, you can
use the HTTPS on the PC to access the device.

8.6.1.1 Install Certificate

System supports these two certificates. Install according to your actual requirements.
e Manually create the certificate.
e Install the signed certificate.

8.6.1.1.1 Install the Created Certificate

It is to install the created certificate manually. It includes creating the certificate on the device,
downloading and installing the certificate on the PC.

L1

e Create and install root certificate if it is your first time to use HTTPS or you have changed

device IP address.
e After creating server certificate and installing root certificate, download and install root

certificate on the new PC, or download the certificate and then copy to the new PC.

Step 1 Click . or click on setting interface, and then select Security > Credential.

The Credential interface is displayed. See Figure 8-82.
Figure 8-82 Credential (1)
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Step 2 Create certificate on the device.
1) Click Create certificate.
The Create certificate interface is displayed. See Figure 8-83.
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Figure 8-83 Create certificate
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2) Set country, IP/domain, valid date and so on.

I-—-—-l

e Country, IP/domain, and valid date are required items. Other items are
optional.
e |P/domain shall be the device IP or the domain.
3) Click OK.
System begins to install certificate, and then displays certificate information after
the installation. See Figure 8-84.
Figure 8-84 Credential (2)
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Step 3 Download certificate.
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§ Cownload
1) Click ¥ ™™o

The Opening ca.crt interface is displayed. See Figure 8-85.
Figure 8-85 Opening ca.crt
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LS 4
2) Click Save File to select file saved path.
3) Click Save.

System begins downloading certificate file.
Step 4 Install root certificate on the PC.
1) Double click the certificate.
System displays Open file-security warning interface.
2) Click Open.
System displays Certificate interface. See Figure 8-86.
Figure 8-86 Certificate
o |

General | Detais | Certification Path

Certificate Information

This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authorities store.

Issued to: Product Root CA

Issued by: Product Root CA

valid from 2013-6-18 to 2023-6-16

3) Click Install Certificate.
The Certificate Import Wizard interface is displayed. See Figure 8-87.
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Figure 8-87 Certificate import wizard
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4) Follow the prompts to import the certificate.
System goes back to Certificate interface.
Step 5 Click OK to complete certificate installation.

8.6.1.1.2 Install Signature Certificate

It is to upload signature certificate to install.

Preparation

Before installation, make sure you have obtained safe and valid signature certificate.

Operation Steps

Step 1 Click , or click on setting interface, and then select Security > Credential.
The Credential interface is displayed. See Figure 8-88.

System Configuration 237



Figure 8-88 Credential(1)

rrrrrrr

En -
Step 2 Click Install Signature Certificate.
The Install Signature Certificate interface is displayed. See Figure 8-89.
Figure 8-89 Install signature certificate
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Certificate Fath Browse
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Cancel

Step 3 Click Browse and then select certificate and credential file.

Step 4 Click Install.
System begins to install certificate, and then displays certificate information after the
installation.

Step 5 Install the root certificate on the PC. Refer to "8.6.1.1.1 Install the Created Certificate
Step 4" for detailed information.

I-—-—-l

This root certificate is the one obtained with signed certificate.

8.6.1.2 Enable HTTPS

After you install the certificate and enable HTTPS function, you can use the HTTPS on the
PC to access the device.

Step 1 Click , or click on setting interface, and then select Security > Credential.

The Credential interface is displayed.
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Step 2 Click - to enable HTTPS function. See Figure 8-90.

Figure 8-90 Credential

Step 3 Click Save.
After you successfully save the settings, you can use HTTPS to access the WEB

interface.
Open the browser and then input https://IP address:port, click Enter, and the login
interface is displayed.

I-—-—-l

e |P address is device IP or the domain name.
e Port refers to device HTTPS port number. If the HTTPS port is the default value
443, just use https://IP address to access.

8.6.1.3 Uninstall the Certificate

It is to uninstall the certificate.
LL]

You cannot use the HTTPS function after you uninstall the certificate.

Step 1 Click , or click on setting interface, and then select Security > Credential.
The Credential interface is displayed. See Figure 8-91.
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Figure 8-91 Credential
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Step 2 Click Uninstall.
System pops up a confirmation box. See Figure 8-92.
Figure 8-92 Confirmation

Are you sure to uninstall the certificate?

Step 3 Click OK to uninstall the certificate.

8.6.2 Configuring Access Right

It is to set the specified IP addresses to access the device, to enhance device network and
data security.

-
Step 1 Click , or click on setting interface, and then select Security > IP Filter.
The IP Filter interface is displayed. See Figure 8-93.
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Figure 8-93 IP Filter
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Step 2 Itis to select IP access rights.
e Allow all access: Itis to allow all IP addresses in the same IP segment to access
the device.
e Reject access list: It means the IP address in the list cannot access the device.
e Allow access list: It means the IP address in the list can access the device.
Step 3 Add IP host.
(1]
The following steps are to set reject access list or allow access list.
1) Click Add.
The Add interface is displayed. See Figure 8-94.
Figure 8-94 Add

Add X
Add Type ® Single IF |F%dé addr MAC
P4/ IFY G P4 L4
P 1 . 0 . O . 1

Cancel

2) Select Add Type, and set IP address or MAC address of IP host.
e Single IP: Enter host IP address.
e [P segment: Enter IP segment. It can add multiple IP addresses in current
IP segment.
e MAC: Enter MAC address of IP host.
3) Click OK to add the IP host.
System displays added IP host list. See Figure 8-95.

L]
e Click Add to add more IP hosts.
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o Click “ to edit the IP host.

e Select an IP host and then click Delete to delete.
Figure 8-95 IP host list

O Aot access _ o Atow secess it

Step 4 Click Save.
8.6.3 Safety Protection

It is to set the login password lock strategy once the login password error has exceeded the
specified threshold. System can lock current IP host for a period of time.

Step 1 Click . or click on setting interface, and then select Security > Safety

Protection.
The Safety Protection interface is displayed. See Figure 8-96.
Figure 8-96 Safety protection (1)
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Step 2 Click - to enable security protection function.

e Remote: When you are using WEB, IVSS Client to access the device remotely,
once the login password error has exceeded the threshold, system locks the IP
host for a period of time.

e Local: When you are accessing local menu of the device, once the login
password error has exceeded the threshold, system locks the account for a
period of time.

Step 3 Set lock strategy according to the actual situation.
Step 4 Click Save.
Once the IP host has been locked, you can view the locked IP host on the list. See

Figure 8-97. Select an IP host and then click Unlock, or click the o’ of the

corresponding IP host to unlock.
Figure 8-97 Safety protection (2)

8.6.4 Enabling System Service Manually

Step 1 Click . or click on setting interface, and then select Security > System

Service.
The System Service interface is displayed. See Figure 8-98.
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Figure 8-98 System service

A\ After disabled, reset the password only through the security

Step 2 Enable or disable system service according to your actual situation.
Refer to Table 8-24 for detailed information.

Table 8-24 System service

System service

Description

SSH

After enabling this function, you can access IVSS with SSH protocol, to
carry out system debugging and IP configuration. It is disabled by default.

Password Reset

After enabling this function, you can use Email or answer the security
guestions to reset password once you forgot. It is enabled by default.

If it is not enabled, you can only reset password at local device. Refer to
"8.7.3.2 Reset Password" for detailed information.

Mobile phone After enabling this function, you can access IVSS with mobile phone client,
push to receive information from IVSS.

After enabling this function, third-party platform can connect IVSS with CGI
CGI Enable

protocol.

After enabling this function, other devices can connect IVSS with ONVIF
ONVIF Enable

protocol.

Step 3 Click Save.

8.7 Account Management

Device account adopts two-level management mode: user and user group. You can manage
their basic information. To conveniently manage the user, we recommend the general user
authorities shall be lower than high-level user authorities.

N

e To ensure device safety, enter correct login password to operate Account interface (for
example, add or delete user).

e After a correct login password is entered on Account interface, if you do not close
Account interface, you can do other operations directly. If you close the interface and
enter it again, you shall enter the correct login password again. The actual interface shall

prevail.
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8.7.1 User Group

Different users may have different authorities to access the device. You can divide the users
to different groups. It is easy for you to maintain and manage the user information.
e System supports maximum 64 user groups. User group name supports maximum 64

characters.
e System has two default user groups (read-only): admin and ONVIF.
e Create new user group under the root.

Add User Group

Step 1 Click , or click on setting interface, and then select Account.

The Account interface is displayed.

. ) »,
Step 2 Select root node at the left list and then click ** at the bottom left corner.

The Input Password is displayed. See Figure 8-99.
Figure 8-99 Input password

Input Password =

Step 3 Enter current user’s login password, and then click OK.
System creates one user group and displays Attribute interface. See Figure 8-100.
Figure 8-100 User group attribute

Step 4 Set parameters. For details, refer to Table 8-25.
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Table 8-25 User group

Parameter Description
Set user group name.
Name The name ranges from 1 to 64 characters. It can contain English letters,

number and special character ("_", "@", ".").

Displays user group organization node. System automatically recognizes

Group name

the group name.
Description It is to input user group description information.
User list Displays user information of current group.

Step 5 Select user authority.
1) Click Authority tab.
The Authority interface is displayed. See Figure 8-101.
Figure 8-101 Authority

2) Set user group authorities according to actual situation.

° : means it has the corresponding authority.

e Check the box at the top of the authority list (such as (0) Authority Control)
to select all authorities of current category.
Step 6 Click Save.

Delete user group

I—vJ

e Before you delete a user group, delete all users of current group first.
e Admin and ONVIF user cannot be deleted.

Step 1 Click . or click on setting interface, and then select Account.

The Account interface is displayed.

Step 2 Select user group and click L] .
The Input Password is displayed. See Figure 8-102.
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Figure 8-102 Input password

nput Password 4

Password | g

Cancel

Step 3 Enter current user’s login password, and then click OK.
The following prompt interface is displayed.
Step 4 Click OK.

8.7.2 Device User

The device user is to access and manage the device. System default administrator is admin.
It is to add a user and then set corresponding authorities, so that the user can access the
resources within its own rights range only.

L.—_.l

User authorities adopt the user group authorities settings. It is read-only.

Adding a user

Step 1 Click , or click on setting interface, and then select Account.

The Account interface is displayed.

. ., .
Step 2 Select admin user group or other newly added user group, and then click*=* at the

bottom left corner.
The Input Password is displayed. See Figure 8-103.
Figure 8-103 Input password

nput Password o4

Password | g

Cancel

Step 3 Enter current user’s login password, and then click OK.
The Attribute interface is displayed. See Figure 8-104.
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Figure 8-104 Attribute

Step 4 Set parameters. For details, refer to Table 8-26.

Table 8-26 User management

Parameter Description
Set user name.
Name The name ranges from 1 to 31 characters. It can contain English letters,
number and special character ("_", "@", ".").
Group name Displays user organization node. System automatically identifies it.
In the new password box, enter the new password and enter it again in the
Password )
Confirm Password box.
The password ranges from 8 to 32 non-empty characters. It can contain
Confirm letters, numbers and special characters (excluding "™","",";",":","&") .The
Password password shall contain at least two categories. Usually we recommend the
strong password.
Description It is to input user description information.

Step 5 (Optional) Click Authority tab to view user authority.
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Figure 8-105 Authority

Step 6 Click Save.
Operation

After adding a user, you can modify user information or delete the user. For details, see Table

8-27.
L]
The user with account management authority can change its own and other users’
information.
Table 8-27 User operation
Name Operation
Edit user Select a user from user list. The Attribute interface of the user is
) ) displayed, and the user’s login password and description information can
information -
be modified.
Select a user from user list, and then click @ to delete.
Delete User H;T;l]
Before deleting online user, shield the user first. For details, see "9.2 Online
User".

8.7.3 Password Maintenance

Maintain and manage user’s login password.

8.7.3.1 Modify Password

Modify user’s login password.

Modify the user’s own password
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Step 1 Click E at the top right corner, and then select Modify Password.

The Change Password is displayed. See Figure 8-106.
Figure 8-106 Modify password

Change Password x
o
o [ 0
] @ | 0
Cancel

Step 2 Input old password and then input new password and then confirm.
Step 3 Click OK.

Modify another user’s password.

L.—_.l

Only Admin account supports this function.

Step 1 Click , or click on setting interface, and then select Account.

The Account interface is displayed.
Step 2 Select a user.
The Attribute interface is displayed. See Figure 8-107.
Figure 8-107 Attribute

| Attribute S Authority

Iy

Step 3 Click
The Input Password interface is displayed. See Figure 8-108.
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Figure 8-108 Input password

Input Password

Step 4 Enter current user’s login password, and then click OK.
The Change Password is displayed. See Figure 8-109.
Figure 8-109 Modify password

Change Password

o
o [ 20
[ = | 0

Cancel

Step 5 In the New Password box, enter the new password and enter it again in the Confirm
Password box.

Step 6 Click Save.

8.7.3.2 Reset Password

You can use Email or answer the security questions to reset password once you forgot. The

system supports to reset password in a local and remote way (web and IVSS client). For
details, see Table 8-28.

I—vJ

e When password resetting function is not enabled, the password cannot be reset if the
security questions are not set.

e Web and IVSS client only reset password with Email.
e Referto "8.6.4 Enabling System Service Manually" for detailed information.

Table 8-28 Reset password

Reset

Operation

Applicable scene

Remote reset

The system supports to reset password in a

local and remote

Password resetting function is

way (web and IVSS client). | enabled, and Email is set.

Local reset

Reset password

at local interface.

It applies to all scenes.

Remote reset
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Step 1 The Login interface of device is displayed. See Figure 8-110.
Figure 8-110 Login

,. ‘/SS Login for iVSS

admin

Forgot Password?

Step 2 Click Forgot Password.
System pops up a confirmation box. See Figure 8-111.
Figure 8-111 Prompt interface

A In order to provide a secure password reset environment, we need
to collect your e-mail address, device MAC address, device SN, etc.
All collected info is used only for the purposes of verifying device
validity and sending a security code to you. Do you agree and want

to continue the operation?

Step 3 Click OK.
The Reset the password interface is displayed. See Figure 8-112.

System Configuration 252



Figure 8-112 Reset password

Reset Password

@ Retrieve Password @ Set New Password

Retrieve Password By Email

SN presmsstS6F1F

1.Use specified APP (DMSS) to scan, APP
can automatically send out the data to the

Scan QR Code

server
2 Use non-specified APP to scan, please
send QR Code to

support_rpwd@global dahuatech.com

Security code will be sent to ***@dahuatech.com.

Input Security Code | 2

Cancel

Step 4 Rest the login password.
Scan the QR code to obtain the security code according to system prompts. Enter the

security code in your Email into the box of Input Security Code.
(1]
e You can get security codes twice by scanning the same QR code. If you need to
get the security code once again, refresh the interface.
e Use the security code received in your email box to reset the password within
24 hours; otherwise the security code becomes invalid.

Step 5 Click Next button.
The Reset Password interface is displayed. See Figure 8-113.

System Configuration 253



Figure 8-113 Reset password

Reset Password

& Retrieve Password @ setNew Password

L3
-

%] @ | 7P
o =
-

Sync password on the camera(s) that connected to current device

Cancel

Step 6 Set parameters. For details, refer to Table 8-29.

Table 8-29 Description of password parameters

Parameter Description
User The default user name is admin.

In the New Password box, enter the new password and enter it again in the
Password )

Confirm Password box.

The new password can be set from 8 through 32 non-empty characters and
Confirm contains at least two types from number, letter and special characters
Password (excluding ™, ™™, ";", ":" and "&"). Enter a strong password according to the

password strength indication.

After setting the prompt, when you move the mouse to m on the login
Prompt interface, the system pops up a prompt to help you remember the password.
guestion L]

The prompt question function is for local login interface only. Refer to the

actual interface for detailed information.

Step 7 Click OK to complete the password reset.
You can log in with the new password.

Local reset

Step 1 Through local connection, the Login interface of device is displayed. See Figure
8-114.

System Configuration 254



Figure 8-114 Login

,. ‘/SS Login for iVSS

admin

Forgot Password?

e
Login

Step 2 Click Forgot Password.
System pops up a confirmation box. See Figure 8-115.
Figure 8-115 Prompt interface

A In order to provide a secure password reset environment, we need
to collect your e-mail address, device MAC address, device SN, etc.
All collected info is used only for the purposes of verifying device
validity and sending a security code to you. Do you agree and want

to continue the operation?

Step 3 Click OK.
e If you have set the reserved Email, the interface is displayed as Figure 8-116
e If you have not set the reserved Email, the interface is displayed as Figure 8-117.
After you set the reserved Email and click Next, the interface is displayed as
Figure 8-116.
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Figure 8-116 Reset password (1)

Reset Password

@ Retrieve Password # Set New Password

-

Retrieve Password By Email

5N dremmsest I56F1F
Scan QR Code 1.Use specified APP (DMSS) to scan, APP
can automatically send out the data to the
SErver
2.Use non-specified APP to scan, please
send QR Code to
support_rpwdi@global.dahuatech.com

Security code will be sent to **@dahuatech.com.

Input Security Code | 92

Cancel

Figure 8-117 Reset password (2)

Reset Password

@ Password Protection @ Retrieve Password © setNewPassword

Email (Toreset password) ]

Cancel

Step 4 Reset the password.
e Emall
Scan the QR code to obtain the security code according to system prompts.
Enter the security code in your Email into the box of Input Security Code.

I-—-—-l

¢ You can get security codes twice by scanning the same QR code. If you
need to get the security code once again, refresh the interface.
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¢ Use the security code received in your email box to reset the password
within 24 hours; otherwise the security code becomes invalid.
e  Security Questions
In the Retrieve Password drop-down list in Figure 8-116, select Security
Questions, and the security questions interface is displayed, see Figure 8-118.
In the Answer boxes, enter the correct answers.
Figure 8-118 Reset password (3)

Reset Password

@ Retrieve Password ® setMew Password

Retrieve Password | Retrieve Password v

Question 1

* Answer

Question 2

* Answer

Question 3

* Answer

Cancel

Step 5 Click Next button.
The new password setting interface is displayed. See Figure 8-119.
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Figure 8-119 New password setting

Reset Password

& Retrieve Password @ setNew Password

L3
-

& @ | 2
& @
-
Sync password on the camera(s) that connected to current device

Cancel

Step 6 Set parameters. For details, refer to Table 8-30.

Table 8-30 Description of password parameters

Parameter Description
User The default user name is admin.

In the New Password box, enter the new password and enter it again in the
Password )

Confirm Password box.

The new password can be set from 8 through 32 non-empty characters and
Confirm contains at least two types from number, letter and special characters
Password (excluding ™, ™™, ";", ":" and "&"). Enter a strong password according to the

password strength indication.

After setting the prompt, when you move the mouse to m on the login
Prompt interface, the system pops up a prompt to help you remember the password.
guestion L]

The prompt question function is for local login interface only. Refer to the

actual interface for detailed information.

Step 7 Click OK to complete the password reset.
You can log in with the new password.

8.7.4 ONVIF

When the remote device is connecting with the device through ONVIF protocol, use the
verified ONVIF account.

I—vJ

e System adopts three ONVIF user groups (admin, user and operator). You cannot add
ONVIF user group manually.
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e You cannot add user under ONVIF group directly.

Add ONVIF User

Step 1 Clic, or click on setting interface, and then select Account.

The Account interface is displayed.
Step 2 Select user group under ONVIF.

The Attribute interface of ONVIF group is displayed. See Figure 8-120.
Figure 8-120 ONVIF

LTS

v
Step 3 Click =+,

The Input Password interface is displayed. See Figure 8-121.
Figure 8-121 Input password

Input Password

Password | g

Cancel

Step 4 Enter current user’s login password, and then click OK.
The Attribute interface is displayed. See Figure 8-122.
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Figure 8-122 ONVIF attribute

Step 5 Set parameters. For details, refer to Table 8-31.

Table 8-31 ONVIF parameters description

Parameter Description
Itis to set ONVIF user name.
Name The name ranges from 1 to 31 characters. It can contain English letters, number
and special character ("_", "@",".").
Group nhame Displays user organization node. System automatically identifies it.
Password Itis to set ONVIF user password.
The password ranges from 8 to 32 non-empty characters. It can contain letters,
Confirm numbers and special characters (excluding "","",";",":","&") .The password shall
Password contain at least two categories. Usually we recommend the strong password.
Description Input ONVIF user description information.

Step 6 Click Save.

Delete ONVIF User

L.—_.l

Deleting the admin

account is not supported.

Step 1 Click , or click on setting interface, and then select Account.

The Account interface is displayed.

Step2 Select ONVIF and click I .

The Input Password interface is displayed. See Figure 8-123.
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Figure 8-123 Input password

Input Password

Password | g

Cancel

Step 3 Enter current user’s login password, and then click OK.
The following prompt interface is displayed.
Step 4 Click OK.

8.8 System Management

Click or click on setting interface, select System. The System interface is
displayed. See Figure 8-124.

It is to set system basic settings, such as general parameters, time, display parameter,
schedule, and voice.

Figure 8-124 System management

8.8.1 Setting System Parameter

It is to set system language, standard, user logout time, virtual keyboard, and mouse moving
speed.

Step 1 Click , or click on setting interface, and then select System > General >

System.
The System interface is displayed. See Figure 8-125.
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Figure 8-125 Configuring system settings

Step 2 Set parameters. For details, refer to Table 8-32.

Table 8-32 System parameters description

Parameter Description

Language It is to set system language.

Select video standard.
e PAL is mainly used in China, Hong Kong, Middle East and Europe.
e NTSC is mainly used in Japan, United States of America, Canada and

Standard Mexico.

L]

As a technical standard of processing video and audio signals, PAL and NTSC
mainly differ in encoding, decoding mode and field scanning frequency.

Itis to set auto logout interval once you remains inactive for a specified period or
the device exceeds the set value. After auto logout, the user needs to login
again to operate.

If you set as No Logout, system does not automatically log out.

User logout time

It is to enable virtual keyboard function on the local menu. Refer to "Appendix

1.2 Virtual Keyboard" for detailed information.
Virtual keyboard M

This function is for local menu only.

. It is to set mouse moving speed on the local interface.
Mouse moving A

speed _ —
This function is for local menu only.

Step 3 Click Save.

8.8.2 System Time

It is to set system time, and enable NTP function according to your need. After enabling NTP
function, device can automatically synchronize time with the NTP server.

Step 1 Click , or click on setting interface, and then select System > General >

Time.
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The Time interface is displayed. See Figure 8-126.
Figure 8-126 Time

me and Date Format YYYY.MM.DD - | | 24HR -

Step 2 Set parameters. For details, refer to Table 8-33.

Table 8-33 System parameters description

Parameter Description

It is to set system date and time. You can set manually or set device to

synchronize time with the NTP server.

Time e Select Manual Setting and then input actual date and time.

e Sync with the Internet Time Server: Check the box and then input
NTP server IP address or domain, and then set Auto Sync Time

Interval.

Time and date . .
Set time and date display format.

format
Time Zone Set device time zone.

. After enabling this function, IVSS detects system time of remote device once
Auto Time

o in every interval. When time of remote device is inconsistent with IVSS time,
Synchronization

IVSS will calibrate the time of remote device automatically.

Step 3 (Optional) Set DST.
L]

DST is a system to stipulate local time, in order to save energy. If the country or
region where the device is located follows DST, you can enable DST to ensure that
system time is correct.

1) Click - to enable DST.

2) Select DST mode. It includes Date and Week.
3) SetDST start time and end time.
Step 4 Click Save.

System Configuration 263



8.8.3 Display

It is to set connected display resolution and refresh rate.

Step 1 Click , or click on setting interface, and then select System > General >

Display.
The Display interface is displayed. See Figure 8-127.
Figure 8-127 Display

e SN 1-3 refers HDMI 1-HDMI 3. Among which, HDMI/VGA is the main display,
while the VGA and HDMI 1 outputs the same video.

e VGA and HDMI 1 are outputting the same video source. Three HDMI ports can
output different video sources.

-

° = means display is connected and enabled. means display is

connected but has not enabled.

~ means display is disconnected.

Step 2 Select display.
Step 3 Set parameters. For details, refer to Table 8-34.

Table 8-34 Display parameters description

Parameter Description

Start or stop display.
Enable L1]
System adopts main screen by default. The main screen cannot be disabled.

Resoluti It is to set display resolution. Different displays support different resolutions.
esolution
Refer to your actual interface for detailed information.

Refresh rate It is to set refresh rate of the display.

Step 4 Click Save.

System Configuration 264



8.8.4 Schedule

It is to set schedule. When you are configuring alarm, record arm/disarm period, system can
call the schedule directly. System only triggers the corresponding operations during the
specified schedule.

[11

Default schedule has been created by default. Default schedule is Always Effective, and
cannot be modified or deleted.

Step 1 Click , or click on setting interface, and then select System > Schedule >

Schedule.
The Schedule interface is displayed. See Figure 8-128.
Figure 8-128 Schedule

sssss

[ Schedule v

Step 2 Add schedule.

1) Click T

The Add Schedule interface is displayed. See Figure 8-129.
Figure 8-129 Adding schedule

Add Schedule X
Schedule Mame Schedulel
Schedule Type ® Week Schedule

Cancel

2) Set schedule name.

3) Click OK to save the configuration.
Step 3 Set valid time period. It includes Always Effective and Customize.
Step 4 Set validity period of schedule.
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e The step is for customized mode only.

e Each calendar supports maximum 50 validity periods.

e The blue area on the time bar means the validity period.
On the time bar, you can:

e Click the blue area, and *? is displayed. Drag ** to adjust the start time and

end time of validity period.

e Press the any blank space on the time bar, and drag to the right to add a validity
period.

e Click Clear to clear all validity periods of current schedule.

e Select a validity period, and then click Delete to delete the period.

Step 5 Click Save.
[LI

.

Select an added schedule, and then click @ to delete.

8.8.5 Enabling Voice Manage Function

This function is used to upload and manage audio files, so the device plays audios in case of
events.

I._.—_.l

e  Only support to import .pcm files.
e Asingle audio file shall not be less than 2KB and shall not exceed 10MB.
e Total size of imported audio files shall not exceed 200MB.

Import audio file

Step 1 Click , or click on setting interface, and then select System > Voice

Manage > Voice Manage.
The Audio Manage interface is displayed. See Figure 8-130.
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Figure 8-130 Audio manage

+ Import | | i Delete Veice Volume 0Byte /200MB

© File Name Format File Size Operate

Step 2 Click Import to select the audio files that you want to import.
Step 3 Click OK.
The uploaded audio file is displayed. See Figure 8-131.
Figure 8-131 Audio file

+ import || {ff Delete Veice Volume 426,008 /200MB

© File Name Format File Size. Operate

browser.pcm pem 426008 = @

Operation

After audio file is uploaded, audio file can be renamed or deleted. For details, see Table 8-35.

Table 8-35 Audio file operation

Name Operation

Rename audio file | Click [# peside the audio file. The Rename interface is displayed. See Figure

8-132. You can rename the audio file.

e Delete: Click (1] beside the audio file to delete it.

Delete audio file ] o ]
e Batch delete: Select multiple audio files, and click Delete to delete all of

the selected audio files.
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Figure 8-132 Rename

Rename

File name:

browser
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9 System Maintenance

Click on the LIVE interface, and select Maintain. The Maintain interface is displayed.

See Figure 9-1.

On the LIVE interface, you can operate and maintain the device working environment to
guarantee proper operation.

Figure 9-1 Maintain

9.1 Searching Log

The logs record all kinds of system running information. Check the log periodically and fix the
problems in time to guarantee system proper operation.

Log classification

Search system log, user log, event log, and link log. For details, see Table 9-1.

Table 9-1 Log description

Log Type
Search system log.
System log It includes logs of system running status, file management, hot spare, hardware

detect and scheduled task.

User operation

Search user operation log.

log It includes user operation and user configuration log.

Search alarm event log.

It includes logs of cross line detection, storage error, storage full, lock in, power
Event log fault, video motion, fan speed alarm, face detection, face recognition, human

detect, device offline, tampering, no HDD, IPC offline, Al module offline, Al
module temp, 10 alarm, IP conflict, MAC conflict, and cross region detection.
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Log Type

Search device link log.

session blast and remote device.

Link log You can search or export link log including user login/logout, session hijack,

Search log

The following steps are to search system log. Refer to the actual interface for detailed
information.

Step 1 On the LIVE interface, click , and select Maintain > Log > System.

The System interface is displayed.
Step 2 Set search criteria such as system log level, type and date.
Step 3 Click Search.
The search results are displayed. See Figure 9-2.
Figure 9-2 System log

O™ O P o] tent [ v o 20000501 00000 @ 0ts-03 o000 @ (DN | e 2| 8o
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L ]
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= Device Maintain > L
]

@ rotice 20160027 142009 Ackdraesl0.15.8.94 MewTor=2016-03-27 14:20:09 OliTim= 2018032

ShutDavn 0 rtice 20180327 120534 Time2018405.27 124532
System SyneSysTime O riotice 20160027 100122 Aekdresrt015 6 94 NewTim=2016-00-27 10421 OTime: 2018092 _

Shamiote | 200 in 1

Operation

Search, export and clear log. For details, see Table 9-2.

Table 9-2 Log operation

Name Operation

Export log Click 2+ to export log information to local PC or USB storage device.

A\

Clear log
You will be unable to track the system error reason if you clear log.

Click Clear all to clear all system logs.
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9.2 Online User

It is to search remote access network user information or you can block a user from access
for a period of time. During the block period, the selected user cannot access the Device.

I—vJ

Cannot block yourself or block admin.

Step 1 On the LIVE interface, click , and select Maintain > Online User > Online User.

The Online User interface is displayed. See Figure 9-3.
L1]

The list displays the connected user information.
Figure 9-3 Online user

© Block

Login Time 13 MAC Link Type v Duration Operate

S

admin SDK 2018-11-20 17:00:29 10.33.12.154 74:85:c4:b1:9c0a TCP 79min

Total1 temls) Showupto [ 20 v

Step 2 Block user.

e Block: Click "= corresponding to the user.

e Batch block: Select multiple users you want to block and then click Block.

The Block interface is displayed. See Figure 9-4.
Figure 9-4 Block

Elock b4

Block Time 30 Mim r

Cancel

Step 3 Set block period. The default period is 30 minutes.
Step 4 Click OK to save the configuration.
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9.3 Device Maintenance

Device maintenance is to reboot device, restore factory default setup, or upgrade system and
so on. It is to clear the malfunction or error during the system operation and enhance device
running performance.

9.3.1 Upgrading Device

It is to upgrade device or the Al module version.

9.3.1.1 Upgrading Host

It is to import the upgrade file to upgrade device version. The upgrade file extension name
shall be .bin.

A\

e During upgrading, do not disconnect from power and network, and reboot or shut down
the Device.
e Make sure the upgrade file is right. Improper upgrade file may result in device error!

Preparation

You need to obtain the correct upgrade file and save it in the corresponding path.

e When operating on the local interface, save the upgrade file in the USB storage device
and then connect the USB storage device to the IVSS.

e When operating on the web or IVSS interface, save the upgrade file on the PC in which
the Web or IVSS client is located.

Operation Steps

Step 1 On the LIVE interface, click , and select Maintain > Device Maintain >

Upgrade > Host.
The Host interface is displayed. See Figure 9-5.
Figure 9-5 Upgrade host

EF Host 8 Al Module

ing, don't shut down device, disconnect network, restart or close Intelligent Video Surveillance Server. * If upgrade arror, restart the device, o part of functions will be invalid

Local Upgrade

Step 2 Click Browse to select an upgrade file.
Step 3 Click Upgrade Now.
System pops up a confirmation box. See Figure 9-6.
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Figure 9-6 Note

X

The upgrade will suspend the intelligence

a*-

analysis business. Do you want to continue?

“ Cancel
Step 4 Click OK.

The system starts upgrading. Device automatically reboots after successfully
upgraded.

9.3.1.2 Upgrade Al module

It is to upgrade the system version of the Al module installed on the device.

A\

e During upgrading, do not disconnect from power and network, and reboot or shut down
the Device.

e Make sure the upgrade file is right. Improper upgrade file may result in device error!
e System cannot upgrade different Al modules at the same time.

Preparation

e You need to obtain the correct upgrade file and save it in the corresponding path.
¢ When operating on the local interface, save the upgrade file in the USB storage
device and then connect the USB storage device to the IVSS.
¢ When operating on the web or IVSS interface, save the upgrade file on the PC in
which the Web or IVSS client is located.
e The Al module you want to upgrade is online.

Operation Steps

Step 1 On the LIVE interface, clickn, from Maintain > Device Maintain > Upgrade > Al

Module.

The Al Module interface is displayed. See Figure 9-7.
L]

® means Al module is online.
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Figure 9-7 Upgrade Al module

w Name Version Upgrade State \

& FPGA 1 V2.000.0000000.0

Total 1 ltem(s) Showupta[ 10 = 1 Go

Step 2 Select the Al module.
(1]
e You can select multiple Al modules at the same time.
e System cannot upgrade different types of Al modules at the same time.
Step 3 Click File Upgrade.
The File Upgrade interface is displayed. See Figure 9-8.
Figure 9-8 File upgrade

File upgrade ¥

A When upgrading, don’t shut down device, disconnect network, restart or close Intelligent

&=

Video Surveillance Server.

(=
&
2
i
m

Import File

Cancel upgrading

Step 4 Click Browse to select an upgrade file.

Step 5 Click Upgrade Now.
The system starts upgrading. After the upgrade is completed, Al module
automatically reboots.

9.3.2 Default

When the system runs slowly and has configuration errors, try to solve the problems by
restoring the default settings.

A\

All configurations are lost after factory default operation.

Step 1 On the LIVE interface, click , from Maintain > Device Maintain > Default.
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The Default interface is displayed. See Figure 9-9.
Figure 9-9 Default

Factory Defauit

A Click Factory Default button, device r

s factory default settings and needs to be initialized again

G Factory Default

Step 2 Click Factory Default.
System pops up a confirmation box. See Figure 9-10.
Figure 9-10 Note

X
This option will set the device to factory
status, all configurations will be lost. whether
to confirm factory default?

n Cancel
Step 3 Click OK.

System begins to restore default settings. After successfully restored default settings,
system prompts to reboot the device.

9.3.3 Auto Maintain

If the device has run for a long time, you can set to automatically reboot the device at idle
time.

Step 1 On the LIVE interface, click , from Maintain > Device Maintain > Auto

Maintain.
The Auto Maintain interface is displayed. See Figure 9-11.
Figure 9-11 Auto Maintain

Auto Maintain

Auto Reboot Never ¥ || 02:00

Step 2 Set auto reboot time.
Step 3 Click Save.

9.3.4 IMP/EXP

Export device configuration file to local PC or USB storage device, to backup it. When the
configuration is lost due to abnormal operation, import the backup configuration file to restore
system configurations quickly.

On the LIVE interface, click , and select Maintain > Device Maintain > IMP/EXP. The
IMP/EXP interface is displayed. See Figure 9-12.
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Figure 9-12 IMP/EXP

IMP/EXP

Export Config

Click Export to export configuration file to local PC or USB storage device. File path may
vary depending on interface operations, and the actual interface shall prevail.

e On IVSS client, click = , select Download content to view file saving path. For details,

see 10.3 View Downloads
e Select file saving path during local operation.
L]
Connect USB device to IVSS if you are on the local menu to operate.
e During web operations, files are saved under default downloading path of the browser.

Import Config

Step 1 Click Browse to select the configuration file.

Step 2 Click Import.
After the configuration file is imported successfully, the device will reboot
automatically.
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10 IVSS Client Introduction

After installing IVSS client, system supports to access the device remotely. It is to realize
system configuration, function operations and system maintenance.

[l

Refer to "5.3.1 Logging in Client" for detailed information.

10.1 Interface Description

Double-click E on the PC desktop. System displays IVSS Client at full screen by default.
Click~mm=mto display the task column. See Figure 10-1. Refer to Table 10-1 for detailed

information.

iVSs Please Enter URL

Figure 10-1 IVSS task column

Table 10-1 Icons

Icons

Description

iVSE

Address bar: Enter the IP address of remote device.

Input device IP address and then click the button to go to the login interface.

Now the icon turns into 5] . Click to refresh the interface.

Click to view history login record, view downloads, set compatibility mode and
view IVSS version information.

Click to minimize IVSS Client.

Click to display IVSS Client at full screen.

Click to close IVSS Client.

10.2 History Record

Click = , and then select History Record.

The History Record interface is displayed. See Figure 10-2. It is to view history access
record and clear buffer.

e Click Clear History to clear all history records.

e Click Clear Buffer to clear buffer data, and reboot IVSS client.
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Figure 10-2 History record

History X

M Clear History @ Clear Cache

(© Today 2018-01-17

® 13:41:20 http:#192.168.1.102

10.3 View Downloads

Click = , and then select Downloads. The Downloads interface is displayed. See Figure

10-3. It is to view and clear history downloads.
e Double click file name to open it.
e Click Displayed in Folder to open the folder where the file is located.
e Click Clear Downloads to clear history download records.
Figure 10-3 Downloads

Downloads X

W Clean up 0 ltems

10.4 Configuring IVSS Client

When PC theme is not Areo, video of IVSS client might not be displayed normally. It is
suggested that PC theme should be switched to Areo, or compatibility mode of IVSS client
should be enabled.

Switching PC Theme

I._.—_.l

The following steps are to take Windows 7 for example. Refer to the actual interface for
detailed information.
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Right-click any blank position on PC desktop, select Personalize, and switch to Aero theme.

See Figure 10-4.

N

After switching PC Theme, it will take effect after rebooting IVSS client.

Figure 10-4 PC theme

Control Panel Home .
Change the visuals and sounds on your computer

Change desktop icons Click a theme to change the desktop background, window color, sounds, and screen saver all at once.

.
=) ﬁ

- . ae
@uv]i <« App. b Persona.. + [ 43| Search Controt Panet 2|

Change mouse pointers My Thernes (0)

Change your account picture

Aero Themes (T)

& T

Get more themes cnline

Windows 7 Architecture Characters Landscapes

i

China

Basic and High Contrast Themes (6)

i

Nature

Windows 7 Basic Windows Classic High Contrast #1 High Contrast #2 High Contrast Black  High Contrast White
'''' . r = 'S
Displa L <v7 ®
s baiondSat Nend Desktop Background Sounds Screen Saver

Window Color

Ease of Access Center i

Windows Default

None

Enable compatibility mode

Click = , and select Settings. The Settings interface is displayed. See Figure 10-5. Select

compatibility mode.

I—vJ

After enabling the mode, it will take effect after rebooting IVSS client.
Figure 10-5 Setting

Settings

[7] Compatibility Mode

10.5 Viewing Version Details

Click = and then select About. The About interface is displayed. See Figure 10-6. Itis to

view IVSS Client version information.
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Figure 10-6 About

About

IVSS-APP

Faster, Simple and Safe

\ersion: V1.0.0.651721
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1 1 Log Out/Reboot/Shut Down

Itis to log out, reboot and shutdown the device. See Figure 11-1.
Figure 11-1 User operation

Hi, admin
Change Password
Lock

& Log Out

3t | Reboot

'y | Shut Down

Log Out

Click E and then select Log Out.

Reboot

Click E and then select Reboot. System pops up confirm dialogue box. Click OK to
reboot.

Shut Down

A\

To unplug the power cable may result in data (record, image) loss. We recommend Mode 1.

e Mode 1 (recommended): CIickE, and then select Shutdown. System pops up confirm
dialogue box and then click OK to shut down.
e Mode 2: Use power on/off button on the device.
¢ 8-HDD series product: Press power on/off button on rear panel.
¢ Other series products: Press the power on/off button on the device for at least 4
seconds.
e Mode 3: Unplug the power cable.
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12 FAQ

Problem Possibilities and Solutions
e The Al module is offline.
On the LIVE interface, click . Select System > Maintain >
Upgrade > Al Module, check the Al module is online or not.
After enabling Al by e There are too many filter criteria on the Al display interface.
device function, thereis | @ The registered remote device does not support face detection
no human face function.
comparison event. Enable Al by device function. Refer to "6.2.3 Configuring Face
Detection” for detailed information.
e Itis notin the deployment period.
e There is no linked face database or the face database has no data.
e The human face similarity setting is too high.
) e The human face comparison function has not been enabled on the
After enabling Al by
] Al plan.
camera function, there . .
) e There is no human face database on the WEB interface of the
is no human face .
) remote device.
comparison event. _ . .
e Itis notin the deployment period.
e The human face similarity setting is too high.
e The selected remote device does not trigger the human face
There are no human comparison.
face search results. e There is no human face comparison on the search period
e The specified human face image is not on the human face

database.
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Appendix 1 Operation Description

Appendix 1.1 Mouse Operations

Connect mouse to the USB port, you can use the mouse to control the local menu. Refer to
Appendix table 1-1 for detailed information.

Appendix table 1-1 Mouse operation description

button twice)

Operation Description
e Left-click mouse to select a function menu, to enter the corresponding menu
. ) interface.
Click (click L
he left e Implement the operation indicated on the control.
ele
e Change check box and option button status.
mouse
button) e Left-click check box to display dropdown list.
utton
e On virtual keyboard, select letter, symbol, English upper letter and lower letter,
and Chinese characters.
e On the LIVE interface, double-click one video window to zoom in the window.
. Click any position out of the window, so the video window restores original
Double-click )
, size.
(click the left ) . L .
e On the LIVE interface, double-click the remote device in the device tree.
mouse

Switch to video edit status, and add remote device.
e Double-click the image or record file thumbnail, to playback record file or view
the image.

Right-click
(click the
right mouse
button)

e On the LIVE or SEARCH interface, right-click one video window to display
right-click menu.

e Onthe LIVE interface, right-click the view in the list or the remote device in the
device tree, to display right-click menu.

Wheel button

e On SEARCH interface, move the cursor to the time bar, and then click the
mouse middle button, to adjust the accurate time on the time bar.

e Click the control that needs to input number (such as input date or time). Roll
the middle button to adjust the number value.

Drag the
mouse

e Drag the mouse to select the motion detect zone.

e On the LIVE interface, drag the remote device in the device tree to the play
window, switch to the view status. It is to add the remote device.

e On SEARCH interface, drag the record file or the image thumbnail to the

playback window. It is to play back the corresponding record file or image.

Appendix 1.2 Virtual Keyboard

On local menu, it supports virtual keyboard function.
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Click the text box to display virtual keyboard interface. See Appendix figure 1-1 or Appendix
figure 1-2. Refer to Appendix table 1-2 for detailed information.

N

If the device has connected to the peripheral keyboard, click the text column. Virtual keyboard
will disappear.
Appendix figure 1-1 Virtual keyboard (global keyboard)

(1f2]3fals]el7]s]9]o 8
afwlelrledvlolilo]e g
lals]alefeln]i]r] ' [N
tlz]xfcfv]b]n]m]. Ja
(#=JEn] o |e]a] <
Appendix figure 1-2 Virtual keyboard (digital keyboard)
ﬂ .
I!

Appendix table 1-2 Virtual keyboard icon

Signal Words | Description

Click the icon to switch to upper case. The icon becomes n Click n to

switch to lower case.

E Click to delete letter.

Click to input letter. See Appendix figure 1-3. Now the icon turns into .

Click to restore previous input mode.

Click to input space.

=
n Click to control cursor position.

Select text and click the icon to cut the selected contents.

Select text and click the icon to copy the selected contents.

Cut or copy the contents, click the text box and click the icon to paste the
contents.

Click to switch to the next line.
=,
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Appendix figure 1-3 Virtual keyboard (input letter)
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Appendix 2 RAID

RAID is an abbreviation for Redundant Array of Independent Disks. It is to combine several
independent HDDs (physical HDD) to form a HDD group (logic HDD).

Comparing with one HDD, RAID provides more storage capacity and data redundancy. The
different redundant arrays have different RAID level. Each RAID level has its own data
protection, data availability and performance degree.

RAID Level

RAID Level

Description

Min. HDD
Needed

RAID 0

RAID 0 is so called striping.

RAID 0 is to save the continued data fragmentation on several
HDDs. It can process the read and write at the same time, so its
read/write speed is N (N refers to the HDD amount of the RAID 0)
times as many as one HDD. RAID 0 does not have data redundant,
so one HDD damage may result in data loss that cannot be restored.

RAID 1

It is also called mirror or mirroring.

RAID 1 data is written to two HDDs equally, which guarantee the
system reliability and can be repaired. RAID 1 read speed is almost
close to the total volume of all HDDs. The write speed is limited by
the slowest HDD. At the same time, the RAID 1 has the lowest HDD
usage rate. It is only 50%.

RAID 5

RAID 5 is to save the data and the corresponding odd/even
verification information to each HDD of the RAID 5 group and save
the verification information and corresponding data to different
HDDs. When one HDD of the RAID 5 is damaged, system can use
the rest data and corresponding verification information to restore
the damaged data. It does not affect data integrity.

RAID 6

Based on the RAID 5, RAID 6 adds one odd/even verification HDD.
The two independent odd/even systems adopt different algorithm,
the data reliability is very high. Even two HDDs are broken at the
same time, there is no data loss risk. Comparing to RAID 5, the
RAID 6 needs to allocate larger HDD space for odd/even verification
information, so its read/write is even worse.

RAID 10

RAID 10 is a combination of the RAID 1 and RAID 0. It uses the
extra high speed efficient of the RAID 0 and high data protection and
restores capability of the RAID 1. It has high read/write performance
and security. However, the RAID 10 HDD usage efficiency is as low
as RAID 1.

RAID Capacity
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Refer to the sheet for RAID space information.

capacityN refers to the mini HDD amount to create the corresponding RAID.

RAID Level Total Space of the N HDD

RAID O The total amount of current RAID group
RAID 1 Min (capacityN)

RAID 5 (N-1) xmin (capacityN)

RAID 6 (N-2) xmin (capacityN)

RAID 10 (N/2)xmin (capacityN)

RAID 50 (N-2) xmin (capacityN)

RAID 60 (N-4) xmin (capacityN)
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Appendix 3 HDD Capacity Calculation

HDD capacity calculation formula:

Total capacity (M) = Channel number x Demand time length (hour) x HDD capacity occupied
per hour (M/hour)

According to the above formula, get recording time calculation formula.

Total capacity (M)

Recordlng time (hOUI’) “HDD capacity occupied per hour (M/hour)xChannelnumbner

For example, for single-channel recording, HDD capacity occupied per hour is 200M/hour.
Use 4-channel device to make 24-hour continuous recording in every day of one month (30
days), the required HDD space is: 4 channels x 30 days x 24 hours x 200M/hour = 576G.
Therefore, five 120G HDD or four 160G HDD shall be installed.

According to the above formula, at different stream values, recording file size of 1 channel in
1 hour is shown as follows (for your reference):

Bit stream size File size Bit stream size File size
(max.) (max.)

< 96K 42M 128K 56M
160K 70M 192K 84M
224K 98M 256K 112M
320K 140M 384K 168M
448K 196M 512K 225M
640K 281M 768K 337M
896K 393M 1024K 450M
1280K 562M 1536K 675M
1792K 787M 2048K 900M
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Appendix 4 Glossary

Name

Description

CaGl

Common Gateway Interface (CGIl) is an important Internet technology. With CGl, client
can ask data from program running on network server. CGIl describes data
transmission standard between server and asking processing program.

DDNS

Dynamic Domain Name System (DDNS) is to map the user dynamic IP address to a
specified domain analysis service. Each time, when the user connects to the network,
the client can transmit the host dynamic address to the server application on the host
of the service provider. The server applications are to provide the DNS service and
realize dynamic domain analysis. That is to say, the user does not need to remember
the changeable IP address, just uses the domain name to login the device or the
address.

DHCP

Dynamic Host Configuration Protocol (DHCP) is a network protocol in the LAN. It is to
automatically allocate IP address for the internal network or the ISP (Internet service
provider).lt is to manage the computer IP address by the unified means of
management.

DNS

Domain Name System (DNS) is to save the all host domain name and corresponding
IP address in the network. It has the ability to change the domain to the IP address.

DVR

Digital Video Recorder.

FTP

File Transfer Protocol (FTP) is used to control bilateral transmission of file on the
Internet.

HDMI

High Definition Multimedia Interface (HDMI) is a special digital interface suitable for
audio/video transmission. It can transmit audio signal and video signal at the same
time.

HTTPS

Hyper Text Transfer Protocol over Secure Socket Layer (HTTPS) is a HTTP channel
for security purpose. The HTTPS has defines the browser the world wide web service
safety communication rule. It adopts encryption technology to guaranty safety access
to the webpage.

Internet Protocol.

IPC

IP Camera.

NTP

Network Time Protocol (NTP) is a protocol to synchronize computer time. It adopts
wireless network protocol UDP, so that the computer time synchronizes with the server
or the time source. It is to provide time correction of high accuracy.

NTSC

National Television Standards Committee, American national standard television and
broadcast transmission and receiving protocol. This is a television standard that
television scanning beam is 525 beams, 30 frames per second, interlaced scanning,
odd field first and then it is followed by even field. NTSC is used in the United States of
America, Japan, and so on.

NVR

Network Video Recorder

MTU

Maximum Transmission Unit (MTU) refers to the maximum data packet amount (byte)
on one layer of the communication protocol.
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Name

Description

ONVIF

Open Network Video Interface Forum (ONVIF) is the defined general protocol for
information exchange among the network video devices. It includes search device,
real-time audio/video, metadata, information control, and so on.

PAL

Phase Alteration Line, this is a television standard that television scanning beam is
625 beams, 25 frames per second, phase alteration, odd field first and then it is
followed by even field. PAL color encoding is used. PAL is used in China, Europe, and
so on.

PTZ

Pan Tilt Zoom (PTZ) refers to the PTZ all-direction movement, lens zoom, and focus
control.

RAID

RAID is an abbreviation for Redundant Array of Independent Disks. It is to combine
several independent HDDs (physical HDD) to form a HDD group (logic HDD), to
provide higher storage performance and data redundancy.

SMAR.T

Self-Monitoring Analysis and Reporting Technology (S.M.A.R.T) is a technical
standard to detect HDD drive status and report potential problems.

SSH

Secure Shell (SSH) is a security protocol formulated by IETF network group on the
basis of application layer. SSH protocol can effectively prevent information leakage
problem during remote management.

SvC

Scalable Video Coding (SVC) is a video encoding technology. It can split the video
streams to one basic layer and several enhanced layers according to the
requirements. The basic layer provides the general video quality, frame rate and
resolution, and the enhanced layer is to perfect the video quality.

VGA

Video Graphics Array (VGA) is a video transmission standard. It has high resolution,
high display speed and abundant colors.

WLAN

Wireless Local Area Networks (WLAN) adopts radio frequency to realize data
transmission.
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Appendix 5 Cybersecurity

Recommendations

Cybersecurity is more than just a buzzword: it's something that pertains to every device that
is connected to the internet. IP video surveillance is not immune to cyber risks, but taking
basic steps toward protecting and strengthening networks and networked appliances will
make them less susceptible to attacks. Below are some tips and recommendations on how to
create a more secured security system.

Mandatory actions to be taken for basic equipment network security:
1. Use Strong Passwords
Please refer to the following suggestions to set passwords:
e The length should not be less than 8 characters;
e Include at least two types of characters; character types include upper and lower
case letters, numbers and symbols;
e Do not contain the account name or the account name in reverse order;
e Do not use continuous characters, such as 123, abc, etc.;
e Do not use overlapped characters, such as 111, aaa, etc.;
2. Update Firmware and Client Software in Time
e According to the standard procedure in Tech-industry, we recommend to keep your
equipment (such as NVR, DVR, IP camera, etc.) firmware up-to-date to ensure the
system is equipped with the latest security patches and fixes. When the equipment
is connected to the public network, it is recommended to enable the "auto-check for
updates” function to obtain timely information of firmware updates released by the
manufacturer.
e We suggest that you download and use the latest version of client software.

"Nice to have" recommendations to improve your equipment network security:

1. Physical Protection
We suggest that you perform physical protection to equipment, especially storage
devices. For example, place the equipment in a special computer room and cabinet, and
implement well-done access control permission and key management to prevent
unauthorized personnel from carrying out physical contacts such as damaging hardware,
unauthorized connection of removable equipment (such as USB flash disk, serial port),
etc.

2. Change Passwords Regularly
We suggest that you change passwords regularly to reduce the risk of being guessed or
cracked.

3. Set and Update Passwords Reset Information Timely
The equipment supports password reset function. Please set up related information for
password reset in time, including the end user’s mailbox and password protection
questions. If the information changes, please modify it in time. When setting password
protection questions, it is suggested not to use those that can be easily guessed.
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10.

11.

12.

13.

Enable Account Lock

The account lock feature is enabled by default, and we recommend you to keep it on to

guarantee the account security. If an attacker attempts to log in with the wrong password

several times, the corresponding account and the source IP address will be locked.

Change Default HTTP and Other Service Ports

We suggest you to change default HTTP and other service ports into any set of numbers

between 1024—-65535, reducing the risk of outsiders being able to guess which ports you

are using.

Enable HTTPS

We suggest you to enable HTTPS, so that you visit Web service through a secure

communication channel.

Enable Whitelist

We suggest you to enable whitelist function to prevent everyone, except those with

specified IP addresses, from accessing the system. Therefore, please be sure to add

your computer’s IP address and the accompanying equipment’s IP address to the

whitelist.

MAC Address Binding

We recommend you to bind the IP and MAC address of the gateway to the equipment,

thus reducing the risk of ARP spoofing.

Assign Accounts and Privileges Reasonably

According to business and management requirements, reasonably add users and assign

a minimum set of permissions to them.

Disable Unnecessary Services and Choose Secure Modes

If not needed, it is recommended to turn off some services such as SNMP, SMTP, UPnP,

etc., to reduce risks.

If necessary, it is highly recommended that you use safe modes, including but not limited

to the following services:

e SNMP: Choose SNMP v3, and set up strong encryption passwords and
authentication passwords.

e SMTP: Choose TLS to access mailbox server.

e FTP: Choose SFTP, and set up strong passwords.

e AP hotspot: Choose WPA2-PSK encryption mode, and set up strong passwords.

Audio and Video Encrypted Transmission

If your audio and video data contents are very important or sensitive, we recommend

that you use encrypted transmission function, to reduce the risk of audio and video data

being stolen during transmission.

Reminder: encrypted transmission will cause some loss in transmission efficiency.

Secure Auditing

e Check online users: we suggest that you check online users regularly to see if the
device is logged in without authorization.

e Check equipment log: By viewing the logs, you can know the IP addresses that were
used to log in to your devices and their key operations.

Network Log

Due to the limited storage capacity of the equipment, the stored log is limited. If you need

to save the log for a long time, it is recommended that you enable the network log

function to ensure that the critical logs are synchronized to the network log server for

tracing.
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14. Construct a Safe Network Environment

In order to better ensure the safety of equipment and reduce potential cyber risks, we

recommend:

e Disable the port mapping function of the router to avoid direct access to the intranet
devices from external network.

e The network should be partitioned and isolated according to the actual network
needs. If there are no communication requirements between two sub networks, it is
suggested to use VLAN, network GAP and other technologies to partition the
network, so as to achieve the network isolation effect.

e Establish the 802.1x access authentication system to reduce the risk of
unauthorized access to private networks.
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